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About This Guide

This guide describes how to install, configure, and customize Micro Focus iPrint Appliance on your

network.

+ Chapter 1, “iPrint Overview,” on page 11

+ Chapter 2, “What’s New in iPrint Appliance,” on page 17

+ Chapter 3, “Planning Your Print Environment,” on page 25

+ Chapter 4, “Deploying iPrint Appliance,” on page 31

+ Chapter 5, “Configuring New Appliance,” on page 39
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+ Appendix B, “Email Service Parameters,” on page 233

+ Appendix C, “iPrint Appliance Support Matrix,” on page 235

+ Appendix D, “iPrint Commands and Utilities,” on page 243

+ Appendix E, “TIDs for iPrint,” on page 249

+ Appendix F, “Documentation Updates,” on page 251

Audience

This guide is intended for Micro Focus iPrint Appliance administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the

online documentation.

Documentation Updates

For the most recent version of the Micro Focus iPrint Appliance Administration Guide, and other
documentation for this product, visit the Micro Focus iPrint Appliance Documentation Web site.

For information about configuring and using the mobile app, see the FAQ section of the app.
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iPrint Overview

IMPORTANT: iPrint 3.2 is only available as an online update to iPrint 3.0.

To install a New iPrint Appliance 3.2: You must first configure iPrint 3.0, and then apply the 3.2
updates. To apply the iPrint Appliance 3.2 updates, see “Migrating to iPrint Appliance 3.2” on page 61

Organizations want to reduce the complexity of managing printers by IT and allow end users to easily
locate and install printers.

That’s where Micro Focus iPrint comes in. Micro Focus iPrint offers a single, scalable solution for
managing all of your printing across multiple office locations from any device. It lets the users print
quickly, easily, and more securely.

+ “Understanding Micro Focus iPrint” on page 11

+ “Benefits of iPrint” on page 15

¢ “Challenges in Print Environment” on page 16

Understanding Micro Focus iPrint

¢ “iPrint Components” on page 12

Micro Focus iPrint provides secured enterprise print services for your desktops, laptops, and mobile
devices. Micro Focus’s iPrint solution integrates with your existing corporate printers, regardless of
the printing vendor or brand allowing you to deliver self-service printer provisioning to your device
users.

iPrint Overview 1



iPrint Components

Figure 1-1 iPrint Overview
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Remote Renderers

¢ “Users” on page 13

+ “Devices” on page 13

+ “Protocols” on page 13

+ “Administration” on page 13

+ “Accounting With iPrint” on page 14
+ “ldentity Source” on page 14

+ “iPrint Appliance” on page 14

+ “Renderers” on page 14

+ “Printers” on page 14
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Users

Users can submit print jobs through iPrint from their desktops, laptops, or mobile devices to both new
and legacy printers from all the major print vendors, without worrying about print drivers. You can
either import users from an existing LDAP source or create new users on the iPrint Appliance.

Devices

iPrint supports printing from desktops, laptops, or mobile devices.
Desktops and laptops: Clients for Windows and Mac workstations.

Mobile Devices: Apps for iOS, Android, Windows, and Amazon Kindle devices.

Protocols

IPP/ Email: The devices and app uses IPP (Internet Printing Protocol) or email to submit the print job.
If a direct network connection to iPrint Appliance is unavailable, the device switches to email printing,
and uses the email client configured on the device.

LDAP: LDAP is used for communication between iPrint Appliance and identity stores (eDirectory and
Active Directory).

HTTPS: HTTPS protocol is used for secure communication between iPrint Appliance and remote
renderers.

LPR/RAW/SNMP: iPrint Appliance supports printer communications using the Line Printer Remote
(LPR), RAW, or SNMP protocols.

Administration

Using Micro Focus iPrint Appliance Management Console, you can add and manage printers, check
the printer status, create printer maps, and monitor the appliance.

iPrint Configuration: Use for initial iPrint configuration and setup. You can configure items such as
mobile printing, LDAP user/group sources, renderers for enhanced document conversion, and so on.

Appliance Configuration: : Use this tool to reconfigure the system's network settings, time, SSL
certificates, and passwords. Network Settings should not be changed once iPrint Appliance
Configuration has been initiated.

iPrint Printer Configuration (iManager): iManager is a web-based tool that allows you to set up
and manage your print environment. You can create printers, printer drivers, profiles, and users.

iPrint Health Monitor: Monitors your iPrint environment. You can view status of print jobs and
manage jobs, and generate audit reports that show details of who printed and how much.

iPrint Migration Utility: You can migrate printers, drivers, driver profile, and printer configuration
details from your existing NetWare or OES environment.

iPrint Map Designer: Use this tool to create map displaying the location of printers. Users can
identify and install printers that are nearest to their location.

Ganglia: You can access various real-time monitoring statistics for all of the Ganglia-enabled
machines on your network segment.

iPrint Overview 13
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Accounting With iPrint

Print Accounting: Micro Focus iPrint integrates with third-party print accounting solutions to provide
full support for accounting the print jobs including tracking all the print jobs and keeping a tab on the
paper consumption. The print accounting feature enables the print administrator to have a clear
understanding of who is printing what and when, and apply charge back capabilities if required.

Direct Print Accounting: A printer that is enabled for iPrint Direct sends print jobs directly to the
printer instead of sending the job to the print server first. The print job is sent to the printer in LPR or
raw 9100 format, depending on the setting in the gateway autoload command for the printer. Although
this greatly reduces server communication, the ability to audit print jobs is lost. However, if you are
running a third-party print accounting solution, Micro Focus iPrint client can integrate with the third-
party print accounting solution to provide support for accounting print jobs to direct printers.

To install and configure third-party print accounting solution, refer to their documentation.

Identity Source

It works with LDAP directories such as Active Directory and eDirectory. Micro Focus iPrint makes
secure printing easy by integrating its data store with your identity directory.

iPrint Appliance

Print and mobile server are the main components of appliance which handle all print jobs and all print

infrastructure.

Renderers

+ “Local Renderer” on page 14

+ “Remote Renderer” on page 14

Local Renderer

iPrint Appliance is bundled with an in-built document renderer (local renderer). The local renderer
converts documents to the PDF format, then converts them to the print ready format using CUPS.
The renderer supports Open Office, Microsoft Office and image formats, and also has a
multithreading feature.

Remote Renderer

iPrint Appliance ships with a remote renderer. For desktop-quality printing, it is highly recommended
that you install the remote renderer. You can download the remote renderer from the iPrint Appliance
Management Console.

The remote renderer provides high quality rendering for Microsoft Office and PDF document formats.

Printers

Users can send print jobs through iPrint to both new and legacy printers from all the major print
vendors.

iPrint Overview



Benefits of iPrint

Self-service printing: Users can print from their desktops, laptops, or mobile devices without waiting
for the helpdesk to set-up a printer.

From desktops or laptops, users can print by selecting printers on a map using a web browser.

From mobile devices, users can print to any organizational printer using an iPrint app, email, or via
AirPrint™,

WalkUp printing: Print jobs sent by the users are put on hold and can be released to a desirable
printer.

Mobile device printing: Users of iOS, Android, and Windows mobile devices can download apps
that allow them to print from their mobile devices directly to any of your organization's printers.

Micro Focus iPrint provides all of the necessary document rendering and conversion.

Expand your horizons: Users can print any time, from anywhere, using almost any device. Click to
send a print job to any printer irrespective of the location of the printer.

Works with everything: iPrint provisions print services for nearly every device you have, including
desktops, laptops, smartphones, and tablets. It works whether users are printing from Mac or
Windows. It works on iOS, Android, and Windows Mobile.

Simplified enterprise printing: Micro Focus iPrint connects all your organization's workstations and
mobile devices to your current printers. iPrint scales exceptionally well, reducing the server
infrastructure you need to maintain hundreds or thousands of printers and thus lowering your network
bandwidth costs.

AirPrint Integration: Makes wireless, proximity-based printing a possibility across your organization.
Allows iOS users to use the AirPrint capabilities with the iPrint printer.

Samsung KNOX certified: Enhanced security for Android devices while maintaining user-friendly,
secure mobile printing in your corporate environment.

QR Code Support: Scan a QR code to quickly connect your mobile device to a specific printer.

Email print jobs to any iPrint printer: Any email-enabled device can print to any iPrint printer by
sending the print job in the body of the email or as an attachment.

Secure printing: You can secure your data before it goes to the printer, provisioning print services
based on user, group and container membership.

Works in heterogeneous environments: Saves IT time and money by significantly reducing the
management burden required for mixed fleets of Mac or Windows desktops. It works across the major
mobile platforms as well, meaning IT only has to manage a single print solution for all your
organization's endpoints.

Leverages your current directory service: Micro Focus iPrint makes secure printing easy by
integrating its data store with your identity directory. It works with lightweight directory access protocol
(LDAP) directories such as Active Directory and Micro Focus eDirectory.

Works with legacy printers: Mobilize your existing fleet of printers rather than buying new. It works
with what you have now and what you may want going forward.

iPrint Overview 15
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Challenges in Print Environment

End users:

¢ Printing from mobile devices (BYOD)
+ Ease of installing printers and printer drivers

+ Updating printer specific drivers
Administrators:

+ Complexity of managing printers and printer drivers

*

Auditing and accounting of print jobs

*

Health-monitoring of a printer
¢ Secure printing

¢ Printing in heterogeneous environments - Windows and Mac platforms

iPrint Overview



2 What’s New in iPrint Appliance

This section describes enhancements and changes to Micro Focus iPrint Appliance.

*

“What's New (iPrint Appliance 3.2)” on page 17
“What's New (iPrint Appliance 3.1.2 - May 2018 Patch)” on page 19
+ “What’s New (iPrint Appliance 3.1.1 - December 2017 Patch)” on page 19

*

+ “What’s New (iPrint Appliance 3.1)” on page 19
+ “What’s New (iPrint Android 3.1.0)” on page 20
+ “What's New (iPrint iOS App 3.0.5)” on page 20
+ “iPrint Appliance 3 - Highlights” on page 20

What’s New (iPrint Appliance 3.2)

“Direct PDF Printing” on page 17

*

*

“Desktop Printing” on page 17

*

“Print Transfer Utility” on page 18

*

“Mobile Apps” on page 18

*

“Proxy Server Enhancements for iPrint Mobile App” on page 18

Direct PDF Printing

A new parameter di rect _pdf _pri nt is added to the i pri nt nobi | e. conf file to support printing of
PDF documents on a PDF supported IPP printers. The printer’s capabilities are leveraged and there
is no dependency on the drivers for rendering the PDF jobs. For more information, see
“direct_pdf_print” on page 231.

Desktop Printing

iPrint Client 6.16 for Windows

The iPrint Client is upgraded to version 6.16 and available on Windows 10, Windows 8.x, Windows 7,
Windows Vista, Windows Server 2008 R2, Windows Server 2012 R2, and Windows 2016.

With iPrint Appliance 3.1, an option “iPrint” is added for faster access to print from the context menu.
Starting with this release, multiple (up to 15) documents in different formats can be selected for
printing at a time. For more information, see “Windows: Context Menu-based Desktop Printing” on
page 188.

What's New in iPrint Appliance 17
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iPrint Client 6.11 for Mac

The iPrint Client is upgraded to version 6.11 and available on macOS High Sierra (10.13), macOS
Sierra (10.12), OS X El Capitan, 10.8 or later versions. For more information, see “Installing iPrint
Client” on page 175.

The iPrint clients can now automatically be updated on MAC workstations. For more information, see
“MAC Workstations” on page 198. This feature will be enabled from the next version of the client.

Print Transfer Utility

The Print Transfer Utility (PTU) is used to migrate the TCP/IP printers from the Active Directory (AD)
environment to the Micro Focus iPrint Appliance. The utility only migrates the printers that are
published to the AD domain. For more information, see Chapter 8, “Migrating Printers from an Active
Directory Environment,” on page 73.

Mobile Apps

Android App

iPrint App is enabled for the shortcut feature. The supported devices are Android 7.1 and above with
Android theme. You must do long-press on the iPrint app’s launcher icon to display the following
actions:

*

WalkUp Jobs
Photos
Documents

*

*

+ Camera

i0OS App

iPrint App is enabled for the 3D Touch feature. The supported devices are iPhone 6s and above. On
the Home screen, press the iPrint icon to display the following actions:

+ WalkUp Jobs

+ Photos

+ Camera

Proxy Server Enhancements for iPrint Mobile App

The Proxy server settings on the iPrint Appliance can now be pushed to the mobile apps.
Alternatively, the mobile app user can also configure a proxy server on the iPrint App. On configuring
Proxy, the mobile app sends the request to the proxy server and the proxy server then redirects the
requests to the iPrint server. For more information, see “proxy_server_hostname” on page 231.

What's New in iPrint Appliance



What’s New (iPrint Appliance 3.1.2 - May 2018 Patch)
iPrint Client 6.15 for Windows

The iPrint Client is upgraded to version 6.15 and available on Windows 10, Windows 8.x, Windows 7
Windows Vista, Windows Server 2008 R2, Windows Server 2012 R2, and Windows 2016.

What’s New (iPrint Appliance 3.1.1 - December 2017
Patch)

iPrint Client 6.12 for Windows

The iPrint Client is upgraded to version 6.12 and available on Windows 10, Windows 8.x, Windows 7
Windows Vista, Windows Server 2008 R2, Windows Server 2012 R2, and Windows 2016.

A new CLI option - -i cm r ef r esh is added to apply the iCM settings modified by the administrator.

What’s New (iPrint Appliance 3.1)

“Certificate Management” on page 19

*

*

“Advanced Authentication Support” on page 19

*

“Desktop Printing” on page 20

*

“IPP Page” on page 20

Certificate Management

iPrint Management Console is enhanced with a new work flow for managing the certificates. Using
the Certificates page, you can upload the CA signed certificates and apply them to all the relevant
services used by iPrint Appliance.

’

The Digital Certificates page is no longer available to manage the certificates, instead, you must use

the Certificates page that is now part of the iPrint Management Console. For more information, see
“Certificate Management” on page 123.

Advanced Authentication Support

iPrint Appliance integrates with Advanced Authentication framework to release WalkUp jobs.
Advanced Authentication is a multi-factor authentication solution that ensures secure printing to the
iPrint printers with minimal administration. iPrint Appliance can use only Card or combination of a
Card and a Smartphone for authentication. For more information, see “Advanced Authentication” on
page 121.
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Desktop Printing

iPrint Client 6.10 for Windows

The iPrint Client is upgraded to version 6.10 and available on Windows 10, Windows 8.x, Windows 7,
Windows Vista, Windows Server 2008 R2, Windows Server 2012 R2, and Windows 2016.

A new option “iPrint” is added for faster access to print from the context menu. You can print any
format without installing printers or drivers on your desktop. For more information, see “Windows:
Context Menu-based Desktop Printing” on page 188.

iPrint Client 6.09 for Mac

The iPrint Client is upgraded to version 6.09 and available on macOS High Sierra (10.13), macOS
Sierra (10.12), OS X El Capitan, 10.8 or later versions. For more information, see “Installing iPrint
Client” on page 175.

IPP Page

The iPrint Portal is modernized with a set of new features.

From this release onwards, the IPP page (https://<iprintappliance_IP or hostname>/ipp) is redirected
to the iPrint Portal. If you still prefer to use the traditional IPP page, refer to the TID 7022057.

What’s New (iPrint Android 3.1.0)

iPrint app is enabled to support managed configurations (Android for Work). The supported devices
are Android 4.0 and later.

What’s New (iPrint iOS App 3.0.5)

Support for managing the iPrint app by using ZENworks Configuration Management 2017 along with
few bug fixes. For more information, see “Managing the iPrint App with ZENworks Configuration
Management 2017” on page 209.

iPrint Appliance 3 - Highlights

“‘Release Jobs With Identity Cards” on page 21

*

+ “iPrint Portal” on page 21

¢ “QuickPrint (Web Printing)” on page 22

+ “Desktop Printing” on page 22

+ “Printing from Chromebook” on page 22

¢ “Update Channel” on page 23

+ “Directory Servers” on page 23

+ “Improved Appliance Migration” on page 23
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Release Jobs With Identity Cards

Swipe to Print

A user prints the WalkUp jobs by using their identity card. A card reader is placed adjacent to the
printer and the user swipes his/her identity card to print the jobs. The benefits are:

+ Go Green: Saves paper, documents are printed only when users are next to the printer
+ Convenience: All you need is a identity card, no additional logins
+ Simplicity: It is so easy to print a job, just swipe your identity card

For more information, see “Identity Card Release for Users” on page 105.

iPrint Portal
A new printer portal is designed for enhanced user experience.
@ Micro Focus iPrint Portal Login
Printers C Refresh
Clear All
Location: _— i
™R Ricoh1
Show All v
= Richo3
Type:
Show All v 8 Richo in Lab
Model: = Richod_lab2
Show All o
8 Richo2
Search:
8 hp1

8 Richo in Lab2

Highlights are:
¢ QuickPrint (Web Printing) to upload and print a document

+ Controlled printer visibility
+ Quick access (bookmark) to printers based on filters
+ Locate printers easily based on location, type, and model of the printers

To access iPrint Portal, specify https://<iprintappliance_IP or hostname>/print
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For more information, see “iPrint Portal” on page 175.

QuickPrint (Web Printing)

QuickPrint is printing documents via Web browser. You no longer require clients or driver installation.
Using any web browser, the user selects a printer and document, then prints.

@ Micro Focus iPrint Portal

Printers C Reiresh
Clear All
Location: 0 LexmarkBW ~
Show All k4
Location : 8thfloorlab
Type: Description : Lexmark BW
Show All M
Color : Yes
Model: ‘ 4] Install H & QuickPrint |
Show All

For more information, see “iPrint Portal: QuickPrint” on page 179.

Desktop Printing

Micro Focus iPrint connects all your organization's workstations to your current printers. It allows IT to
set up a self-service printing environment in which employees can print on demand instead of calling
IT with print-provisioning needs.

iPrint Client 6.07 for Windows

The iPrint Client is upgraded to version 6.07.This client is available on Windows 10, Windows 8.x,
Windows 7, Windows Vista, Windows Server 2008 R2, Windows Server 2012 R2, and Windows
2016. For more information, see “Installing iPrint Client” on page 175.

iPrint Client 6.07 for Mac

The iPrint Client is upgraded to version 6.07. This client is also available on macOS Sierra (10.12),
OS X El Capitan, 10.8 or later versions. For more information, see “Installing iPrint Client” on
page 175.

Printing from Chromebook

iPrint provides secure enterprise print services for Chromebook users. The latest updates are:
¢ Supports printing of WalkUp jobs.

The extension is available in the Chrome Web Store for download.
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Update Channel

You no longer need manual downloads for patches. Henceforth, all patches are available from the
new channel.The patches can be scheduled or manually triggered from the channel.

For more information, see “Online Update” on page 95.

Directory Servers

The LDAP User Import GUI for managing users is now enhanced and made more intuitive. The task
is renamed as Directory Servers. For more information, see “Directory Servers” on page 109.

Improved Appliance Migration

+ Improved experience to perform migration from 2.x to 3 by using secondary disk.

For more information, see Chapter 6, “Migrating or Recovering an iPrint Appliance,” on page 59.

What's New in iPrint Appliance 23



24 What's New in iPrint Appliance



Planning Your Print Environment

IMPORTANT: iPrint 3.2 is only available as an online update to iPrint 3.0.

To install a New iPrint Appliance 3.2: You must first install iPrint 3.0, and then apply the 3.2
updates. To apply the iPrint Appliance 3.2 updates, see “Migrating to iPrint Appliance 3.2” on page 61

This section describes the requirements for installing iPrint Appliance.

+ “Server Requirements” on page 25

+ “Ports Requirements” on page 26

+ “Remote Renderer Requirements” on page 29
+ “Mobile Requirements” on page 30

+ “Migrate Requirements” on page 30

Server Requirements

iPrint Appliance works with any virtualization software that can run the . ovf, . vhd, . xen, or. xva file
formats.

+ Virtualization software. For support matrix, see “iPrint Appliance Server and Client Support” on
page 238.

*

Directory service:
+ NetlQ eDirectory 8.7.x and 8.8.x
+ Active Directory configured on Windows Server 2012 R2 Standard Edition
+ Active Directory configured on Windows Server 2008 R2 Enterprise Edition

*

NTP server details:

+ |P address or hostname

*

IP address details for iPrint Appliance, including:
¢ Static IP address
+ Network mask
+ Gateway IP address
+ Host name associated with the IP address
+ |P address of a DNS server

*

The IP address assigned to the iPrint Appliance and remote renderer must have DNS host entry
in the DNS server. Ensure that the DNS entries are in the same domain.

If you do not have a DNS server to resolve the hostnames, you can use the host s file to resolve
the same as follows:

+ Ensure that the host s file is updated with the iPrint Appliance and remote renderer details
(IP and hostname) in both the iPrint Appliance and the remote renderer machine. The
host s file is located at:

iPrint Appliance: / et c/ host s
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Remote renderer in the Windows machine: C:\ W ndows\ Syst enB2\ dri vers\etc

+ If you are using a third party certificate, ensure that the hostname of the iPrint Appliance and
remote renderer are configured with the domain name against which the certificate is issued. For
example, appliance.xyz.com and remoterenderer.xyz.com.

+ |f the iPrint Appliance and remote renderer, requires same IP address to resolve two different
host names, then during the appliance configuration, do one of the following:

+ Ensure that the / et ¢/ host s file of iPrint Appliance is updated with the IP address and
hostname (domain name against which the certificate is issued) of the iPrint Appliance and
remote renderer.

+ If you have a DNS server, then ensure that the PTR record entry for hosthname matches the
domain name of the used certificate. Ensure to remove all the other hostnames from the
host s file.

¢+ Memory: 4 GB RAM or higher is recommended.
+ Primary Hard Disk: 40 GB. This disk stores the Operating System and all the binaries.

+ Secondary Hard Disk: 40 GB. This disk stores the configuration details of the appliance. All
the WalkUp jobs are also stored on the secondary disk. Depending on the usage of the print
service, decide the space required on the secondary disk.

Ports Requirements

Figure 3-1 iPrint Appliance Ports Map

A Inbound Magl;::::nt iManager Ganglia
W Outbound W
0443 q 443 q 80 q 8080
A [ A 2081
2443
2444
2640
A
Mowell iPrint App
on Maobile Device Deskiop Client
Printer
s ¥ r gae ¥
631 EQ 831 ﬂ/ ¥ im0 e
20 = o100 181 B &
515 515
161 . ) &0
524 iPrint Appliance
0S5
AdrPrimt Mail Server LDAP Import Windows Renderer
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821 5353 143 524 b o100 2080
A g A ! 283 638 - 636 1681 EL: | 8443
ﬂﬂ 110 280 380 515 - A
205 A 80
. NetiQ eDirectary or
485 Microsoft Active Directory
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Desktop Clients: Open the ports on your clients to communicate with iPrint Appliance, printers and

LDAP sources.

Operating Connection Port Protocols Description
System Type
Windows
Outbound 9443 The release portal uses this port to
communicate with iPrint Appliance
Qutbound 636 LDAPS (Secure) To communicate with LDAP sources
Outbound 631 IPP To communicate with the printers
9100 RAW
515 LPR
161 SNMP
524 To communicate with eDirectory using
DClient
Mac
Outbound 9443 The release portal uses this port to
communicate with iPrint Appliance
Outbound 631 IPP To communicate with the printers
9100 RAW
515 LPR

Mobile Apps: Open ports on your mobile devices to communicate with iPrint Appliance and printers.

Operating System Connection Port Protocols Description
Type
iOS, Android, Outbound 443 HTTPS To communicate with iPrint Appliance and with
Windows the printers
Outbound 631 IPP To communicate with the printers
80 TCP

Remote Renderer: Open the ports for various communications between iPrint Appliance and

printers.
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Operating System Connection Port Protocols Description
Type
Windows Inbound 8080 HTTP To allow Management Console and Mobile
server to connect with the renderer
Inbound 8443 HTTPS To allow secure communication
Outbound 9100 RAW To communicate with the printers
161 SNMP
515 LPR

iPrint Appliance: Open the ports for various communications between iPrint Appliance and printers.

Tasks Connection Port Protocols Description
Type
Printers Outbound 9100 RAW To communicate with the printers
161 SNMP
515 LPR
80 TCP
AirPrint Inbound 631 IPP To perform AirPrint jobs
443 HTTPS
5353 mDNS/
UDP
Outbound 5353 mDNS/ To advertise iPrint printers as iOS AirPrint printers
UDP
Desktop Inbound 515 LPR To allow Desktop clients to communicate with the
Clients appliance
LDAP Import Outbound 524 NCP To perform LDAP import and authenticate users to the
(Dclient)  configured LDAP sources
636 LDAPS
(Secure)
389 LDAP
(Non-
Secure)
Inbound 22 SSH To allow access to appliance to perform LDAP Import
636 LDAPS
(Secure)
389 LDAP
(Non-
Secure)
Management Inbound 9443 To allow access to iPrint Management Console
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Tasks Connection Port
Type

Protocols Description

Inbound/ 443
Outbound
80
Mail Server Outbound 143

993

110
995
25

465

587

Ganglia Inbound 8080
Configuration (blocked)

8081
8443
8444
8649

HTTPS To perform iManager tasks
TCP
IMAP To communicate with the Mail server.

IMAPS
(Secure)

POP3
POP3
SMTP

SMTP
(Secure
via SSL)

SMTP
(Secure
via TLS)

To configure Ganglia

NOTE: For ports required by 3rd party products, you must refer to their documentation.

Remote Renderer Requirements

For desktop quality printing for Microsoft Office and PDF documents, you must install a remote

renderer. The minimum requirements are as follows:

+ Install the renderer on a Microsoft Windows 64-bit system

+ Windows 10/ Windows 8.1 / Windows 7 SP2 /Windows 2012 R2/ Windows 2008 R2 Enterprise

with a dual-core processor or higher

+ Microsoft .Net Framework 4 or later

+ The IP address assigned to the iPrint Appliance and remote renderer must have DNS host entry

in the DNS server. Ensure that the DNS entries are in the same domain.

If you do not have a DNS server to resolve the hostnames, you can use the host s file to resolve

the same as follows:

+ Ensure that the host s file is updated with the iPrint Appliance and remote renderer details
(IP and hostname) in both the iPrint Appliance and remote renderer machine. The host s file

is located at:

iPrint Appliance: / et c/ host s
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Remote renderer in the Windows machine: C:\ W ndows\ Syst enB2\ dri vers\etc

+ If you are using a third party certificate, ensure that the hostname of the iPrint Appliance and
remote renderer are configured with the domain name against which the certificate is issued. For
example, appliance.xyz.com and remoterenderer.xyz.com.

+ |f the iPrint Appliance and remote renderer, requires same IP address to resolve two different
host names, then during the appliance configuration, do one of the following:

+ Ensure that the / et ¢/ host s file of iPrint Appliance is updated with the IP address and
hostname (domain name against which the certificate is issued) of the iPrint Appliance and
remote renderer.

+ If you have a DNS server, then ensure that the PTR record entry for hosthname matches the
domain name of the used certificate. Ensure to remove all the other hostnames from the
host s file.

For Desktop quality printing, we recommend to install the following optional software:
+ Microsoft Office 2013
+ Microsoft Office 2010

Adobe Acrobat X| Professional
Adobe Acrobat X Pro

*

*

Mobile Requirements

For more information on the supported platforms, see “Mobile Operating System Support” on
page 235.

Migrate Requirements

+ Secondary disk that includes the earlier version of the configuration file.

For more information, see Chapter 6, “Migrating or Recovering an iPrint Appliance,” on page 59.
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4 Deploying iPrint Appliance

IMPORTANT: iPrint 3.2 is only available as an online update to iPrint 3.0.

To install a New iPrint Appliance 3.2: You must first install iPrint 3.0, and then apply the 3.2
updates. To apply the iPrint Appliance 3.2 updates, see “Migrating to iPrint Appliance 3.2” on page 61

This section describes the steps to deploy iPrint Appliance.

+ “Configuring Virtual Environment” on page 31

+ “Initial Appliance Configuration” on page 37

Configuring Virtual Environment

You must download the iPrint Appliance and configure the virtual environment where you plan to run
the appliance.

The process of downloading the iPrint Appliance and configuring the virtual environment differs,
depending on which virtual environment you plan to use to run the iPrint Appliance.

+ “VMware Configuration” on page 31

+ “Citrix Xen Configuration” on page 32

+ “Xen Configuration” on page 34

+ “Hyper-V Configuration (Not Available for Beta)” on page 36

VMware Configuration

1 Download the iPrint software (i Pri nt Appl i ance. x86_64- ver si on. ovf. zi p) to your
workstation.

2 Extractthe i Print Appl i ance. x86_64- ver si on. ovf . zi p file on your workstation. The i Pri nt -
ver si on folder is created with the . ovf file.

NOTE: On a VMware workstation, do not extract the i Pri nt Appl i ance. x86_64-

ver si on. ovf . zi p file using the default Windows extractor. On deploying this file, you may
receive an error message, Access is Denied. To resolve this issue, extract the file using any
other third-party extractor.

In the vSphere client, click File > Deploy OVF Template.

Browse to and select the . ovf file from the i Pri nt - ver si on file folder.
Click Next.

Click Next again.

In the Name field, specify name for the iPrint appliance, then click Next.
Select the location to store the virtual machine files, then click Next.

© 00 N OO O A~ W

Click Next to accept the disk format.
10 Review the deployment settings, then click Finish.
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On successful deployment, ensure to add a secondary disk before starting the VM.

Add a secondary disk for the appliance. The appliance configuration details will be stored in this
location.

11a In the vSphere client, right-click the virtual machine that you just created, then click Edit
Settings.

The Virtual Machine Properties page is displayed.
11b On the Hardware tab, click Add.
The Add Hardware dialog box is displayed.
11c Select Hard Disk, then click Next.
11d Select Create a new virtual disk, then click Next.
11e Specify the disk space, then click Next. Recommended size is 40 GB.
11f In the Advanced Options, continue with the default selection, then click Next.
11g Review the settings, then click Finish.

12 Power on the appliance (virtual machine).

13 Continue with Initial Appliance Configuration.

Citrix Xen Configuration

¢ “Using OVF Format” on page 32

¢ “Using XVA Format” on page 33

Using OVF Format

1

Download the iPrint software (i Pri nt Appl i ance. x86_64- ver si on. ovf . zi p) to your
management workstation.

You can download the software from the Novell Customer Center (NCC) (https://
www.novell.com/center) Or you can download an evaluation version of the software from the
Novell Downloads page (http://download.novell.com).

2 Extractthei Print Appliance. x86_64- versi on. ovf. zi p file on your management workstation.

3 In the Citrix XENCenter client, right-click the server on which you will install iPrint Appliance, then

click Import.
The Import OVF/OVA Package wizard is displayed.

4 Import Source: Browse to F folder and select the . ovf file.

5 Location:

Click Next to continue with the default settings.

Storage: Select one or more storage repositories (SRs) where the disk images for the imported
VMs will be placed, then click Next.

Networking: To map an incoming virtual network interface to a target network, select a network
from the list in the Target Network column, then click Next.

The Network and MAC address shown in the list of the VMs are stored as part of the definition of
the original (exported) VM in the export file.

Security:
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If the selected OVF/OVA package is configured with security features such as certificates or a
manifest, select Verify manifest content to verify the list of files in the package. If the packages
are digitally signed, the associated manifest is verified automatically and so the Verify manifest
content option is not available on the Security page.

Click Next.

OS Fixup Settings: Since the VMs are created on XenServer, select Don’t use Operating
System Fixup, then click Next.

Transfer VM Settings: Configure the network settings, then click Next.
10a Select a network from the list of network interfaces.

10b To configure networking settings manually, select Use these network settings and enter the
IP address, subnet mask and gateway.

We recommend you to provide the same IP address that you plan to use for iPrint VM
server. However, you can also provide a temporary IP address.

Review all the import settings and then click Finish to begin the import process and close the
wizard.

The import progress is displayed in the status bar at the bottom of the XenCenter window and
also on the Logs tab.

Add a separate hard disk for the appliance. The appliance configuration details will be stored in
this location.

12a In the Citrix XENCenter client, select the virtual machine that you just created, and click on
the Storage tab.

The Virtual Disks page is displayed.
12b Click Add.
The Add Virtual Disk dialog box is displayed.
12c¢ In the Name field, specify the name of the virtual disk.

12d In the Size field, specify the amount of hard disk space that you want to allocate. 40 GB is
recommended.

12e Click Add.

13 Power on the appliance (virtual machine).

14 Continue with Initial Appliance Configuration.

Using XVA Format

1

Download the iPrint software (i Pri nt Appl i ance. x86_64- ver si on. xva. t ar. gz) to your
management workstation.

You can download the software from the Novell Customer Center (NCC) (https://
www.novell.com/center) Or you can download an evaluation version of the software from the
Novell Downloads page (http://download.novell.com).

Extract the i Pri nt Appl i ance. x86_64- versi on. xva. t ar. gz file on your management
workstation.

In the Citrix XENCenter client, right-click the server on which you will install iPrint Appliance, then
click Import.

The Import XVA Package wizard is displayed.

4 Import Source: Browse to i Pri nt Appl i ance. x86_64- ver si on folder and select the . xva file.

5 Home Server:
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Select the server that you want to nominate as home server for this VM. Click Next.

Storage: Select one or more storage repositories (SRs) where the disk images for the imported
VMs will be placed, then click Import.

Networking: To map an incoming virtual network interface to a target network, select a network
from the list in the Network column, then click Next.

The Network and MAC address shown in the list of the VMs are stored as part of the definition of
the original (exported) VM in the export file.

Review all the import settings.

NOTE: Do not select the option Start VMs after import. If you select this option the VM will start
without user intervention. We need to add a secondary hard disk before starting the VM.

Click Finish to begin the import process and close the wizard. The import progress is displayed
in the status bar at the bottom of the XenCenter window and also on the Logs tab.

Add a separate hard disk for the appliance. The appliance configuration details will be stored in
this location.

9a In the Citrix XENCenter client, select the virtual machine that you just created, and click on
the Storage tab.

The Virtual Disks page is displayed.
9b Click Add.
The Add Virtual Disk dialog box is displayed.
9c In the Name field, specify the name of the virtual disk.

9d In the Size field, specify the amount of hard disk space that you want to allocate. 40 GB is
recommended.

9e Click Add.

10 Power on the appliance (virtual machine).

1"

Continue with Initial Appliance Configuration.

Xen Configuration

1

Log in to the host server either locally or from a remote workstation.

You can use the following command to log in to the host server from a remote workstation on
Linux:

ssh - X root @ost _i p_address

You must use the -X in the command in order to display the GUI installation program. The steps
in this section use the GUI installation program to configure the server.

2 Navigate to the / var/1i b/ xen/ i mages directory on the host server.

3 Create a new directory inside the images directory where you can download the iPrint software.

The name of this directory must be the same as the name that you plan to use for your iPrint
virtual appliance. For example, if you plan to name the iPrint appliance i Pri nt 1, the name of this
new directory must also be i Print 1.

4 Change to the directory that you just created. For example, / var/1i b/ xen/i mages/i Print 1.

5 Download the iPrint software (i Pri nt Appl i ance. x86_64- ver si on. xen. t ar. gz) to the current

directory on the host server. For example: /var/1i b/ xen/i mages/i Print1

Untar the i Pri nt Appl i ance. x86_64- ver si on. xen. t ar. gz file in the directory where you
downloaded it.
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You can use the following command to untar the file:
tar -Sxvzf iPrintAppliance.x86_64-version.xen.tar.gz

Ai Print - ver si on directory is created, which contains a . r awfile that you will use to run the
virtual image. This process can take a few minutes.

From the host server, run the following command to launch the GUI configuration menu:
vminstall

The Create a Virtual Machine wizard is displayed.

8 Click Forward.

9 Select | have a disk or disk image with an installed operating system, then click Forward.

10
1"

12

13

14

15
16

Leave SUSE Linux Enterprise Server 11 selected, then click Forward.

Rename the virtual machine by clicking Name of Virtual Machine, then specifying a new name in
the Name field. Then click Apply. For example, i Print 1.

Configure the amount of memory and number of CPUs that Xen allocates for the iPrint
appliance.

12a On the Summary page, click Hardware, then specify the following information:

Available Memory: Displays the amount of available memory that is available on the host
server.

Initial Memory: 4 GB is the recommended minimum amount of memory.
Maximum Memory: Set this to the same value that you set for Initial Memory.
Available Processors: Displays the number of available processors on the host server.
12b Click Apply.
Configure the bootable disk image:
13a On the Summary page, click Disks.
13b Click Harddisk.
13c On the Virtual Disk page, specify the following information:
Source: Click Browse, then browse to the . r awfile that you untared in Step 6.
Protocol: Select file:.
Size (GB): The default size is 40.1 GB. This cannot be changed.
Create Sparse Image File: This option is not available.
Read-Only Access: Do not select this option.
13d Click OK.

Add a separate Xen hard disk. You must add a hard disk to the virtual machine before you
choose this option. If you have not already added a hard disk, click Power Off Virtual Machine,
modify the virtual machine settings to add a hard disk, then power on the virtual machine.

14a On the Disks page, click Harddisk.
14b On the Virtual Disk page, specify the following information:

Source: This field should already contain the path to the . r awfile that will be created when
the virtual machine is created. If desired, you can rename the disk in the source field from
di sk0 to a name of your choosing.

Size (GB): Specify the amount of hard disk space that you want to allocate. 40 GB is
recommended.

Click OK > Apply.

Click OK to save your changes and to create and power on the virtual machine.
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IMPORTANT: Do not power on the appliance until you have created a separate Xen hard disk
for the appliance, as described in Step 14.

Continue with Initial Appliance Configuration.

Hyper-V Configuration (Not Available for Beta)

1

Log in to the host server either locally or from a remote workstation.
You can use Windows Remote Desktop to log in to the host server from a remote workstation.

Create a new directory in the location where you want each virtual machine to reside (for
example, C:\ User s\ Publ i ¢\ Docunent s\ Hyper-W Virtual Hard Di sks). In a later step, you
will download the iPrint software to this directory.

As a best practice, give this directory the same name as the name that you plan to use for your
iPrint virtual appliance. For example, if you plan to name the iPrint appliance i Pri nt 1, the name
of this new directory should also be i Print 1.

Download the iPrint software (i Pri nt Appl i ance. x86_64- ver si on. vhd. zi p) to the directory on
the host server that you created in Step 2.

You can access the software from the Novell Customer Center (NCC) (https://www.novell.com/
center). Or, you can access an evaluation version of the software from this location (https://
www.microfocus.com/products/iprint/trial/).

Extract the i Pri nt Appl i ance. x86_64- ver si on. vhd. zi p file to the directory on the host server
that you created in Step 2.

5 Open the Hyper-V Manager.

6 In Hyper-V Manager, right-click the disk name in the Action Pane in the left-hand column of the

Hyper-V Manager window. This is the disk where you want to create the new virtual machine.
Then click New > Virtual Machine.

The New Virtual Machine Wizard is displayed.

7 Review the Before You Begin page, then click Next.

8 In the Name field, specify a name for the new virtual machine. For example, i Pri nt 1.
9 Click Next.

10

1"
12
13

14
15

In the Startup memory field, specify the amount of memory (in MB) to allocate to the virtual
machine. 4 GB is the recommended minimum for a iPrint.

Click Next.
On the Configure Networking page, select the networking card of your choice, then click Next.
Configure the bootable disk image:

13a On the Connect Virtual Hard Disk page, select Use an existing virtual hard disk, then
browse to the . vhd file that was in the downloaded . zi p file that you extracted in Step 4.

13b Click Open to select the file, then click Next.
Click Finish.

Create a separate Hyper-V hard disk for the appliance. You must add a hard disk to the virtual
machine before you choose this option. If you have not already added a hard disk, click Power
Off Virtual Machine, modify the virtual machine settings to add a hard disk, then power on the
virtual machine.
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NOTE: If you do not add a hard disk to the virtual machine, then iPrint Appliance is installed on
the default partition. The default partition is /sda.

15a In Hyper-V Manager, right-click the disk that you just created, then click Settings.

15b In the Hardware section, select IDE Controller 1, select Hard Drive, then click Add.

15¢ Select Virtual hard disk, then click New.

15d Review the Before You Begin page, then click Next.

15e On the Choose Disk Format page, select VHD, then click Next.

15f On the Choose Disk Type page, select Fixed size, then click Next.

15g On the Specify Name and Location page, specify the following information, then click Next:
Name: Specify a name for the hard disk. For example, i Pri nt Di sk2.
Location: Specify the location where you want the hard drive to be located.

16 On the Configure Disk page, select Create a new blank virtual hard disk, then specify a size for
the hard disk. 40 GB is recommended.

17 Click Next.

18 Review the summary information, then click Finish.
19 Click Apply > OK.

20 Right-click the virtual machine, then click Start.

IMPORTANT: Do not start the appliance until you have created a separate Hyper-V hard disk for
the appliance, as described in Step 15.

21 Right-click the virtual machine, then click Connect.

22 Continue with Initial Appliance Configuration.

Initial Appliance Configuration

1 After you have downloaded the iPrint appliance, configured the virtual environment, and
powered on the appliance, click the Console tab.

NOTE: If you are configuring the appliance with a xva file, then the remaining steps are
displayed in ncurses (text-based) format.

2 After the appliance starts, select your preferred keyboard layout in the Keyboard Language
drop-down, then accept the license agreement by clicking Accept.

You can change the language in the agreement from the License Language drop-down.
The Micro Focus iPrint Appliance Passwords and Time Zone page is displayed.

3 On the Micro Focus iPrint Appliance Passwords and Time Zone page, specify the following
network information:

Root password and confirmation: The root password for your iPrint appliance.

Vaadmin password and confirmation: The preferred user to use when logging in to the
appliance.

NTP Server: The IP address or host name of the reliable external Network Time Protocol (NTP)
server your OES server uses. For example, time.example.com.

For the best results, set up NTP in accordance with the VMware best practices guidelines.
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Region: Your local region.
Time Zone: Your local time zone.
4 Click Next.
5 On the Micro Focus iPrint Appliance Network Settings page, specify the following information:

Hostname: The fully qualified DNS host name associated with the appliance’s IP address. For
example, myiPrint.mynetwork.example.com.

IMPORTANT: Ensure that the host name is in valid format because no validation is done in this
step. At a later stage, appliance configuration fails if the host name is invalid.

To get the hostname, go to the command prompt and type nsl ookup <ipaddress>. For example,
nslookup 192.168.1.255.

IP Address: The static IP address for the appliance. For example, 172.17.2.3.

Network Mask: The network mask associated with the appliance’s IP address. For example,
255.255.255.0.

Gateway: The IP address of the gateway on the subnet where your iPrint virtual appliance is
located. For example, 172.17.2.254.

DNS Servers: The IP address of a primary DNS server for your network. For example,
172.17.1.1.

Domain Search: The domain where the iPrint Appliance is located. For example,
mynetwork.example.com.

6 Click Next.
7 Select the Hard Drive.

If you created a secondary VMware hard drive for this appliance, it is automatically detected and
sdb is displayed as the hard drive. If you have not created a secondary VMware hard drive, sda
is chosen as the default partition.

If you have added a secondary hard drive, specify the following options:
Hard Drive: Select the hard drive you are using.
Create a new partition: Select this option to create a new partition.
Filesystem type: Specify the type of file system.

8 Click Configure.

If you have not created a secondary hard disk, a warning message is displayed to power off the
VM.

8a Click Power Off Virtual Machine, then add the secondary hard disk.
8b Power on the VM and continue with the installation.

The iPrint Appliance installation process begins. A message stating, “The system is ready for
appliance configuration” is displayed. After the installation is complete, a URL and an IP address
to access the iPrint Appliance Management Console is displayed. Using a Web browser,
navigate to the Management Console URL.

The iPrint Appliance installation is now complete. You must configure iPrint Appliance before you can
start printing. Continue with Chapter 5, “Configuring New Appliance,” on page 39.

To migrate from an earlier version or recover the appliance in an event of crash, see Chapter 6,
“Migrating or Recovering an iPrint Appliance,” on page 59.
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Configuring New Appliance

IMPORTANT: iPrint 3.2 is only available as an online update to iPrint 3.0.

To install a New iPrint Appliance 3.2: You must first install iPrint 3.0, and then apply the 3.2
updates. To apply the iPrint Appliance 3.2 updates, see “Migrating to iPrint Appliance 3.2” on page 61

You can configure iPrint Appliance through the iPrint Appliance Management Console.

+ “Configuring New iPrint Appliance” on page 40

+ “Creating Printers” on page 41

+ “Creating or Importing Users” on page 45

¢ “Configuring Printer Drivers” on page 45

+ “Configuring Printing Through Mobile Devices” on page 53
+ “What’s Next” on page 58

You can configure new iPrint Appliance or recover an appliance from crash. To view help, click
Getting Started.

1 On a Web browser, use either the host name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. To avoid the security warning prompt every time you access the iPrint Appliance
Management Console, you can add the certificate to the trusted certificates list on your browser.

2 Specify vaadni n orr oot as the user name.
3 Specify the password, then click Log in.
The Management Console page is displayed.

4 Click iPrint Appliance Configuration.
° iPrint Appliance Configuration

|' Configure New iPrint Appliance ‘

Recover Existing iPrint Appliance

« Modify Settings Getting Started

5 Click Configure New iPrint Appliance or Recover iPrint Appliance.
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Configuring New iPrint Appliance

Figure 5-1 Create iPrint Appliance

. Create iPrint Appliance

DNS for Print Service Q

Modify DNS Address

Authentication Realm Q

Use OES server

iManager Credentials

Usemame:
cn=admin,o=IPrintAppliance

Password:

Re-type Password:

Back

1 DNS for Print Service: The host name is tied to a Print service, rather than the server. The host
name must resolve to the IP address of the Appliance. You must validate that the DNS address
is correct and functional before continuing because a wrong DNS address can result in errors.

The default value is the host name of the iPrint Appliance. If you modify this value to a different
host name it allows you to move the iPrint server without interrupting the workstations. The host
name is used to connect to the Windows and Mac desktop clients.

NOTE: If you configure a Remote Driver Store, you must manage (using iManager) the Remote
Driver Store from the machine where the Driver Store resides.

2 Authentication Realm: Specify the tree name only if you want to authenticate to an existing
OES server.

In an OES iPrint server, the Authentication Realm is the eDirectory tree name. When a user logs
in to the workstation with NetlQ eDirectory credentials, the credentials are shared with the iPrint
Client to provide seamless login experience to all the iPrint servers in your tree.

3 iManager Credentials: The credentials in this section are used to log in to the iManager
interface. In the earlier release this label was Embedded Data Store.

Administrator Username: The administrator account user name is pre-populated in the
following format: cn=adni n, o=i Pri nt Appl i ance. This field is not editable.

Administrator Password: Specify the password for the iManager administrator account. This
password will be used to log in to the iManager for managing the print environment.
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Re-type Password: Specify the password again to confirm.
4 Click Finish.
After configuring iPrint Appliance, you must create or import users, create or import printers, and

upload drivers. You can also configure printers to accept print jobs from mobile devices, AirPrint, or
email.

Creating Printers

Before configuring the printer, you must create the printer object on the iPrint Appliance. You can use
any one of the following methods to add printers to iPrint Appliance.

+ Chapter 7, “Migrating Printers from an OES iPrint Server,” on page 65

¢ “Creating Printers Using iManager” on page 41

¢ “Bulk Printer Import Using a CSV File” on page 42

Creating Printers Using iManager

By default, iPrint Appliance supports only PostScript printers. For non-PostScript printers like PCL, or
for printers that do not work with the default PostScript driver, you must associate appropriate drivers
to the printers.

1 On the iPrint Appliance Management Console page, select the Manage Printers (iManager) tool
to connect to iManager.
2 Log in to iManager using the eDirectory admin credentials of iPrint Appliance.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. If you add the certificate to the trusted certificates list, the security warning is not
displayed.

3 Click iPrint > Create Printer.
4 Specify the Target printer details.

Printer Name: Defines the label by which the new printer is identified. You can include
uppercase and lowercase letters, numbers, spaces, and underscore in the label. Do not use any
other characters.

Container Name: The eDirectory container where the printer reference resides. By default, the
value is “iPrintAppliance”. We do not recommend changing the default value.

Print Manager name: The name of the Print Manager that handles the incoming print jobs.

DNS name or IP address: The IP address of a printer uniquely identifies it on the network and
allows other networked machines to communicate with it. ADNS name can also be applied to
the printer, which can be translated into the printer's IP address.

Specify the IP address (v4) or the DNS name of the target printer.

Location: Indicates the printer's location. The value of this field is displayed when selecting a
printer.

Description: Describes the printer. The value of this field is displayed when selecting a printer.

LPR Printer Name: Specify an LPR printer name. If the LPR protocol is selected, other optional
parameters can also be specified. With most modern printers, the name can be set to
PASSTHROUGH. With some older printers (1990's & prior), there might be a different printer
name.
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RAW Port Number: If the RAW protocol is selected, a port number is required. Most printers are
configured, by default, to use port 9100 for RAW protocol communications.

iPrint Appliance supports printer communications using either the Line Printer Remote (LPR) or
RAW protocols.

The LPR protocol is the most common printing protocol and is generally more flexible than the
RAW protocol. A printer that supports the LPR protocol is sometimes referred to as a TCP/IP
printer. The LPR protocol has limited error reporting capabilities, which is often limited to “Printer
Error” with no details.

The RAW protocol is often the default protocol on non-Windows systems. Most printers that
support the RAW protocol use port 9100. The LPR protocol can generally be substituted for the
RAW protocol if the RAW protocol does not respond to a print job.

5 Click Next.
6 Specify the drivers for the printer.

iPrint Appliance supports both driver and driverless printing. For mobile device printing, drivers
are not required. The selectable drivers for each operating system are available in the Micro
Focus iPrint Appliance Driver Store.

7 To reedit the printer-specific options after the new printer has been created, click Modify. To
create another printer, click Repeat Task. To continue, click OK.

In iManager, you might see a Partition and Replicas option. This feature is not supported on
iPrint Appliance.

Bulk Printer Import Using a CSV File

You can import printers into iPrint Appliance through a csv file. On successful import the printers
resides in the container O=iPrintAppliance.

You must create a csv file, then import the csv file into iPrint Appliance. The csv file must contain the
following fields in the same order:

PrinterNang, Printerl P, Location, Description, Wn95_ 98 Driver, Wnnt_Driver, Wn2k_Driv
er, Wnxp_Driver, Linux_Driver, Mac_Driver, Vista32_Driver, Vista64 Driver, Wn732_Drive
r,Wn764_Driver, Wn832_Driver, Wn864_Driver, Wnl1032_Dri ver, Wnl1064_Dri ver, Enabl e
Direct Printing, Secure Printing, Enabl e Auditing, LPR RAW Raw Port

NOTE
+ Ensure to have a blank line at the end of the CSV file. If no blank line is added, then the last
printer is missed and bulk printer import fails.

+ You cannot enable both direct printing and auditing. If enabled, both options are disabled when
creating the printers.

Table 5-1 Parameter Description of CSV File

Parameter Description Value

(Mandatory/Optional)

PrinterName Name of the printer that you want to import Mandatory
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Parameter

Description

Value

(Mandatory/Optional)

PrinterlP

Location

Description

Win95_98_ Driver

Winnt_Driver

Win2k_Driver

Winxp_Driver

Linux_Driver

Mac_Driver

Vista32_Driver

Vista64_Driver

Win732_Driver

Win764_Driver

Win832_Driver

Win864_Driver

Win1032_Driver

Win1064_Driver

DirectPrinting

Secure Printing

IP Address assigned to this printer

NOTE: Specify only the IP address. Printer
creation fails if host name is specified.

Location of the printer

Details of the printers like make, model, and so
forth.

Driver associated with this printer for Windows 95

and Windows 98 platform.

Driver associated with this printer for Windows
NT platform.

Driver associated with this printer for Windows
2000 platform.

Driver associated with this printer for Windows
XP platform.

Driver associated with this printer for Linux
platform.

Driver associated with this printer for Mac
devices.

Driver associated with this printer for Windows
Vista 32-bit platform.

Driver associated with this printer for Windows
Vista 64-bit platform.

Driver associated with this printer for Windows 7
32-bit platform.

Driver associated with this printer for Windows 7
64-bit platform.

Driver associated with this printer for Windows
8.x (32-bit) platform.

Driver associated with this printer for Windows
8.x (64-bit) platform.

Driver associated with this printer for Windows 10
32-bit platform. Windows 10 uses the same driver

as Windows 8.x.

Driver associated with this printer for Windows 10
64-bit platform. Windows 10 uses the same driver

as Windows 8.x.

Enable direct printing for this printer. Value is yes

or no. By default, this option is disabled. You
cannot enable both direct printing and auditing.

Enable secure printing for this printer. Value is
yes or no. By default, this option is disabled.

Mandatory

Optional
Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional

Optional
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Parameter Description Value

(Mandatory/Optional)

Enable Auditing Enable auditing of this printer. Value is yes or no. Optional
By default, this option is disabled.

LPR/RAW Protocol to be used by this printer. Value is LPRor Optional
RAW By default, the value is LPR.

Raw Port If you have selected RAW protocol, specify the Optional
port number.

IMPORTANT: In the csv file, you must specify at least one driver for each printer. For all optional
parameters, you must include a empty string.

Example of a CSV file
To migrate 2 printers (printer1 and printer2) for a Windows 8.1 platform. The csv file includes:

printerl,10.0.0.1, 1st_floor, HP LaserJet 4100,,,,,,,,,,, HP LaserJet 4100 PCL 5
1y no! yes, yeS, I—F’R1

printer2,10.0.0.2,2st_floor, HP LaserJet 4100,,,,,,,,,,,HP LaserJet 4100 PCL 5
.+, N0, yes, yes, RAW 9100

After you create the csv file, upload the file to iPrint Appliance.

Uploading the CSV File

1 On a Web browser, specify either the host name or the IP address. For example, https://
10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the Username and Password, then click Log in.
3 Click Manage iPrint Appliance.
4 Click Printers.
5 Click the Bulk Printer Creation button in the upper-right corner of the window.
Create Printers from CSV X
| CSV File: Browse...
Download Sample CSY oK Cancel

5a To download the sample csv file, click Download Sample CSV.

6 Navigate to the . csv file, select it, then click OK to begin the printer import process.

To enable printing from mobile devices, proceed to “Configuring Printing Through Mobile Devices” on
page 53.
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Creating or Importing Users

You can either import your users from an existing LDAP eDirectory or Active Directory source, or you
can create local users on iPrint Appliance.

To set up iPrint Appliance and import printers, you must first import users from your LDAP source. For
information on how to import users from an LDAP source, see “Directory Servers” on page 109.

Configuring Printer Drivers

A printer driver or PostScript Printer Description (PPD) file is software that directly supports a physical
printer, enabling it to carry out its functions.

Hardware vendors develop printer drivers and PPD files, which are specific to each printer. Most
printers require different printer drivers for each operating system they interact with. You can use
iManager to view a list of printer drivers and PPD files you have uploaded to the Driver Store. You can
add printer drivers and PPD files from diskettes, CDs, and the workstation operating system.

iPrint Appliance ships with a default Linux driver that is used by the local renderer for mobile printing.
To modify the default Linux driver, see “Modifying the Default Linux Driver Used by the Local
Renderer for Mobile Printing” on page 51.

+ “Prerequisites” on page 45

+ “Uploading Drivers By Using iManager” on page 45

+ “Uploading Drivers By Using Command Line” on page 50

+ “Modifying the Default Linux Driver Used by the Local Renderer for Mobile Printing” on page 51
+ “Location Of the Linux Printer Drivers” on page 52

Prerequisites

+ |Install iPrint Client. For more information, see “Installing iPrint Client” on page 175

Uploading Drivers By Using iManager

iManager is a management tool that allows you to manage your print environment. You can create
printers, printer drivers, profiles, and users.
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Supported Browsers to Upload Drivers Using iManager

Workstation Supported Upload Linux Upload Windows Upload Mac
Browser Drivers Driver Drivers
(PPD file) (-inf file) (PPD file)
Linux Windows Mac
Windows Internet Explorer e v
6.0 or later (run as
administrator) .
Same version as
the workstation
Mac Not supported % x x

NOTE: If you are running iManager from a Windows workstation, you can only add printer drivers for
that version of Windows.

You cannot upload drivers from a Windows Server platform. To print documents from your Windows
server, you must upload the drivers from the Windows workstation that can work with the server
platform. For more information, see “Windows server and workstation Map” on page 50.

Uploading Drivers to the Driver Store

To upload printer drivers to the Driver Store:

1 In iManager, click iPrint > Manage Driver Store.

42 Manage Driver Store

Specify the object(s) to modify.

Select a single object

Simple Selecticn

iPrint Driver Store name:
driver_store iPrintAppliance

oK | Cancel

2 Specify the name of the iPrint Driver Store to which you want to add printer drivers.

3 Select the Drivers tab.

Configuring New Appliance



Manage Driver Store: ggdriver_store.iPrintAppliance

Driver Store Control | Access Control S0

Drivers Platform:

Windows 7 (64 bit) M

Current drivers:

Adobe PDF Converter - Add From File
Brady IPS00 Printer

Brother HL-2250DN series _Add From System |
Brother HL-3040CN series

Brother HL-3070CW series I

- |Brother HL-4040CN series
_|Brother HL-4050CDM BR-Script3
Brother HL-4050CDN series
Brother HL-4150CDN series
Brother HL-4570COW BR-Script3 -

Use the Drivers Platform drop-down list to select the client platform for which you want to add
the printer driver.

5 Perform one of the following actions:

¢ Click Add from File to add printer resources from a printer driver (. i nf file or PPD) file.
Mac: The standard file format is PPD (Postscript Printer Description) file.
Windows: The standard file format is . i nf file.

+ Click Add from System to add drivers from the workstation where you are running
iManager.

The drivers installed on your workstation are only available to be uploaded to the Driver
Store.

6 (Conditional) If the client platform is Mac, new options are available as follows:.
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Manage Driver Store: ggdriver_store.iPrintappliance

Driver Store Control | Access Control S0

Drivers Platform:
Mac v
Drivers:
Brother MFC-7860DM BR-Script3 Add From File
HF LaserJet 4050 Series I ERPTE T
Delete
Associated Package: xeroxprinterdrivers1_2_3
Driver Packages:
[None] __Add From File |
hpprinterdriver3. 1 -
xeroxprinterdrivers1_2_3 I

Select the desired drivers, then select a package and click Associate.

Associate

Associated Driver Package: Displays the driver package, if any, associated with the selected
drivers. This is the dependent package for the driver and is installed with the printer. This option
is available only on a Mac machine.

6a Perform one of the following actions:

¢ Click Add from File to add printer driver package to the list from a .pkg or .dmg file that
you obtain from the printer vendor.

+ Select the driver from the Drivers list, then select the package from the Driver
Packages list and click Associate. This associates the selected driver to the package.
When a user installs the printer, the driver and its associated files from this package

are installed on the workstation. If the dependent files are missing, the printer
installation fails.

+ To disassociate a driver from the package, select the driver and select None from the
Driver Packages list and click Associate. The driver is no longer associated to any
package.

7 Click OK to save your changes.

To display the changes you made, click Refresh.

Deleting Drivers from the Driver Store

1 IniManager, click iPrint > Manage Driver Store.
2 Select the Drivers tab.

3 Read the list of existing printer drivers displayed in the Current Drivers panel.
4 Select a driver, then click Delete.
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5 Click OK to save your changes

6 Click Refresh to refresh the screen and display the changes you just made.

Associating the Driver
To set the default driver:

1 IniManager, click iPrint > Manage Printer.

47 Manage Printer

Specify the object(s) to modify.
Select a single object | Simple Selecticn

iPrint Printer name:

MacTest Printer2. iPrintAppliance

oK |  cancel |

2 Specify the name of the printer to which you want to set the default driver.
3 Select the Drivers tab.

Manage Printer: ggMacTest PrinterZ.iPrintappliance

Printer Control

Dyl Access Control | Configuration | Client Support |

Drivers Platform:
Mac v
Mac current setting
Driver:
Profile:

Model:

Available drivers:

[None]

Brother HL-4070CDW BR-Script3
Brother HL-4150CDN BR-Script3
Brother HL-5450DN series CUPS
Canen iR3235/iR3245

Dell 2330dn Laser Printer

Dell B2360d-dn Laser Printer
Dell Laser Printer W5300 PS3 -

Available driver profiles for selected driver:
[None]

4 Use the Drivers Platform drop-down list to select the client platform for which you want to set the
printer driver for the selected printer.

5 In the Available drivers, select the printer driver you want to associate with the selected printer.

This field displays a list of printer drivers that have been uploaded for this operating system. If
you do not want a printer driver to be used, select None.
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NOTE: If no printer driver is selected, you cannot print from a desktop client to that printer. For
mobile printing, the default driver will be used to render jobs for that printer.

Windows server and workstation Map

Windows Desktop Windows Server
Windows XP (32-bit) Windows 2003

Windows Vista (64-bit) Windows 2008

Windows 7 (64-bit) Windows 2008 R2
Windows 8.1 (64-bit) Windows 2012 or 2012 R2
Windows 10 Windows Server 2016

For example: To print from Windows 2008 server, associate the printer with Windows Vista driver.

Uploading Drivers By Using Command Line

You can upload drivers from your workstation or from an iPrint Appliance server.

+ “Workstation” on page 50
+ “iPrint Appliance Server” on page 51

Workstation

iprntcmd is a command-line utility that helps you manage iPrint tasks on your workstation. To upload
the drivers to the driver store, run the following commands on your workstation:

Windows Client: Execute the following command to upload Windows driver:
iprntcnmd -U <ids_address> <usernane> <passwor d> <I| NF pat h>

where ids_address is the IP address or host name of the driver store, username and password are
credentials of the user who has rights to add the drivers to the driver store and INF path is the path of
the Windows driver file.

Windows Client: Execute the following command to upload MAC driver:
iprntcnd -U [osx] <ids_address> <usernanme> <password> driver-Filepath

where ids_address is the IP address or host name of the driver store, username and password are
credentials of the user who has rights to add the drivers to the driver store, driver-Filepath is the path
of the Mac driver file (PPD or PDE).

Mac Client: Execute the following command:
iprntcnmd -u <ids_uri> <PPD path or Mac driver path>

where ids_uri is the IP address or host name of the driver store, and PPD path is the path of the
printer driver file or path of the driver package file.
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iPrint Appliance Server

iprntman is a command-line utility that helps you manage iPrint tasks on the iPrint Appliance server.
Linux: Execute the following command:

i prntman driver linux --upload --fromppd <PPD path> -u <eDir usernanme> -P <eDir
passwor d>

where PPD path is the path of the printer driver file, eDir username and password are credentials of
the eDirectory user who has rights to add the drivers to the driver store.

Modifying the Default Linux Driver Used by the Local
Renderer for Mobile Printing

iPrint Appliance ships with a default Linux driver that is used by the local renderer for mobile printing.
Remote renderer does not include any driver, you must upload the drivers available in the driver
store.

To modify the default Linux driver:

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

Micro Focus®
iPrint Appliance

o)
& Username

8 Password

© (2016) Micro Focus Software Inc.

2 Specify root or vaadni n as the user name.

3 Specify password. This password was created when you performed the Initial configuration of
the iPrint Appliance.
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The Appliance Console page is displayed.
4 Click Manage iPrint Appliance.

iPrint Appliance
Configuration

5 Under Configuration, click Renderers.

6 On the Renderers Configuration page, selectthe i Print Local Renderer, then click Edit.

a0e

7 In the Default Printer Driver drop-down list, select the driver that you want to set as default for
the local renderer.

NOTE: The drivers from the driver store are listed in the Default Printer Driver field.

Edit Renderer *®

Renderer Name: iPrint Local Renderer

Default Printer Driver: Generic PostScript Printer Foomatic/Postscript (re| v

Commit Cancel

If a printer does not have a driver associated to it, the default printer driver is automatically used
to print the documents.

Location Of the Linux Printer Drivers

iPrint Appliance ships with a default Linux driver that is uploaded to the Driver Store and used by the
local renderer for mobile printing.

If you want to modify the default Linux driver, the appliance is also bundled with additional Linux
printer drivers. To associate the drivers, you must upload the drivers to the Driver Store. The location
of the drivers is / usr/ shar e/ cups/ nodel and / usr/ shar e/ cups/ nodel / manuf act ur er - PPDs/

hpl i p.

To extract the relevant driver, execute the following command:
gunzip <path to ppd. gz>

For example, gunzi p /usr/share/ cups/ nodel / epson24. ppd. gz
Using iManager or CLI, you can upload the drivers to the Driver Store.

You can also download the Linux drivers from the OPEN PRINTING (http://www.openprinting.org/
printers) website and then upload to the Driver Store for association.
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Configuring Printing Through Mobile Devices

You can configure printers to accept print jobs through mobile devices, AirPrint or email.

+ “Configuring for Mobile Printing” on page 53
+ “Configuring for Email Printing” on page 53

+ “Printing Using Email” on page 57

+ “Printing via AirPrint” on page 57

+ “Generating QR Code for Printer” on page 58

Configuring for Mobile Printing

1 On a Web browser, use either the host name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. If you add the certificate to the trusted certificates list, the security warning is not
displayed.

2 In the Micro Focus iPrint Appliance Configuration login page, enter the user name as vaadni n,
enter the password that you specified for vaadmin, then click Log in.

3 Click Manage iPrint Appliance.
4 Under Configuration, click Printers.

The printers listed in this screen can be enabled for AirPrint, Mobile, and Email printing for iPrint
Appliance.

5 Select the printer that you want to configure. You can choose multiple printers at a time by
holding the Ctrl key.

The AirPrint, Mobile, Email, and Configure drop-down menus are activated.

6 To configure the printers for Mobile printing, click the Mobile drop-down menu, then select
Enable.

Printers Configuration @

Name AirPrint™ Mobile Printing Email Secure Location Description

B Printery Floord

Configuring for Email Printing

iPrint Appliance contains an email printing feature. Using email printing, you can print documents
from any device capable of sending emails. You can print emails by specifying email printing
commands in the subject line of the email. You can also print documents by emailing them to your
printer as attachments.

When you enable email printing, the email address you provide becomes the global print email
address. You can also configure a printer for private email printing by providing a specific email
address to each printer.
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The difference between global email printing and private email printing is:

+ Global Email Printing: When you enable email printing, you are prompted to specify an email
address. This email address is the global print email address. When configured for email
printing, iPrint Appliance becomes a client to an email server. The global email account inbox is
polled for incoming print jobs, which are then routed to the intended printer.

+ Private Email Printing: With private email printing, you can assign a specific email address to
each printer. When a user sends an email printing request, the print job is sent directly to the
printer. Users do not need to specify any print commands in the subject line of the email.

Email printing is not enabled by default. You can enable email printing through the Management
Console. You must create a unique email address for iPrint Appliance to receive and process print
requests. For more information on enabling Email, see “Global Email Settings” on page 106 and
“‘Enabling Private Email Printing” on page 98.

IMPORTANT: If you enable auditing for email print jobs, the email address of the user is logged in the
iPrint audit logs. If the same email address is populated for the user object in the LDAP source, then
the user FDN is logged instead of email address. This is important if you are using an accounting
software to ensure that jobs are tracked or accounted correctly.

+ “Email Printing Commands” on page 54

Email Printing Commands

You can print the body of the email and the attachments by using a few simple print commands in the
subject line of your email.
+ “Basic Print Commands” on page 54

+ “Additional Print Commands” on page 55

Basic Print Commands

hel p

Provides information on email printing commands.

list printers
To get the names of the available printers, send an email to the iPrint server address (for
example, iprint@example.com) with the subject line | i st printers.

print printer=<printer_nanme>

Prints your email and its attachments to the specified printer. For example, pri nt
print er=hp#Test Mail .

If you print to a specific printer by using the printer's email address, the print printer
command is ignored.

hol d printer=<printer_nane>

Queues your email along with its attachments and sends you the job ID as acknowledgement.

resune
Resumes the printing of a job that you put on hold. There are two ways to print a job on hold:
+ Send an email with subject r esune followed by the job ID. For example, r esune 10

+ Send an email with the original subject line prefixed with r esune. For example,
resume#Test Mail
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cancel
Cancels a job that you put on hold. There are two ways to cancel a job on hold:
+ Send an email with subject cancel followed by the job ID. For example, cancel 10

+ Send an email with the original subject line prefixed with cancel . For example,
cancel #Test Mai |

st at us
Displays the status of a job. There are two ways to check the status of a job:
+ Send an email with subject st at us followed by the job ID. For example, st at us 10

+ Send an email with the original subject line prefixed with st at us. For example,
stat us#Test Mai |

move
Moves a job to a new printer. There are two ways to move a job to a new printer:

+ Send an email with subject nove, the job ID, and the name of the new printer. For example,
nove 10 printer=<PrinterNane>

+ Send an email with the original subject line prefixed with nove, the name of the new printer,
and #. For example, nove pri nt er =<Pri nt er Nane>#Test Mai |

list jobs
Lists the details of the held jobs.

default printer

Displays the default printer.

default printer=<PrinterNanme>

Sets a particular printer as your default printer. After you set the default printer, you do not need
to include the printer name while printing to the default printer. You only need to use the pri nt
command followed by the email subject. For example, pri nt #Test Mai | .

Note
+ |f a printer name contains spaces, enclose the printer name within double (") or single (') quotes.
For example, print printer="HP PRI NTER .

+ To separate the email subject from the command, use #. For example, pri nt
printer=hp#Test Mail.

Additional Print Commands

In addition to the basic print commands listed above, you can use these commands to refine your
printing:
portrait [portrait=yes/portrait=y (or) portrait=no/portrait=n]
Prints your email content in portrait orientation. For example, pri nt printer=hp
portrait=y#Test Mail
| andscape [landscape=yes/landscape=y (or) landscape=no/landscape=n]

Prints your email content in landscape orientation. For example, pri nt pri nter=hp
| andscape=y#Test Mni |
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col or [color=yes/color=y (or) color=no/color=n]

Prints your email content in color. For example, print printer=hp | andscape=y
col or=y#Test Mil.

pages

Prints a given range of pages in your email. For example, the command pri nt pri nter=hp
| andscape=y col or=y pages=1-3#Test Mail prints pages 1, 2, and 3.

copi es

Prints the specified number of copies of your email and its attachments. For example, the
command print printer=hp | andscape=y col or=y pages=1-3 copi es=5#Test Mui | prints
5 copies of pages 1, 2, and 3.

dupl ex [duplex=yes/duplex=y (or) duplex=no/duplex=n]

Prints your email and its attachments on both sides of the printing paper. For example, the
command print printer=hp | andscape=y col or=y pages=1-3 copi es=5
dupl ex=y#Test Mai | prints 5 copies of pages 1, 2, and 3 in duplex mode.

nedi a
Prints your email and its attachments with the specified paper type. The default paper type is
‘LETTER.” You can change the default paper type by using the iPrint Appliance Management
Console. The other available print paper types are A3, A4, and other common paper types. For
example, the command print printer=hp | andscape=y col or=y pages=1-3 copi es=5
dupl ex=y nedi a=A3#Test Mail prints 5 copies of pages 1, 2, and 3 in duplex mode, on an A3
size paper.

mai | body [mai | body=yes/ nai | body=y (or) nai | body=no/ nmai | body=n]

Prints either your email and its attachments or only the attachments from your email without the
email body. For example, using the command print pri nt er =hp | andscape=y col or=y
mai | body=n#Test Mail prints only the email attachments in landscape mode.

NOTE: If you do not specify any of the additional commands, your print job is carried out according to
the default preferences set by your administrator.

IMPORTANT: When printing to a specific printer using the printer’s private email address, you do not
need to specify the printer's name in the command. You can also leave the subject line empty.
Printing is carried out according to the default print options set by the administrator.

However, you must specify the print command in the following scenarios:

+ The administrator changes the subj ect _opti onal _for_printer_specific_emilstoFalsein
the iPrint Appliance Server Configuration file located at / et ¢/ opt / novel | /i pri nt mobi | e/
conf/iprintnobile.conf.

+ |If you want to customize the print options, you must specify the pri nt command, along with the
required print options. For example, pri nt | andscape=y col or=y pages=1-3 copi es=5
dupl ex=y medi a=A3#Test Mil .
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Printing Using Email

Using email printing, you can print documents from any device capable of sending emails. You can
print emails by specifying email printing commands in the subject line of the email. You can also print
documents by emailing them to your printer as attachments.

Ensure to meet the following prerequisites:

+ Appliance is configured with global or private email address. For example, iprint@example.com
+ The users are provided with the appliance configured email address

¢ List of printers configured for email printing
Perform the following steps to print using email:

1 Open an email. You can use any email mail box.

2 In the To field, specify the appliance configured email address. For example,
iprint@example.com

3 In the Subject field, specify the commands from the “Email Printing Commands” on page 54
section.

For example,
+ To print from a printer named printer1, print printer=printerl
+ To view list of printers that are available to print, list printers
+ To view the list of commands, hel p
4 Specify the information to print in the body of the message or add an attachment to print.
5 Click Send.
The document is printed and a confirmation message is received in the mail box.

Printing via AirPrint

AirPrint is an Apple technology that facilitates printing without the need to download or install drivers.
AirPrint enables easy discovery, automatic selection of media, and so on.

Mac, iPhone, iPad, or iPod touch users can use AirPrint to print over wireless network to AirPrint
enabled printers.

Enabling AirPrint through iPrint
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
Specify vaadmni n or r oot as the user name.
Specify the password, then click Log in.
Click Manage iPrint Appliance.

Under Configuration, click Printers.

oo g A~ W DN

Select a printer for which you want to enable AirPrint.
All Apple certified AirPrint printers are supported by iPrint for AirPrint printing.
7 Click the AirPrint drop-down menu, then click Enable Advertising.

iPrint AirPrint is now enabled on the iPrint printer. You can print to an iPrint AirPrint enabled printer
from any iOS device.
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Disabling AirPrint through iPrint

To disable AirPrint through iPrint:
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
Specify vaadni n or r oot as the user name.
Specify the password, then click Log in.
Click Manage iPrint Appliance.

Under Configuration, click Printers.

O g~ W DN

Select a printer for which you want to disable AirPrint.
The AirPrint and Mobile drop-down menus are activated.
7 Click the AirPrint drop-down menu, then click Disable Advertising.

Generating QR Code for Printer

User can scan a QR code to select a specific printer on their mobile device. To generate the QR code
for the printer, perform the following steps:
1 Create a QR code using any QR code generator.
The generator might include multiple formats, ensure to use Plain text format.
The format to use is ipp://<server ip or host name>/ipp/<printer name>
where the printer name is case-sensitive.
2 Print the generated QR code and paste it on the printer.

What’s Next

iPrint Appliance is now configured for printing through desktop, laptops, and mobile devices. You can
start printing to iPrint printers.

+ For desktop-quality printing on your mobile devices, it is highly recommended that you install the
remote renderer. You can download the remote renderer from the iPrint Appliance Management
Console. To install and configure the remote renderer, see “Installing and Configuring a Remote
Renderer” on page 82.

+ For managing iPrint Appliance, see Chapter 11, “Managing Print System,” on page 97.
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Migrating or Recovering an iPrint
Appliance

IMPORTANT: iPrint 3.2 is only available as an online update to iPrint 3.0.

To install a New iPrint Appliance 3.2: You must first install iPrint 3.0, and then apply the 3.2
updates. To apply the iPrint Appliance 3.2 updates, see “Migrating to iPrint Appliance 3.2” on page 61

During Appliance migration or when recovering an appliance, the configuration settings from an
earlier version or an existing appliance are copied and the new appliance is setup with the same
configuration.

+ “Migrating from iPrint Appliance 2.x to 3.0” on page 59
+ “Migrating to iPrint Appliance 3.2” on page 61
+ “Recovering an iPrint Appliance” on page 62

Migrating from iPrint Appliance 2.x to 3.0
When migrating an appliance the data from the secondary disk of earlier appliance is used to setup
the new appliance. We only support disk-based migration from 2.x to 3.0 versions. The earlier

versions (1.x) cannot be migrated directly to 3.0 due to changes in the schema. These changes were
done to provide enhanced features. You must migrate 1.x to 2.0 using zip file and then migrate to 3.0.

Support Matrix

You must upgrade to the latest supported patch version before migrating to iPrint Appliance 3.0.

Table 6-1 iPrint Source Version Support for Migration

Source Version Patch Version Status

21 patch 3 or later Supported

2.0 patch 5 Supported

1.1 Not Supported. Migrate to 2.x.
1.0/1.0.1 Not Supported. Migrate to 1.1, then 2.x.
Prerequisites

Failure to comply with any of the following critical points can result in a non-functional iPrint
Appliance.

+ Secondary disk that includes the configuration file (i pri nt confi g. zi p) of the earlier version.
+ Print pending jobs: Ensure to print or cancel any pending jobs.
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+ Remove all snapshots prior to upgrading an appliance: To ensure that correct disk file and
the latest configuration settings get migrated.

+ Meet all hardware and software requirements: See Chapter 3, “Planning Your Print
Environment,” on page 25.

+ Patch the appliance: See “Field Patch” on page 93.

+ You cannot migrate directly from iPrint 1.1, 1.0 or 1.0.1 to iPrint 3.x: You must first migrate
to iPrint Appliance 2.x, apply all patches, ensure that all desktop clients are updated, and then
upgrade to iPrint Appliance 3.x.

Migration Process

1 Shut down the earlier appliance. The new appliance will be configured with the same IP and
network settings.

N

Deploy iPrint Appliance with any virtualization software that can run the . ovf, . vhd , or. xen file
formats.

3 Attach the secondary disk of the earlier version of the appliance. This disk includes the
configuration file (i pri nt confi g. zi p) of the earlier appliance.

4 Power on the appliance.
5 On the Console tab, enter the root and vaadmin password for the new appliance.
The iPrint Appliance installation is now complete.

6 On a Web browser, use either the host name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. To avoid the security warning prompt every time you access the iPrint Appliance
Management Console, you can add the certificate to the trusted certificates list on your browser.

~

Specify vaadni n or r oot as the user name.

(]

Specify the password, then click Log in.

©

Click Migrate Existing iPrint Appliance.

. iPrint Appliance Configuration

| Migrate Existing iPrint Appliance

@ Previous appliance configuration detected.

« Modify Settings Getting Started

10 The iManager user name field is pre-populated and not editable. Specify the iManager password
that was used to configure the earlier version of the iPrint Appliance. This password will be used
to log in to the iManager for managing the print environment.
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. Migrate iPrint Appliance

Specify iManager password of the previous iPrint
Appliance

Usemame
cn=admin o=iPrintAppliance

Password:
Back
11 Click Finish.
The time taken to complete the configuration depends on the size of the earlier version
configuration file. On successful migration, the appliance reboots the VM.
The configuration file of the previous appliance is renamed as pr evi ous_i pri nt confi g. zi p.
Post-Migrate

*

If you have an existing remote renderer, then post-migration of appliance, the renderer might be
in an inactive state. To make the renderer active, stop and restart the renderer. After activating
the renderer you must upgrade it. For more information, see “Upgrading the Remote Renderer”
on page 86.

Migrating to iPrint Appliance 3.2

iPrint 3.2 is only available as an online update to iPrint 3.0. Previous migrate methods do not apply to
iPrint Appliance 3.2. To update to iPrint Appliance 3.2, do the following:

1
2
3
4

a

Ensure that the version of iPrint Appliance is 3.0.
Log in to the Appliance Configuration Console (https://appliance_ip_or_dns:9443).
Click Online Update.

In the Patches drop-down option, select Needed Patches. The iPrint Appliance 3.2 patch update
is listed.

Click Update Now.

6 Th update might require a appliance restart, Click OK.

A progress bar displays the status of the update. After the update completes, select the Installed
Patches option in the drop-down and verify that the installed patch is listed there.

On successfully applying the updates, you must reboot the appliance.
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Recovering an iPrint Appliance

The appliance configuration can now be recovered in case of a crash. You either need a backed-up
secondary disk or the last backed-up configuration zip (i pri nt confi g. zi p) file for recovering the
appliance.

If you attach a secondary disk of the backed-up appliance, the GUI provides option to proceed with
Migrate Existing iPrint Appliance.

Recovering Appliance Using a Zip File

You can recover iPrint Appliance using a configuration file (i pri nt confi g. zi p).

Ensure that the copy of the configuration file (i pri nt confi g. zi p) of the backed-up appliance is
available before performing recovery.

1

Create a copy of the configuration file (i pri nt confi g. zi p) of the appliance. For more
information, see “Exporting the Configuration File” on page 63.

Shut down the non-functional appliance. The new appliance will be configured with the same IP
and network settings.

Deploy iPrint Appliance with any virtualization software that can run the . ovf, . vhd , or . xen file
formats. For more information, see “Configuring Virtual Environment” on page 31.

When the appliance is powered on, click the Console tab. Ensure you provide the same network
configuration, passwords, and time zone as that of the earlier version of iPrint Appliance from
which you exported the i pri nt confi g. zi p configuration file.

The iPrint Appliance installation is now complete.

On a Web browser, use either the host name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.

Ignore the security certificate warning, and continue to the iPrint Appliance Management
Console. To avoid the security warning prompt every time you access the iPrint Appliance
Management Console, you can add the certificate to the trusted certificates list on your browser.

Specify vaadni n or r oot as the user name.

7 Specify the password, then click Log in.

Click Recover iPrint Appliance.

" Configure New iPrint Appliance |

Recover Existing iPrint Appliance

« Modify Settings Getting Started

In the Configuration File option, click Browse..., then select the configuration file exported from a
previous copy of iPrint Appliance. For more information about the i pri nt confi g. zi p, see
“Exporting the Configuration File” on page 63.
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° Recover iPrint Appliance

Specify the configuration file (zip) from an earlier version
of the iPrint Appliance.

Configuration File:

Choose File |No file chosen

Specify the iManager password that was used to
configure the earlier version of iPrint Appliance.

Username:
cn=admin,o=iPrintAppliance

Password:

Back

10 Specify the iManager password that was used to configure the earlier version of the iPrint
Appliance.

11 Click Finish.

The time taken to complete the configuration depends on the size of the earlier version
configuration file. On successful migration, the appliance reboots the VM.

Exporting the Configuration File

To create ai pri ntconfi g. zi p file, you must copy the configuration information from an existing
iPrint Appliance.

1 On the iPrint Appliance, either use host name or the IP Address to access the Management
Console. For example, https://10.0.0.1:9443 or http://iprint.example.com/admin.
Ignore the security certificate warning.
2 Specify vaadni n orr oot as the user name.
3 Specify the password.
The Appliance Configuration page is displayed.
4 Click the Manage iPrint Appliance icon.
5 Under Configuration, click Backup.
6 Click Backup Now.
On successful backup, the file is available for download.

7 Click Download Backup File. This downloads the i pri nt confi g. zi p file that contains the
configuration information.
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Migrating Printers from an OES iPrint
Server

During the process of migration the iCM settings and ACLs are automatically migrated to the iPrint
Appliance and depending on your selection printers, drivers, driver profile, and printer configuration
details are migrated.

For more information about the Migration GUI, see OES 2015 SP1: Migration Tool Administration
Guide.

Prerequisites

+ Ensure all users are migrated from OES to iPrint Appliance by using Import Users/ Groups task
from Management Console. For information on how to import users from an LDAP source, see
“Directory Servers” on page 109.

+ Enable SSH service on the appliance. To enable SSH, see “System Services” on page 91. By
default, the ssh service is disabled.

Migrating Printers

1 The Migration GUI must be launched from your Windows, Linux or Mac machines. Using iPrint
Appliance you cannot launch the Migration GUI.

1a To connect to the iPrint Appliance by using Windows (SSH):

1a1 Launch SSH Client and connect to the iPrint Appliance. You must have X server
running on your computer.

1b To connect to the iPrint Appliance by using Linux or Mac:
1b1 Launch the terminal, then run the command ssh - X <i Pri nt Appl i ancel Paddr ess>.
2 Log in as the root user and at the command prompt, enter m ggui .

3 (Optional) Click Save Project. If you save a project, the next time you want to import printers, you
can use the saved file to retrieve your preferences instantly.

4 Specify the credentials to authenticate to the source and iPrint Appliance server.

If the source server is OES 2 SP3, OES 11, or OES , specify the password for authentication in
the root Password field.
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&Sﬂurce Server Authentication Pr— E

Server: |192.168.1.255 [v]

(e.g. 192 168 xxx Ky ar Host Mame)
[ |15 Cluster Resaurce

User Mame ||:n=admin,|:|=n|:wEII |v|

fe.0. ch=admin, o=campanyname)

Password |"--" |

root Passwaord : |"--u |

[(Fequired for OES Linux server) l

b Port: 636 =] Use Ss5L

@ Help B oK € Cancel
(-
-
A Target Server Authentication - g
Uzer Mame : ||:n=admin,|:|=n|:wEII |v|

(e.0. cn=admin, o =companyname)

Password : |""" |

root Password ; |------ |

! Port: 636 |~] [v] Use 551 I
b |
® Help [ oK € Cancel
L
5 Click Add.

6 Select Micro Focus iPrint, then click OK.
7 In the Configure Service dialog box, click Yes. The iPrint configuration windows is displayed.
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iPrint Migrationi(on wgp-print-231)

[_Print Options | other Options |

Print Managers

Select printers from Source printers list to migrate,

Source Print Manager : | |
Target Print Manager : ||:n=print_manager,n=iprintappliance | Get Printers

[] eDirectory Server* :

*In case the Target Server does not hold a ebirectory replica
Printer Objects

SOuUrce printers: [ "Printer with same name exists on Target cantext)
Select | Printer Agents Cantext
[ ]select Al Filter |

Create Target printer objects in:

() Context same as Source grinter context

® Target context: | |

[ ] Do Mot Migrate Existing Target Printers

[ Ea ][ O |

For mare informatiaon, refer to [Print Migration Best Practices Guide,

[»

4

8 Configure the following parameters to proceed with the migration process:

Print Objects Parameter Description

Print

Source Print Manager  Specify the active Print Manager on the source server. The

Managers source Print Manager can be either an NDPS manager (for

NetWare 6.5) or iPrint Manager (OES 2 SP3, OES 11, or OES
). To go directly to a context of your choice, specify the context
in the search base and click Search. The objects in the
specified context are displayed.
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Print Objects Parameter

Description

Target Print Manager

Printer Source printers
Objects

Select All

Filter

Create target  Context same as
printer source printer context
objects in

Target context

Do Not Migrate Existing
Target Printers

The Target Print Manager field is populated with the name of
the active Print Manager running on the target server. This field
is editable; you can also specify a different name for the active
Print Manager. To go directly to a context of your choice,
specify the context in the search base and click Search. The
objects in the specified context are displayed.

Click Get Printers to select printer objects from the source
Print Manager.

Displays all printers of the active Print Manager available on
the source server. The printers that already exist on the target
server are indicated by an asterisk (*).

Selects all the printers listed in the Printer Objects dialog box.

NOTE: When you apply a new filter or modify an existing filter
and click Select All, only printers that are displayed after
applying the filter are selected. When you manually select all
printers, the selected printers are migrated.

Specify the search pattern in the Filter field. This displays the
printers in the Printer Agents list. This field is case sensitive.

Select this option to use the same context as the source
printers on the target server.

This option is selected by default. It allows you to create source
printers under a different context on the target server. This
option does not maintain the context hierarchy of the source
printer.

To go directly to a context of your choice, specify the context in
the search base and click Search. The objects in the specified
context are displayed.

If the printer names on the source server match the printer
names on the target server, the target printer properties and
attributes are overwritten by the source printer properties and
attributes.

The printers that already exist on the target server are
represented by an asterisk (*).
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iPrint Migrationi(on wgp-print-231)

Print Options | Other Options |

Source Driver Store
[ ] The Source Driver Store is not on the same Server as the Source Print Manager
IP Address/DMS Mame .

User Mame :

Fassward

Migrate the following additional source Print Brakers to the Target Driver 3tore:

IP Address/DMS Mame Braker volume Mame

Target Driver Store
Target Driver 5tore DM
[] Target Driver Stare is remote
IF Address/DMS Mame :

ser Mame :

Password :

Printer Drivers
Ciptions to Migrate Printer Drivers:

) Do Mot Migrate Printer Driver and association of the Printer Agents with the Driver.
) Migrate Printer Driver if the driver is not present in the Target Driver Store.
3 Migrate all Printer Drivers. T?’Ei mverwrites the Printer Driver an the Target Diriver Store.

Migrate drivers for the followitg platforms:

All |~
Windows 93/98 =
Windows NT 4 —
Windows 2000

Windows XP - |

Press Ctri+ Click to select ar deselect more than one platform

Migrate Printer Driver Profiles. This owerwrites the existing Printer Driver Profiles
Migrate iPrint.ini file. Thiz overwrites the existing iPrint.ini file on Target

(] [=]

| [ ok | ‘ @ Cancel

For mare informatiaon, refer to [Print Migration Best Practices Guide,

[»

4

Other Options Parameter Description

Source Driver The Source Driver

Store

same server as the

If the source Driver Store is running on a server different from
Store is not on the the source Print Manager's server, this check box is selected.

Source Print Manager ~ SpPecify the IP address or the host name and the root password
of the server on which the source Driver Store is located.
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Other Options Parameter Description

Migrate the following This section lists the names and IP/DNS addresses of the
additional Source Print  source Print Broker volumes that must be migrated to the target
Brokers to the Target Driver Store.

Driver Store
Click the plus button (+) and specify the IP address or the host

name of the Source Broker. Select the Source Broker volume
from the drop-down list and click OK. The list is populated with
the IP address or host name of the Source Broker and Broker
volume name. You can add multiple Source Brokers to the list.

To remove the Source Broker from the list, select the IP
address or host name and click the minus button (-). You can
remove one Broker at a time.

Target Driver  Target Driver Store is  If the Driver Store is running on the remote server (other than
Store remote the target server), the Target Driver Store is remote check
box is enabled.

Specify the IP address or the host name of the remote server
and the root password of the remote server in the
corresponding entry fields.

Printer Do not Migrate Printer ~ Selecting this option ensures that printer drivers and the
Drivers Drivers and the association of Printer Agents with the drivers are not migrated.
association of the
Printer Agents with the
Driver

Migrate Printer Driver if Selecting this option migrates the printer drivers for the

the driver is not present selected driver platforms from the Select Driver Platforms to

in the target Driver Migrate list, if they are not present in the target Driver Store.

Store This also migrates all the associations of the Printer Agents
with the driver.

NOTE: The default driver platform selection is All.

Migrate all Printer Selecting this option overwrites the target drivers for the driver
Drivers. This overwrites platforms you have selected from the Select Driver Platforms to
the Printer Driver on Migrate list, if the driver names in the target Driver Store are the

the target Driver Store same as the source Driver Store. This also migrates all the
associations of the Printer Agents with the driver.

NOTE: The default Driver Platform selection is All.

Printer Driver Migrate Printer Driver  If the profiles are the same on the target server as the source
Profile Profile server, the target profiles are overwritten.

iPrint.ini File  Migrate iPrint.ini File If you migrate printer agents from two or more print managers,
thei Print.ini file on the target server is replaced by the
i Print.ini file of the last source server.

NOTE: After migration, if the target server'si print.ini fileis
overwritten by the source server's file, and if the target server's
i print.ini file had new parameters that were erased, you

can restore them by copying the parameters manually from the
i print.bak file. Thei pri nt. bak file is a backup of the target
server'siprint.ini file. After migration, the i pri nt . bak file
is saved in the / var/ opt/novel | /i pri nt/ htdocs directory.

9 Click OK to finish the configuration and go back to the migration screen.
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10 Click Migrate to begin the migration process.

Using iManager, you can verify the details of the migrated printers.
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Migrating Printers from an Active
Directory Environment

Using the Print Transfer Utility (PTU) you can migrate the TCP/IP printers from the Active Directory
(AD) environment to the Micro Focus iPrint Appliance. The utility only migrates the printers that are
published to the AD domain.

The migrated printers will be available only as iPrint printers and all the features such as Mobility,
QuickPrint, and so on can be used by the users.

+ “Prerequisites” on page 73
+ “Downloading and Installing PTU” on page 73

*

“Migrating Printers” on page 74
+ “Viewing Migrated Printers” on page 77

*

“Log Files and Reports” on page 77

*

“Limitations” on page 77

Prerequisites

+ Windows server 2008 and above with AD and domain controller configured
+ TCP/IP printers published to an AD server
+ Microsoft .NET Framework 4.5 and above for the Windows Server

Downloading and Installing PTU

+ “Downloading PTU (iPrint Appliance 3.2)" on page 73
¢ “Installing PTU (Windows AD Server)” on page 74

Downloading PTU (iPrint Appliance 3.2)
1 On a Web browser of iPrint Appliance 3.2, specify either the host name or the IP address of the
iPrint Appliance. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Specify vaadni n orr oot as the user name.
3 Specify the password, then click Log in.
4 Click Manage iPrint Appliance.

5 In the Management Console, click Printers, then click download icon g.This downloads the
PrintTransferWility. nsi.
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Installing PTU (Windows AD Server)

1 CopythePrintTransferWility. msi to a Windows Domain Controller from where you plan to
migrate the printers.

2 Run the nsi and install it.
The Micro Focus Print Transfer Utility is now available on your server.

Migrating Printers

The printers from the Windows AD domain are migrated to the iPrint Appliance. Migration creates a
copy of the printers on the iPrint Appliance and no printers are synced with the Windows printers. On
successful migration, assign the ACLs and associate the drivers for the migrated printers in the iPrint
Appliance.

1 Run the Micro Focus Print Transfer Utility by double-clicking the icon.

=)

Micro Focus
Print Transfer
Utility

2 Specify the credentials of iPrint Appliance and click Connect.
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Print Transfer Utility

Micro Focus® iPrint

Welcome to Print Transfer Utility

Use this utility to migrate TCP/IP printers from the Active Directory server to Micro Focus iPrint server.

Active Directory Context e
Domain: PRINTWORLD.MET
Domain Administrator: PRINTWORLD Administrator

iPrint Server Credentials

Server: | Hostname or IP address |
User Mame: | Username or (cn=admin,o=iPrintApp e |
Password: | |
'?— i » [
?_‘ J ?_‘ J
= T e =_
(=) S — V)

Select the printers that you want to migrate from the AD domain to the iPrint Appliance, then
click Next.

Print Transfer Utility — x

Search printer here | 9

Printer Name Location IP Address Migrated Description

[v] test-printer 7th Floor Lab 192.168.1.23 No MFC Updated Printer
RicohColor 8th Floor Lab 192.168.10.23 MFC Printer

[ select all printers Selected: 2/2 Next
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4 Continue with default options or modify the options as per your requirements, then click Migrate.

Print Transfer Utility — X

Migration Options

Duplicate Printer Resolution
When a printer from an AD server already exists on the iPrint server
® Do not overwrite the existing iPrint printers

) Overwrite the existing iPrint printers

Features on the migrated printers

i Mobility Enabled
[] QuickPrint
i Secure Printing

i Public Visibility

Back l l Migrate

Duplicate Printer Resolution: For the migrated printers, the utility matches the printer name
and domain context of the printers from the Windows AD domain and iPrint Appliance to locate
the duplicate printers.

+ Do not overwrite the existing iPrint printers: The migrated printers from the Windows
AD domain are ignored and are not migrated again to the iPrint Appliance.

+ Overwrite the existing iPrint printers: The migrated printers with same name on the
iPrint Appliance are overwritten.

Features on the Migrated Printers: The migrated printers will be enabled for the features
selected in this GUI. After successful migration, you can modify the features using the
Management Console in the iPrint Appliance.

5 The Migration status of the printers is displayed. Click Finish to exit the utility or click View
Report to view the details of migration.

The iPrint Appliance creates a directory structure of the migrated printers similar to the one available
on the Windows machine. The same can be verified using iManager.
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Viewing Migrated Printers

1 On a Web browser, specify either the host name or the IP address of the iPrint Appliance. For
example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify vaadmi n or root as the user name.
3 Specify the password, then click Log in.
4 Click Manage iPrint Appliance.

5 In the Management Console, click Printers, the migrated printers are suffixed with a Windows
icon.

Printers Configuration 00

AirPrint™ Mgbile Printing Email Secure Location Description

Log Files and Reports

+ PrintTransferUtil.log: The PTU log file is located at c: / ndps/ user s/ <user nane>/
PrintTransferUil.exe/ PrintTransferWil .l og. By default, the log file captures Info
messages. To modify the log levels, edit the file C: \ ProgramFi | es (x86)\ M cro Focus\ Pri nt
Transfer Wility\PrintTransferUil.l og4net.

+ Report: The report captures the details of migration performed by PTU. The file is located at
C.\NDPS\ Print Transfer Uil _Reports.

Limitations

+ Windows printer names with unsupported characters are not migrated

+ Windows printer names with length more than 31 characters are not migrated

+ Windows printer with the same name as an iPrint Appliance printer is not migrated
+ Windows printers with IPV6 address are not supported for migration

Migrating Printers from an Active Directory Environment
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9 Document Rendering

iPrint Appliance provides a client-independent and driverless printing environment to mobile users.

+ “Overview” on page 79

+ “Key Features” on page 80

+ “Installing and Configuring a Remote Renderer” on page 82
+ “Upgrading the Remote Renderer” on page 86

+ “Managing the Remote Renderer” on page 86

+ “Remote Renderer Commands” on page 87

Overview

What Is a Renderer?

iPrint now supports printing from mobile devices that have limited abilities to convert documents into
print-ready formats. On desktop platforms, the documents are usually converted to print-ready
formats by the application, driver, and the spooler subsystems. This functionality is primitive or non-
existent in many of the mobile devices and hence must be provided by the Print Service. To facilitate
this, iPrint now provides Rendering and Conversion capabilities in the product and can convert and
render most of the documents that are submitted by a mobile device, email, or other submission
methods.

This conversion (rendering) is performed on the iPrint Appliance using our built-in solution known as
Local Renderer. Printing quality varies, depending on the document complexity so for enhanced
desktop-quality printing, you can use the Remote Renderer on a Windows platform.

You can view the Local renderer and list of remote renderers in the Management Console > iPrint
Appliance Configuration, Renderers page.

The renderers support broad range of document formats. For more information, see “Supported
Document Formats By the Local Renderer and Remote Renderer” on page 238.

Local Renderer

iPrint Appliance is bundled with a built-in document renderer known as Local Renderer. The renderer
converts documents to the PDF format, and then converts them to the print-ready format using
CUPS. The renderer supports multiple formats, has a multithreading feature, and provides limited
support for Microsoft Office formats. If a printer does not have a driver associated with it, the default
printer driver PostScript 3 is automatically used to print documents.
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Remote Renderer

iPrint Appliance also ships with a Remote Renderer. For enhanced desktop-quality printing, you can
use the Remote Renderer. The remote renderer can be downloaded from the iPrint Appliance
Management Console and installed on a Windows 64-bit computer.

The remote renderer provides high quality rendering for different formats. The remote renderer job
might take some additional time to complete the print jobs in comparison to the local renderer. If you
do not want to use the built-in PDF renderer, you can also install Adobe Acrobat Pro for PDF
rendering. However, if you are printing PDF using a built-in pdf renderer, then there can be some
minor print quality differences such as color shade difference in the PDFs.

The remote renderer communicates with iPrint Appliance for document conversion. Although, it is not
a mandatory requirement for iPrint Appliance, the remote renderer is recommended for desktop
quality printing.

Key Features

+ “Multi-driver Support” on page 80
+ “Secure and Non-secure Communication Support (Remote Renderer)” on page 80
+ “Automatic Printer Driver Updates” on page 81

+ “Printer Rename and Redirection (Remote Renderer)” on page 81

Multi-driver Support

On iPrint Appliance, you can configure the local and remote renderer to use multiple drivers for
different mobile enabled printer agents. The renderer installs the unique drivers associated with
various mobile enabled printer agents, on the renderer machine. During the rendering of jobs, the
correct printer driver is selected based on the printer agent to which the job is being submitted for
rendering.

If a printer agent does not have any driver associated with the renderer platform, the renderer uses
the default driver for rendering the jobs sent to those printer agents. You can select a default driver
when adding a renderer from the Management Console. The Management Console also provides an
option to change the default drivers.

For information on how to upload drivers to the Driver Store, see “Configuring Printer Drivers” on
page 45.

Secure and Non-secure Communication Support (Remote
Renderer)

On iPrint Appliance, the remote renderer can communicate over secure and non-secure channels
with the iPrint Appliance. By default, the iPrint Appliance is set to communicate in both secure and
non-secure modes.

Secure Communication Mode: When this mode is used, only the secure remote renderers can
communicate with the iPrint Appliance. For information on how to configure the iPrint Appliance and
renderer in a secure mode, see “Secure Communication Mode” on page 84.

Non-secure Communication Mode: When this mode is used, both secure and non-secure remote
renderers can communicate with the iPrint Appliance. For information on how to configure the iPrint
Appliance and renderer in a non-secure mode, see “Non-secure Communication Mode” on page 85.

Document Rendering



Non-secure communication mode is desirable in the following scenarios:
+ Experiencing problems with third-party certificates

The iPrint Appliance handles third-party certificates well when working with secure web tools and
authentications from the iPrint Mobile App. However, some third-party certificates can be
problematic when registering a remote renderer; in these situations, non-secure communication
mode is convenient because certificates are not used for the remote renderer registration.

+ Domain suffix for the iPrint Appliance and the remote renderer does not match

Secure communication mode requires both the iPrint Appliance and the remote renderer to have
matching DNS domain suffixes. For example, iprintserver.company.com and
remoterenderer.cityname.company.com will cause the remote renderer registration to fail if the
secure communication mode is selected. The non-secure communication mode ignores the
DNS suffix matching requirement.

You can verify the mode of the renderer in the Renderers page under the Secure Mode column.

+ If the Secure Mode column displays false, then the renderer is in a non-secure communication
mode.

+ If the Secure Mode column displays true, then the renderer is in a secure communication mode.

Automatic Printer Driver Updates

The local and remote renderer supports the Automatic Driver Update feature. When a printer driver is
updated on the Drive Store, or if the association of a particular printer agent is changed, the driver is
automatically updated on the renderer.

Local Renderer: All the jobs submitted for printing is rendered by the driver that is currently
associated with the printer. However, the first print job that is sent for printing after the driver
association change may take some time to be rendered depending on the size of the driver.

Remote Renderer: All the jobs submitted for printing is rendered by the driver that is currently
associated with the printer. However, the first print job that is sent for printing after the driver
association change may take some time to be rendered depending on the size of the driver. This is
because the remote renderer installs the driver first and then processes it for rendering.

Printer Rename and Redirection (Remote Renderer)

If a printer is renamed or redirected through the Management Console, the remote renderer
automatically updates its configuration to associate the correct printer drivers with the printer.

When you redirect a printer, the printer driver associated with the destination printer is used for
rendering.
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Installing and Configuring a Remote Renderer

For desktop quality printing for Microsoft Office and PDF documents, you must install a remote
renderer on a Microsoft Windows 7, Windows 8.1, Windows 2008 R2, Windows 2012, or Windows
2012 R2 64-bit system with a dual-core processor or higher.

During the remote renderer configuration process, when prompted for service configuration
credentials, local users must specify the credentials of an account with Windows admin and domain
users must specify the user name in [domai nnane] \ [ user nane] format.

*

*

“Prerequisites” on page 82

“Assigning Log On as a Service Rights” on page 82
“Downloading the Remote Renderer” on page 83

“Installing and Configuring the Remote Renderer” on page 83
“Registering the Remote Renderer” on page 84

“Secure Communication Mode” on page 84

“Non-secure Communication Mode” on page 85

Prerequisites

Before installing and configuring the remote renderer, ensure that you have met the requirements
listed in “Remote Renderer Requirements” on page 29 and the following prerequisites:

*

At least one printer driver is uploaded to the Driver Store for the Windows platform on which you
are setting up the renderer. This is required because when you add a remote renderer from the
Management Console, you must designate one driver as the default driver for the renderer.

NOTE: It is recommended that you upload a universal printer driver such as HPUPD, and set
that as the default driver.

You must assign Log on as a service rights to the account with which you want to set up the
renderer.

Assigning Log On as a Service Rights

Before configuring the remote renderer, you must assign the Log on as a service rights to the account
with which you want to set up the renderer, on the local machine.

1 On your Windows computer, Go to Start > Control Panel.

2 In the upper-right corner of the Control Panel window, click the View by drop-down menu, then

© 00 N OO 0o A~ W

select Large icons.

Go to Administrative Tools > Local Security Policy.

In the left pane, double-click Local Policies.

Click User Rights Assignment.

In the right pane, under Policy, double-click Log on as a service.

Click Add User or Group.

Specify the user name in the Enter the object names to select box, then click Check Names.
Click OK after the user is displayed.
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10 Click OK.
11 Click OK, then close the Local Security Policy window.

Downloading the Remote Renderer

1 On a web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify root or vaadni n as the user name.

3 Specify the password that you provided for root or vaadmin.
The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Configuration, click Renderers.

6 Click the gicon in the upper-right corner of the screen.

Renderers Configuration @DQ
Retresn

NOTE: The remote renderer installation interface is not available in Slovak, Hungarian,
Netherlands Dutch, or Catalan languages

A zip file named i Pri nt Render er Bundl e. zi p is downloaded. This zip file contains a set up. exe file,
i Print Renderer Set up. nsi file, readne. t xt, and a devi ce. pf x certificate file.

Continue with installing and configuring the remote renderer.

Installing and Configuring the Remote Renderer

1 Unzip the i Pri nt Render er Bundl e. zi p file, then launch the set up. exe file. Follow the on-
screen prompts to complete the installation procedure.

2 When the installation is complete, launch the command prompt in the Run as administrator
mode.

3 Run the command i Prnt RendCmd - ¢ to configure the remote renderer.

3a If you want to configure the remote renderer over a secure channel and if you are using a
self-signed digital certificate, copy the devi ce. pf x file into the
C:\NDPS\ Renderer\certificates\ folder.

3b If you want to configure the remote renderer over a secure channel and if you are using a
third-party certificate, copy the PKCS12 file of type . pf x or .p12 into the
C. \ NDPS\ Render er\certificates\ folder.
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4 When prompted for Do you want to configure the remote renderer over secure channel,
depending on your requirement, specify Yes or No.

4a When you specify Yes, the renderer is configured in a secure mode. You need to perform
additional steps, if you need iPrint Appliance to accept only secure communications. For
more information, see “Secure Communication Mode” on page 84.

4b When you specify No, the renderer is configured in a non-secure mode. You need to
perform additional steps to ensure that iPrint Appliance accepts non-secure
communications. For more information, see “Non-secure Communication Mode” on
page 85.

5 When prompted for credentials, specify your credentials.

On successful configuration, you must register the Remote Renderer.

Registering the Remote Renderer

1 On the Management Console, click iPrint Appliance Configuration.
2 Under Configuration, click Renderers.

3 Click New.
4

In the Renderer Host/IP address box, specify the hostname or IP address of the renderer
system, then click Connect.

5 Under Options, specify a name for the renderer in the Renderer Name box.

6 Select the document formats you want the remote renderer to render.

7 Choose the Default Printer Driver, then click Register.
After you click the Register button, a success message is displayed, but the remote renderer is still
configuring. The configuration time depends on the number of unique drivers associated with mobile
enabled printers. During that period, the renderer is in the Configuring state. After the configuration is
complete, the renderer changes to the Active state. When the status of the remote renderer displays

Active, it means that the registration is successful. Refresh the page after a couple of minutes to
check the status.

Secure Communication Mode

By default, the iPrint Appliance accepts both secure and non-secure communication.To set only
secure communication mode, you must ensure that the renderer is secure and the iPrint Appliance
accepts only secure communications.

On the Windows computer, run the i Prnt RendCnd - ¢ command to configure secure remote renderer.
On configuring the renderer to a secure mode, you can verify the status in the Management Console,
Renderers page under the Secure Mode column, the value displayed is true.

To configure iPrint Appliance to accept only secure communications, modify the secure
communication settings in the Management Console as follows:

1 On a web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the root or vaadmin name that you provided as the user name.

3 Specify the password that you provided for the root or vaadmin.
The Management Console page is displayed.

4 Click iPrint Appliance Configuration.
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5 Under Configuration, click Renderers. All the available renderers are displayed.
6 Click the Secure settings for renderers icon.

The Secure Communication Settings window is displayed.

Renderers Configuration @

Hew Rtk
MName Version Address State Secure Mode Supported Formats

e Weasa

E 20006 192.968.1:2 At Y c, B0, S0C, Gotm, [P, PR, PR, BRAM, PR, (2, xS, xisb, xem, s
aariues 006 192.168.133 cive Tes e, @00, S0C, S0, P, P ..

bamp, 93, e, de, doem, doe,
o

Prik Locsl Randensr 20 162.160.1 3% active e

Sremre Commumication Sctlings ®

SeleCt the COMMUNICANON Sengs between the remate
. Thits setting is applicable to the

7 Select the Use Secure Mode Only check box, then click OK. The iPrint Appliance will now accept
only secure communications. The non-secure renderers will fail to communicate with the iPrint
Appliance and no jobs can be rendered by those renderers.

Non-secure Communication Mode

By default, the iPrint Appliance accepts both secure and non-secure communication but if the iPrint
Appliance is modified to accept only secure communications, then you must modify the iPrint
Appliance to accept both secure and non-secure communications.

On the Windows computer, run the i Prnt RendCnd - ¢ command to configure the non-secure remote
renderer. On configuring the renderer to a non-secure mode, you can verify the status in the
Management Console, Renderers page under the Secure Mode column, the value displayed is false.

Modify the secure communication settings in the Management Console for iPrint Appliance to accept
both secure and non-secure communications:

1 On a web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Specify the root or vaadmin name that you provided as the user name.

3 Specify the password that you provided for the root or vaadmin.
The Management Console page is displayed.

4 Click iPrint Appliance Configuration.

5 Under Configuration, click Renderers. All the available renderers are displayed.

6 Click the Secure settings for renderers icon.
The Secure Communication Settings window is displayed.
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Renderers Configuration @

Version Address State Secure Mode Supported Formats

oo, Socx, @otm, Pal, PR, PR, BRUM, PRtx, 1, 8, xisk, lem, xisx

Sremre Commumication Sctlings ®

SECTings between the remote

Select the comy
rendrer 3 is seeting Is applicable o the

7 Deselect the Use Secure Mode Only check box, then click OK. The iPrint Appliance will now
accept both secure and non-secure communications.

Upgrading the Remote Renderer

If you have upgraded your iPrint Appliance, you must also upgrade the remote renderer. Before
upgrading the remote renderer, ensure that you have applied the patch and updated the iPrint
Appliance server.

Upgrading from 2.0 or later to 3.x

The version of the remote renderer for 2.x and 3 is same. To make the renderer active after upgrading
the iPrint Appliance server, you must reconfigure the renderer using the command i Pr nt RendOmd - c.

Managing the Remote Renderer

You can manage the remote renderer through the Management Console.
1 On a web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Specify root or vaadni n as the user name.
3 Specify the password that you provided for root or vaadmin.
The Management Console page is displayed.
4 Click iPrint Appliance Configuration.

5 Under Configuration, click Renderers.
On the Renderers page, you can perform the following actions:

+ “Add a Renderer” on page 87
+ “Edit a Renderer” on page 87
¢ “Delete a Renderer” on page 87

+ “Activate or Deactivate a Renderer” on page 87
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Add a Renderer

1 On the Renderers page, click New.

2 In the Renderer Host/IP address box, specify the host name or IP address of the renderer
system, then click Connect.

3 Under Options, specify a name for the renderer in the Renderer Name box.
4 Select the document formats you want the remote renderer to render.

NOTE: The PDF Formats option along with the In-built PDF renderer is selected by default. If
you want to use Adobe Acrobat, you must ensure that Adobe Acrobat Pro is installed on the
renderer machine before selecting the Adobe Acrobat option. Similarly, if you want to enable the
remote renderer to render Microsoft Office formats, you must ensure that Microsoft Office is
installed on the renderer machine before selecting the Office Formats option.

5 Choose the Default Printer Driver, then click Register.

Edit a Renderer

You can change a remote renderer’s name, the document rendering options, and the default printer
driver using the Edit feature on the Renderers page.

1 On the Renderers page, select a renderer which you want to edit, then click Edit.
2 Change the rendering options, then click Commit.

Delete a Renderer

1 On the Renderers page, select a renderer that you want to delete, then click Delete.

Deleting a renderer unregisters the renderer from iPrint Appliance.

Activate or Deactivate a Renderer

1 On the Renderers page, select a renderer that you want to activate or deactivate, then click
Activate/De-Activate.

If the renderer is in an Active state, it is deactivated. If the renderer is in an Inactive state, it is
activated.

If the renderer is in an Inactive state, it will not render any job.

Deactivating a renderer does not unregister the renderer from iPrint Appliance.

Remote Renderer Commands

The management of remote renderer is supported from the Management Console. You can
additionally use the command line interface by launching the command prompt in the Run as
administrator mode and executing the i Pr nt RendCnd command for the following operations:

Command Description

-h|--help Shows the various available commands with their syntax.
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Command

Description

-V | --version

-C | -
configureservice
-u | —-

unregisterrenderer
<iPrint Appliance
server Fully
Qualified Domain
Name or IP
address>

-rt | -
reregisterrenderer
<iPrint Appliance
server Fully
Qualified Domain
Name or IP
address>

-s | -
rendererstatus

1]
launchrenderer

- g |--stoprenderer

-t --
testconverttops
<input file
location> <output
file location>

-1 s | --listservers

Shows the current version of the remote renderer.

Configures the remote renderer service for the specified user. It also provides the option of
choosing between secure and non-secure communication mode with the iPrint Appliance.

Unregisters the remote renderer from the iPrint Appliance server. Afterward, the remote
renderer stops accepting jobs from the iPrint Appliance server for conversion. The iPrint
Rendering service is running, but does not receive rendering jobs from the iPrint Appliance
server.

Installs both self-signed and unsigned drivers for remote renderers.

Displays the status of the iPrint Windows Rendering service.

Starts the iPrint Windows Rendering service. After registration, the rendering service starts
automatically.

Stops the iPrint Windows Rendering service.

Tests the conversion locally.

Lists the iPrint Appliance registered with the remote renderer.
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Managing iPrint Appliance

The Micro Focus iPrint Appliance Management Console allows you to administer iPrint Appliance,
and to change configuration settings, such as administrative passwords, network settings, and
certificate settings.

To access the Appliance System Configuration page:
1 On a Web browser, specify either the host name or the IP address. For example, https://
10.0.0.1:9443 or https://iprint.example.com:9443.
2 Specify the Username and Password, then click Log in.

The Micro Focus Appliance Configuration pane displays the following options:

+ “Ganglia Monitoring” on page 89

+ “Network” on page 90

+ “Time” on page 90

+ “Storage” on page 91

+ “System Services” on page 91

+ “Firewall” on page 92

+ “/var Mount Configuration” on page 92

+ “Administrative Passwords” on page 93

+ “Field Patch” on page 93

+ “Ganglia Configuration” on page 94

+ “Support” on page 95

+ “Online Update” on page 95

+ “Shutting Down and Restarting iPrint Appliance” on page 96
+ “Signing Out of iPrint Appliance” on page 96

Ganglia Monitoring

Ganglia is a scalable, distributed monitoring system that allows you to gather important information
about your iPrint Appliance system.The default metrics that you can monitor are processor, disk, load,
memory, network, and process.

To monitor iPrint Appliance using Ganglia, you must enable Ganglia Configuration in the Appliance
System Configuration page of the iPrint Appliance Management Console. For information in how to
enable Ganglia Configuration, see “Ganglia Configuration” on page 94.

To view Ganglia monitoring of your iPrint Appliance system:

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the Ganglia Monitoring icon.
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An overview of all the nodes in the cluster, including information such as processor utilization,
memory, load, and so forth is displayed.

3 In the Grid-Node drop-down list, select a node that you want to monitor.

or

Scroll to the bottom of the page and click a node to get server information for your iPrint
Appliance.

For information about how to configure Ganglia for your environment, including changing from
multicast mode to unicast mode, see “Ganglia Configuration” on page 94.

Network

1 On a Web browser, use either the host name or the IP address to access the Management

Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Network.

3 In the DNS Configuration section, you can modify the name servers, search domains, and

Time

gateway settings for your Micro Focus iPrint Appliance network.

If the Search Domains field is left blank, it is auto-populated with the domain of the appliance
hostname. For example, if the hostname of the appliance is i pri nt. nyconpany. com the
domain is auto-populated with nyconpany. com

In the NIC Configuration section, you can modify the IP address, hostname, and network mask
of any Network Interface Controller (NIC) associated with the appliance. (If you configured
multiple NICs for the Micro Focus iPrint Appliance, you can configure the additional NICs.)

4a In the NIC Configuration section, click the ID of the NIC.
4b Edit the IP address, hostname, or network mask.

If you change the IP address, you must restart the appliance in order for the change to be
reflected

4c Click OK.

(Optional) In the Appliance Configuration Ul (port 9443) Access Restrictions section, specify
the IP address of any networks for which you want to allow access to the iPrint Appliance. Leave
this section blank to allow any network to access the iPrint Appliance.

IMPORTANT: Post iPrint Appliance configuration, do not change any Network settings.

Click OK.

On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Time.

3 Change the time configuration options as necessary:

NTP Server: Specify the NTP server that you want to use for time synchronization.
Region: Select the region where your Micro Focus Appliance is located.

Time Zone: Select the time zone where your Micro Focus Appliance is located.
Click OK.
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Storage

If you have created partitions for / vast or age and / var , iPrint Appliance provides native tools to allow
you to expand the storage space for the / vast or age and / var partitions.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Storage.

3 Use the tools provided by your virtualization platform vendor to expand the virtual disks that
contain the partitions your are expanding.

4 In the provided table, select the partitions to be expanded.
5 Click Expand partitions.

Appliance services are stopped, the selected partitions are expanded to the size of their
respective disks, and appliance services are restarted.

6 Reboot the appliance so the operating system can detect the disks that have been expanded.

System Services

This section displays the system services that are required for iPrint Appliance.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click System Services.
3 You can perform the following actions:

+ “Starting, Stopping, or Restarting System Services” on page 91
+ “Setting System Services to Automatic or Manual” on page 91
+ “Downloading Log Files for System Services” on page 91

Starting, Stopping, or Restarting System Services

1 Select the service that you want to start, stop, or restart.
2 Click Action, then click Start, Stop, or Restart.
3 Click Close to exit System Services.

Setting System Services to Automatic or Manual

1 Select the service that you want to make automatic or manual.
2 Click Action, then click Set as Automatic, or Set as Manual.

Downloading Log Files for System Services

In the Log Files column of the table, click the download link for the service for which you want to view
log files.

You can download the following log files for each service:

SSH: This is the SSH service that is running on the appliance.
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Micro Focus iPrint Mobile: The iprint_mobile0.log file includes log messages related to mobile
server and renderer. To access this file, either click Download or browse to / var/ opt / novel | /| og/
i printnobile/ folder.

Micro Focus iManager: The cat al i na. out file includes log messages related to iManager
operations. To access this file, either click Download or browse to / var/ opt / novel | / t ontat 6/
| ogs/ folder.

Authentication Services: The cat al i na. out file includes log messages related to services
accessed by the users. To access this file, either click Download or browse to / opt/ novel | /filr/
apache-tontat/ | ogs/ folder.

NetlQ eDirectory: The ndsd. | og file includes log messages related to eDirectory operations. To
access this file, either click Download or browse to / var/ opt/ novel | / eDi rect ory/ | og/ folder.

Apache server for Micro Focus iPrint: The error _I og file includes log messages related to
Apache web server operations. To access this file, either click Download or browse to / var/ | og/
apache2/ folder.

Driver Store: The i dsd. | og file includes log messages related to driver store operations. To access
this file, either click Download or browse to/ var/ opt/ novel | /1 og/i print/ folder.

Print Manager: The i psnd. | og file includes log messages related to print manager operations. To
access this file, either click Download or browse to / var/ opt/ novel | /1 og/i print/ folder.

Firewall

You can view your current firewall configuration directly from the iPrint Appliance:
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click Firewall.

Port numbers are listed with the current status of each port number. This page is for
informational purposes and is not editable.

To have seamless experience with iPrint Appliance, ensure you do not block the ports with your
firewall settings. For more information, see “Ports Requirements” on page 26.

Ivar Mount Configuration

iPrint Appliance system events are logged in the / var directory. Since the / var directory can fill up
with log files and cause the boot partition to grow, it is recommended that/ var be located either on a
separate hard disk on the appliance, or on a remote NFS directory.

To move the / var directory to a dedicated disk or to a remote NFS directory:
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click /var Mount Configuration.
3 Specify the hard disk information for the / var directory:
+ Select disk: Select the hard disk where you want to place / var.
+ File system type: Specify the type of file system.
4 Click OK.
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Administrative Passwords

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Administrative Passwords.
3 Specify new passwords for the root and vaadmin administrators.
If you are changing the root password, you must first specify the current root password.

4 (Optional) Select or deselect Allow root access to SSH. When this option is selected, the root
user is able to SSH to the appliance. If this option is not selected, only the vaadmin user can
SSH to the appliance.

5 Click OK.

IMPORTANT: To change the eDirectory admin password, launch the terminal and run the script
i print_edir_change_passwd. sh.

Field Patch

You can manage field test patches for the iPrint Appliance from the Field Patch page. You can install
new patches, view currently installed patches, and uninstall patches.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Field Patch.

3 (Optional) Install a Downloaded Patch:

3a Before you can install a patch, you first need to download it from the Micro Focus Support
web site (https://www.novell.com/support/) to your management workstation.

3b From the Field Test Patch page on the iPrint appliance, click Browse.
3c Browse to and select the patch that you downloaded in Step 3a.
3d Click Install.

4 (Optional) Manage Installed Patches: Uninstall Patch
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Patches must be uninstalled in reverse order and only the latest patch can be uninstalled.

4a Select the latest installed pacth, then click Uninstall Latest Patch and confirm that you want
the patch uninstalled.

5 (Optional) Manage Installed Patches: Download Log File
5a Click Download Log File to download the log file that tracks patch installations.

Ganglia Configuration

Ganglia is a scalable, distributed monitoring system that allows you to gather important information
about your iPrint Appliance system. The default metric that you can monitor are CPU, disk, load,
memory, network, and process.

To monitor iPrint Appliance using Ganglia, you must enable Ganglia Configuration as follows:
1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click Ganglia Configuration.
3 As necessary, change the following Ganglia configuration options:

Enable Full Monitoring Services: Select this option to receive and store metrics from other
appliances, and to allow the Ganglia Web Interface to run on the same machine as the iPrint
appliance.

You might want to disable Ganglia monitoring by deselecting this option if:
+ You already have a monitoring system that you plan to use for iPrint.

+ You plan to configure a dedicated appliance for viewing monitoring information. (You do this
by selecting Unicast below, then specifying the host name or IP address of the appliance
where monitoring information will be collected.)

Enable monitoring on this appliance: Select this option to enable Ganglia monitoring on this
appliance.

+ Multicast: Select this option to send monitoring information to other appliances on the
network.

+ Unicast: (Recommended) Select this option to send monitoring information to a single
destination.

Unicast mode is recommended for improving performance of the iPrint system.

Publish to: Specify the URL where Ganglia sends monitoring information when it is running
in Unicast mode.

4 (Optional) Click Reset Database to remove all existing Ganglia metrics from this appliance.
This option is not related to the iPrint database.
5 Click OK.

For more information about how to use Ganglia monitoring with iPrint Appliance, see “Ganglia
Monitoring” on page 89.
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Support

You can upload configuration files to Micro Focus Support via FTP, or to download the configuration
files so that you can send them by an alternative method.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click Support.

3 Select Automatically send the configuration to Micro Focus using FTP to automatically send
your iPrint Appliance system’s configuration information to Micro Focus Support via FTP.

or

Select Download and save the configuration file locally, then send it to Micro Focus manually
to download your iPrint Appliance system’s configuration information to your management
workstation. You can then send the information to Micro Focus Support using a method of your
choice.

4 Click OK to complete the process.

Online Update

You can set a manual or automatic method to update the appliance.

NOTE: It is recommended to take the snapshot of the current configuration so that you can revert the
snapshot incase of error.

Online Update (Automatic Update Schedule: X) This title show which Schedule option is selected
(represented by X).

Register Online Update Service: This dialog appears whenever the appliance is not registered with
an update service. For example, the first time Online Update icon is clicked or when a service has
been de-registered.

The appliance must be registered to receive online updates:

Service Type: Select the service type that the appliance will use to obtain online updates: a local
Subscription Management Tool (SMT) or the Micro Focus Customer Center.

Micro Focus Customer Center

+ Email: Your email address for registering the appliance to receive updates.
+ Activation Key: This displays in your NCC Portal in the same dialog as your product license.

+ Allow Data send: Select from the following options if you want to share information with the
Micro Focus Customer Center:

+ Hardware Profile: Shares the hardware information.

+ Optional Information: Shares information such as host type, productversion, release,
architecture, timezone, and processor.

Local SMT: This is a server from where you can download the software updates and automatically
install them to update the product.

+ Hostname: The hostname of the server from where you want the appliance to download
software updates.
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+ SSL cert URL (optional): The path to the SSL certificate for encrypting communications with
the server.

+ Namespace path (optional): To enable the client to use the staging group, specify a value. Do
not specify any value if you want to use the default production repositories.

Update service: X After you register the appliance for an update service, the service name appears
in this field (represented by X).

Patches drop-down:
+ Needed Patches: Selecting this option lists that patches that will be installed during the next
manual or automatic update.
+ Installed Patches: Selecting this option lists all patches that have been previously installed.

Schedule drop-down: Click this to set a schedule for when the appliance will download updates.

+ If you select Manual, the appliance immediately downloads all available patches.

+ If you select Daily, Weekly, or Monthly, you must then choose to apply either All Needed
Patches or Security Patches Only.

+ For interactive patches, you must select the Automatically agree with all license agreements
and Automatically install all interactive patches options.
Update Now tab: This is selectable only when the Patches drop-down is set to Needed Patches.
+ After clicking the option, you must choose to apply either All Needed Patches or Security
Patches Only.
+ For interactive patches, you must select the Automatically agree with all license agreements
and Automatically install all interactive patches options.

View Info tab: Clicking this displays information such as a brief summary of the patch and the bug
fixes in the patch.

Register tab:

+ Clicking this displays the appliance’s registration status, and an option to Deregister the
appliance.

+ If you deregister the appliance, the installed patches are no longer available in the Online Update
page. You need to register again to the receive the updates.

Refresh tab: Clicking this refreshes the status of updates on the Appliance.

Shutting Down and Restarting iPrint Appliance

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click Reboot or Shutdown.

Signing Out of iPrint Appliance

1 In the upper-right corner of the Management Console page, next to the user name, click Logout.

On the Management Console page, along with the user name, Home and Logout links are
available. The Home directs you to the iPrint Appliance main page, and the Logout signs out of
the iPrint Appliance.
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1 Managing Print System

In this section, you can manage the appliance through the iPrint Appliance Management Console and
the configure the server to automatically update the Macintosh and Windows clients.

The iPrint Appliance Management Console allows you to add and manage printers, check the printer
status, create printer maps, and monitor iPrint Appliance. To access the Management Console, on a
Web browser, specify either the host name or the IP address. For example, https://
iprint.example.com:9443 or https://10.0.0.1:9443.

+ “iPrint Appliance Configuration” on page 97

+ “Appliance System Configuration” on page 132

+ “iPrint Printer Configuration (iManager)” on page 132

+ “What’s Next” on page 173

iPrint Appliance Configuration

The iPrint Appliance Configuration page displays the following options:

+ “Printers” on page 97

+ “WalkUp Printers” on page 101

+ “Manage Printers (iManager)” on page 106
+ “Printer Status” on page 106

+ “Mobile” on page 106

+ “Renderers” on page 108

+ “Driver Store” on page 109

+ “AirPrint” on page 109

+ “Directory Servers” on page 109

+ “Advanced Authentication” on page 121

+ “Certificate Management” on page 123

+ “Printer Map (iPrint Map Designer Tool)” on page 127
+ “Backup” on page 129

+ “Product Improvement” on page 130

+ “License” on page 131

Printers

The Printers page lists all printers currently managed by iPrint Appliance. You can enable a printer for
AirPrint, Email printing, and IPP printing.
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Advertising a Printer as AirPrint

1 Select a printer or printers, click the AirPrint drop-down menu, then click Enable Advertising.

Only Apple certified AirPrint printers are supported for AirPrint printing. On enabling the printer
for AirPrint, the printer is advertized as an AirPrint-enabled printer.

Enabling Mobile Printing for a Printer

1 Select a printer or printers, click the Mobile drop-down menu, then click Enable.

On enabling the printer for mobile, you can print to that printer from your mobile devices.

Enabling Email Printing

Using email printing, you can print documents from any device capable of sending emails. You can
print emails by specifying email printing commands in the subject line of the email. You can also print
documents by emailing them to your printer as attachments. When configured for email printing, iPrint
Appliance becomes a client to an email server.

To enable email printing, you must ensure to meet the following:

+ Configure global email settings

+ Email accounts are created and functional
After configuring the global email settings, do the following:

1 Select a printer or printers, click the Email drop-down menu, then click Enable.

On enabling the printer for email, you can print to that printer by using the email printing feature.

Enabling Private Email Printing

You can configure a printer for private email printing by providing a specific email address to each
printer.

To enable private email printing, you must ensure to meet the following:

+ Configure global email settings

+ Email accounts are created and functional
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To enable a private email address for the printer, do the following:

1 Select a printer, click the Configure drop-down menu, then click Printer Email Settings.
2 Specify the values as follows:

Account + Email Address: Specify the full email address of the mailbox to be polled for the
print jobs. When an email-based job arrives, the print job is processed to the
printer. For example, print@example.com.

+ Username: Specify the user name to be used by iPrint Appliance to log in to the
email server to access the private printer email account. For example, iprint.

+ Password: Specify the password for iPrint Appliance to log in to the email
server to access the private printer email account.

Server + Incoming Mail Server: Specify the address of the incoming email server for the
email account. For example, imap.example.com.

+ Incoming Mail Server Port: Specify the port of the incoming email server for
the email account.

+ Outgoing Mail Server: Specify the address of the outgoing email server for the
email account. For example, smtp.example.com.

+ Outgoing Mail Server Port: Specify the port of the outgoing email server for
the email account.

+ Access Method: iPrint Appliance supports two different protocols to poll for
incoming print jobs. Select POP or IMAP depending on the protocol your email
server supports.

Caveats For Email Printing

+ An email address used for a particular printer (per-printer email configuration) cannot be shared
for any other printer or mobile service.

+ Secure printers cannot be configured for email printing.

Editing a Printer

1 To view and modify the details of a printer, click the printer name.
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Printer: norprinter14 (7]

AirPrint™ Advertising: Not Applicable
Bonjour Service Name: norprinter14
Address: 192.168.2.4

Geo-location:

Device Location:

Description:
¥ Web upload using iPrint Portal
¥ Visible to all users in iPrint Portal
Printer Status: iPrint Monitoring Page
Manage Printer: iManager
Manage Certificates: Digital Certificates
Tags: color
Reset Save

2 You can modify the details as follows:

*

AirPrint Advertising: An option is available to enable or disable AirPrint advertising. This
option is displayed for only Apple certified AirPrint printers. For all other printers the
message will be “Not Applicable”.

Bonjour Service Name: Displays the name with which the printer will be advertised as
AirPrint printer.

Address: Displays the IP address or host name of the printer.
Geo-location: (Optional) Geographical location of the printer.
Device Location: (Optional) Local location of the printer.
Description: (Optional) Specific description related to the printer.

Web upload using iPrint Portal: This option enables the QuickPrint button in the iPrint
Portal. Using any web browser, the user selects a file and prints. The user no longer
requires client or driver installations.

Visible to all users in iPrint Portal: By default, all printers are listed in iPrint Portal when a
user is not logged in. If you want to hide some printers from the user who is not-logged in,
then you can deselect this option.

Printer Status: Displays the health monitoring GUI to monitor the printer status.
Manage Printer: Displays the iManager GUI to manage the print environment.

Manage Certificates: Displays the Certificates page. The certificates are managed from
this location.

Tags: Specify a label for the printer. Multiple printers can be grouped under same label. In
the iPrint Portal, it will be easier for the users to find a specific set of printers. For example,
if you specify a tag as Color Printer. In the iPrint Portal, a user can easily locate specific
printers by selecting the Color Printer tag.

3 Click Save.
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Printer Rename and Printer Refresh

You can rename a printer from the Printers page. Select a printer you want to rename, click the
Configure menu, then click Rename Printer.

To refresh the printers list, click the Refresh button in the upper right of the Available Printers window.

Bulk Printer Creation Using a CSV File

You can create multiple printers using a csv file. You can create or use the sample csv file, then
upload the csv file into iPrint Appliance by clicking the Bulk Printer Creation button in the upper-right
corner of the Printers Configuration page.

The csv file contains the following fields:

PrinterNang, Printerl P, Location, Description, Wn95_ 98 Driver, Wnnt_Driver, Wn2k_Driv
er, Wnxp_Driver, Linux_Driver, Mac_Driver, Vista32_Driver, Vista64 Driver, Wn732_Drive
r,Wn764 Driver, Wn832 Driver, Wn864 Driver, Wn1032 Driver, Wnl1064 Driver, Enabl e
DirectPrinting, Secure Printing, Enabl e Auditing, LPR/ RAW Raw Por t

Uploading the CSV File
1 On a Web browser, specify either the host name or the IP address. For example, https://
10.0.0.1:9443 or https://iprint.example.com:9443.
2 Specify the Username and Password, then click Log in.
3 Click Manage iPrint Appliance.
4 Click Printers.
5 Click the Bulk Printer Creation button in the upper-right corner of the window.

Create Printers from C5V *
| CSV File: Browse...

| Download Sample CSV | Ok Cancel

5a To download the sample csv file, click Download Sample CSV.
6 Navigate to the . csv file, select it, then click OK to begin the printer import process.

For more information on the parameters in the csv file, see “Bulk Printer Import Using a CSV File” on
page 42.

WalkUp Printers

+ “Creating a WalkUp Printer” on page 103

+ “Editing a WalkUp Printer” on page 103

+ “Deleting a WalkUp Printer” on page 103

+ “Enabling Mobile Printing for a WalkUp Printer” on page 104
+ “Modifying the Job Hold Time” on page 104

+ “Caveats for Implementing WalkUp Printing” on page 104
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+ “Release Portal for Users” on page 104

+ ‘“ldentity Card Release for Users” on page 105

WalkUp printer is a virtual print queue that includes group of physical printers. The print jobs sent to
the WalkUp printer are put on hold by the iPrint Appliance server and released to a desirable printer.
The jobs can be released using identity cards or Release Portal.

You must associate drivers for printers when performing desktop printing.
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Figure 11-1 WalkUp Flow
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Prerequisites

+ Ensure that the physical printers are available before creating a WalkUp printer.

+ All the WalkUp jobs are stored on the secondary disk. Depending on the usage of the print
service, decide the space required on the secondary disk.

+ The users releases the jobs by using a Release Portal or a mobile app. Ensure that the user is
aware of the printer location and printer names.

+ By default, only the WalkUp administrator and the users created in the i Pri nt Appl i ance
container will have access to the WalkUp printer. To provide access to all the imported users or
users in other containers use iManager.

In the Management Console, WalkUp Printers page, you can create, edit, and delete a WalkUp
printer. You can modify the job hold duration for a printer and also enable it for Mobile printing.
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Creating a WalkUp Printer

1 Under Configuration, click WalkUp Printers.
2 Click New.
3 Specify the name of the WalkUp (virtual) printer. This name will be exposed to the user when

they install printers on their desktop or mobile devices.

4 (Optional) Specify description for the printer.

5 To enable mobile users to use this printer, select Mobile Printing.

6 By default, the Web upload using iPrint Portal option is enabled. This enables the QuickPrint

10

1"

feature in the iPrint Portal and user can print files using any web browser. The user no longer
requires client or driver installations.

By default, the Visible to all users in iPrint Portal option is enabled. This option lists all the
printers in iPrint Portal. If you want to hide some printers from the user who is not-logged in, then
you can deselect this option.

From the list of printers, select the printers to group under the WalkUp printer. The jobs sent to
the WalkUp printer will be put on hold and the user will have control to release those jobs to one
of the grouped printer.

You must select at least one printer.
Click Next.
Assign platform-specific drivers for the WalkUp printer.

If Windows drivers are selected, then bi-directional communication can be set for the WalkUp
printer.

10a Specify the IP Address or host name from the pool of the printer that you have selected for
WalkUp.

Click Finish.

WalkUp printer object is created that includes group of printers. The jobs on hold can only be
released to these printers.

Editing a WalkUp Printer

1 Under Configuration, click WalkUp Printers.

Click the printer name.
Displays the details of the printer and its drivers.

3 In the Printer Details tab, modify the details of the printer.

4 Click the Drivers tab, then reassign the drivers for the selected printers. You can also modify the

IP address or host name for bi-di communication.
Click save.
The modified settings are applicable to all jobs sent to the selected WalkUp printer.

Deleting a WalkUp Printer

Ensure all the jobs are completed before deleting the printer. On deleting this printer, all the held jobs
will be automatically cancelled.

1
2

Under Configuration, click WalkUp Printers.
Select a printer or printers, then click Delete.
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Enabling Mobile Printing for a WalkUp Printer

1 Under Configuration, click WalkUp Printers.
2 Select a printer or printers, click the Mobile drop-down menu, then click Enable.

Modifying the Job Hold Time

By default, the job is put on hold for four hours, after which the job will be cancelled. You can modify
the time duration to put the job on hold as follows:

1 Under Configuration, click WalkUp Printers.

2 Click Settings.

3 Modify the duration to hold a job. This change is applicable only for the jobs put on hold after the
setting is modified. The existing jobs will continue to be on hold as per the earlier set duration.

Caveats for Implementing WalkUp Printing

This section lists a few pointers for avoiding common WalkUp implementation problems.
+ Using iManager: The following management tasks for the WalkUp printer are only managed by
iManager:
+ Enable auto driver or profile update
¢ Assign driver profiles
+ Set Access Control
+ Enable auditing
¢ Delete held jobs

+ Using iPrint status (iPrint Health Monitoring page): The following tasks of the WalkUp
printers are monitored using the iPrint Health Monitoring tool:

+ Delete held jobs
¢ Enable auditing

+ Job hold time: By default, the job is put on hold for four hours, after which the job is cancelled. If
a job is cancelled it is no longer available in the Release Portal. The job hold time can be
modified from the Management Console. For more information, see “Modifying the Job Hold
Time” on page 104.

+ Insufficient balance when printing in PaperCut setup: If the user prints in spite of having

insufficient balance in his account, the job is canceled even though the Release Portal displays a
success message.

Release Portal for Users

The iPrint Release Portal displays the jobs that are put on hold, the time the job was submitted to the
WalkUp printer, and the expiry time of the job. By default, the job is put on hold for four hours, after
which the job will be cancelled. If a job is canceled it is no longer available in the Release Portal.

To launch the Release Portal in a web browser, specify the Appliance server’s address (<https://
<Appliance_IPaddress or host_name>/user> or <https://<Appliance_IPaddress or
host_name>:9443/release-portal).
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Printing a WalkUp Job

1 Using a web browser, specify the server address (https://<Appliance_lPaddress or host_name>/
user) or (https://<Appliance_IPaddress or host_name>:9443/release-portal).

2 Specify the user authentication details.
On successful authentication, jobs are displayed.

3 Select the document, then click Print.

4 Select the printer, then click OK.
The document is printed by the selected printer.

Deleting a WalkUp Job
1 Using a web browser, specify the server address (https://<Appliance_lPaddress or host_name>/
user) or (https://<Appliance_IPaddress or host_name>:9443/release-portal).
2 Specify the user authentication details.
On successful authentication, jobs are displayed.
3 Select the document or multiple documents, then click Delete.
The selected jobs are deleted and no longer available to print.

Identity Card Release for Users

A user can now print the WalkUp jobs by using their identity card. A card reader is placed adjacent to
the printer and the user swipes his/her identity card to print the jobs.The held WalkUp jobs are printed
using the user’s identity card as follows:

The administrator configures the Ethernet 241 switch and card reader.

The card reader is attached to the printer.

The user prints to a WalkUp queue and job is put on hold.

1

2

3

4 The user swipes his/her identity card on the card reader.
5 The iPrint Appliance server validates the user credentials.
6

All the jobs in the WalkUp queue submitted by the user for that printer are printed.

iPrint Appliance works with RF IDeas Ethernet 241 devices. For more information on supported card
types, see the RF IDeas product page.

How to configure identity Cards for iPrint Appliance?

1 Configure the Card (Ethernet 241) devices as per the instructions of the vendor.
2 Launch the Ethernet 241 Web portal (http:/<ethernet241 device’s IP)
2a In Server’s tab, specify the Data Server IP as the iPrint Appliance IP

2b The Data Server URI as the iPrint Appliance’s URL (http://hostname or IP of iPrint
Appliance)

2c In the Data Server Str, specify the exact value given below:

liprint/users/
rel ease?csn=$1&mac=%$28&l ui d=$3&seq=%$48& p=$5&devnac=$68&devi p=$7&r dr =$8&f wer
=$9

2d Click on Update to configure the device with the iPrint Appliance details.
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3 Launch the iPrint Appliance Management Console:
3a In the Directory Servers page, select the directory server to use for Card Release.

3b In the Server Information tab, select Use Card Release for printing jobs and provide the
name of the attribute to which the value of the card is mapped. iPrint Appliance uses this
attribute to authenticate the user when he/she swipes the card.

Manage Printers (iManager)

This page displays the iManager interface.

Using iManager, you can manage the print environment such as create printers, printer drivers,
profiles, and users. You can also manage workstations. For more information, see “iPrint Printer
Configuration (iManager)” on page 132.

Printer Status

This page displays a global view of your print system. The tool displays the current status of Printer
Agents, and lets you configure settings and generate reports about your print system.

For more information about the iPrint Printer Status tool, see the Micro Focus iPrint Appliance 3.2:
Micro Focus iPrint Appliance Health Monitoring Guide.

Mobile

On the Mobile configuration page, you can configure default options for mobile printing and email
printing.

Global Mobile Settings

Following are the default settings for all the printers when printing from the mobile app. When
performing print, these settings can be modified for an individual printer.

Paper Size: Select Letter or A4.
Orientation: Select between Landscape or Portrait printing.

Enable Duplex Printing: Duplex printing allows printing on both the sides of a paper. Print devices
without this capability can only print on a single side of paper (simplex printing).

Enable Color Printing: Color printing prints the documents in color, as opposed to monochrome
(black and white) printing.

Global Email Settings

iPrint Appliance can be configured to accept print jobs through email messages and attachments.
Using email printing, you can print documents from any device capable of sending emails. You can
print emails by specifying email printing commands in the subject line of the email. You can also print
documents by emailing them to your printer as attachments. When configured for email printing, iPrint
Appliance becomes a client to an email server. Email account inbox is polled for incoming print jobs,
which are routed to the intended printer.

Ensure email accounts are created and functional prior to their association with the iPrint Appliance.
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Enable email-based printing: Select this option to enable email printing. A global email address is
assigned for all the printers.

The following fields are used by iPrint Appliance to describe and access the global email account:

Email address: Specify the full email address for global print jobs. For example,
print@example.com. Ensure to use an exclusive email account for iPrint Appliance. Do not use an
existing email account.

iPrint Appliance polls the inbox of this email address looking for print jobs. When an email-based job
arrives, the subject line is parsed to determine the printer to which the job is sent.

IMPORTANT: If an existing email account is used, the mails in that account might get deleted, auto-
replied, and so on.

Account Username: Specify the user name for iPrint Appliance to log in to the email server to
access the global email account. For example, iprint.

Account Password: Specify the password for iPrint Appliance to log in to the email server to access
the global email account.

NOTE: When you are modifying any global email settings, ensure to provide the account password.
An error occurs if password is not provided.

Incoming Mail Server: Specify the address of the incoming mail server for the email account. For
example, imap.example.com.

Incoming Mail Server Port: Specify the port number of the incoming mail server for the email
account. For more information, see “Incoming Mail Server Parameters” on page 233.

Incoming Server Type: iPrint Appliance supports POP and IMAP protocols to poll for incoming print
jobs. Select POP or IMAP depending on the protocol that your email server supports.

Outgoing (SMTP) Mail Server: Specify the address of the outgoing mail server for the email
account. For example, smtp.example.com. iPrint Appliance uses the SMTP protocol to send email
back to users who submit email-based print jobs to report their job status. In order to support iPrint
Appliance, the email server you select must support the SMTP protocol.

Outgoing (SMTP) Mail Server Port: Specify the port of the outgoing mail server for the email
account. For more information, see “Outgoing Mail Server Parameters” on page 234.

Message body Printing: With email-based printing, attachments are always printed. This option
allows the email message body to also be printed. It is enabled by default.

Polling Interval: Configures the interval (in seconds) at which emails are fetched from the mail
servers.

IMPORTANT: When using email printing, the print command in the subject line might trigger spam
filters. To avoid this issue, configure your email system to allow print-specific emails. Include the
approved print users in the spam filter of your email system to prevent unwanted print requests.

You can also configure a printer for private email printing by providing a specific email address to
each printer. For more information, see “Enabling Private Email Printing” on page 98.
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Renderers

The Renderers Configuration page allows you to download the remote renderer and also manage all
the renderers. For more information about installing and configuring a remote renderer, see “Installing
and Configuring a Remote Renderer” on page 82.

On the Renderers page, you can perform the following actions:

+ “Add a Renderer” on page 108

+ “Edit a Renderer” on page 108

+ “Delete a Renderer” on page 108

+ “Activate or Deactivate a Renderer” on page 109

Add a Renderer

1 Under Configuration, click Renderers.
2 Click New.

3 In the Renderer Host/IP address box, specify the host name or IP address of the renderer
system, then click Connect.

4 Under Options, specify a name for the renderer in the Renderer Name box.
5 Select the document formats you want the remote renderer to render.

NOTE: The Build-in PDF renderer is selected by default. If you want to use Adobe Acrobat, you
must ensure that Adobe Acrobat Pro is installed on the renderer machine before selecting the
Adobe Acrobat option. Similarly, if you want to enable the remote renderer to render Microsoft
Office formats, you must ensure that Microsoft Office is installed on the renderer machine before
selecting the Office Support option.

6 Choose the Default Printer Driver, then click Register.

Edit a Renderer

You can change a remote renderer’s name, the document rendering options, and the default printer
driver using the Edit feature on the Renderers page.

1 Under Configuration, click Renderers.
2 Select a renderer which you want to edit, then click Edit.
3 Modify the details, then click Commit.

Delete a Renderer

1 Under Configuration, click Renderers.
2 Select a renderer that you want to delete, then click Delete.

Deleting a renderer unregisters the renderer from the iPrint Appliance.
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Activate or Deactivate a Renderer

1 Under Configuration, click Renderers.
2 Select a renderer that you want to activate, then click Activate.
The renderer is now in an active state.

If the renderer is in an Inactive state, it will not render any jobs. Deactivating a renderer does not
unregister the renderer from the iPrint Appliance.

Driver Store

You can change the Drive Store post the initial configuration.

Changing from local to remote driver store or vice versa: After initial configuration, if you change
the local driver store to remote driver store or vice versa, you must again set the default driver for the
local renderer.

The Driver Store Configuration page contains the following options:
Local: Select this option to use the Driver Store of the local machine.

Remote: Select this option to change the location of the Remote Driver Store. Specify the host name/
Address, Username (FDN format - for example, cn=admin,o=companyname), and the Password of
the new Remote Driver Store, then click Save.

AirPrint

AirPrint is a framework that facilitates driverless printing that allows users to send print jobs to AirPrint
enabled printers. This page displays the status of the AirPrint service. You can start or stop the
AirPrint service.

Directory Servers

To create an iPrint Appliance user account, you can synchronize initial user information from your
network directory service (NetlQ eDirectory or Microsoft Active Directory service) after you have
installed the iPrint Appliance software. Over time, you can continue to synchronize user information
from the LDAP directory to your iPrint Appliance.

+ “Configuring an LDAP Server” on page 110

+ “Deleting an LDAP Configuration” on page 115

+ “Configuring Synchronization Schedule” on page 115

¢ “Securing LDAP Synchronization” on page 115

IMPORTANT:

+ iPrint Appliance performs one-way synchronization from the LDAP directory. If you change user
information on iPrint Appliance, the changes are not synchronized back to your LDAP directory.
It is recommended not to change the LDAP information for the synced user on iPrint Appliance.

+ iPrint Appliance does not support multi-value attributes. If your LDAP directory contains multi-
value attributes, iPrint Appliance recognizes only the first attribute. For example, if your LDAP
directory contains multiple email addresses for a given user, only the first email address is
synchronized to iPrint Appliance.
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+ LDAP import does not sync user passwords to iPrint Appliance. Authentication requests from the
mobile app are redirected to the defined LDAP source. If a user password is changed on the
LDAP source, you do not need to update the same password on iPrint Appliance.

+ The LDAP source IP or host name must be always active for iPrint Appliance to authenticate
users.

Configuring an LDAP Server

You can configure multiple LDAP connections. You should never configure multiple LDAP
connections to point to the same location on the same LDAP directory. If you need a failover solution,
you should use a load balancer.

If your LDAP directory service requires a secure LDAP connection (LDAPS), see “Securing LDAP
Synchronization” on page 115 and then configure the LDAP server.

To configure an LDAP connection:

1 On the Directory Servers Configuration page, click Add.
or
To modify an existing LDAP connection, click the URL of the connection in the table.

IMPORTANT: When modifying an existing LDAP connection, do not modify the LDAP server
URL. Doing so can lead to synchronized users being disabled or deleted.

2 On the New Directory Server page, specify the required information.
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New Directory Server (2]
LDAP Server URL:

dap v 389

Alias Name for URL (optional):

User DN (Proxy User for Synchronizing Users and Groups):

Password:

Directory Type:

Unique Attribute for User or Group: Account Name Aftribute:

Attribute Mappings (syntax: InternallD=ExternallD):
firstName=gn
emailAddress=mails -

lastName=sn
descrintinn=dascrintion P

« Use Card Release for printing jobs

(o) (=)

LDAP Server URL: In order to synchronize initial user information, iPrint Appliance must access
an LDAP server where your directory service is running. You must provide the hostname of the
server, using a URL with the following format:

| dap: // host nane
If the LDAP server requires a secure SSL connection, use the following format:
| daps: // host nane

If the LDAP server is configured with a default port number (389 for non-secure connections or
636 for secure SSL connections), the port number is not required in the URL. If the LDAP server
uses a different port number, use the following format for the LDAP URL:

| dap: // host nane: port _nunber
| daps:// host nane: port _nunber

If the LDAP server requires a secure SSL connection, additional setup is required. You must
import the root certificate for your LDAP directory into the Java KeyStore (JVM Certificates) from
Directory Servers > Upload Certificate on the iPrint server, before you configure iPrint Appliance
for LDAP synchronization. After importing the certificate, you must restart the iPrint Appliance.

Alias Name for URL (Optional): You can specify an alternative name for the LDAP server
instead of the IP or hostname.
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User DN (Proxy User for Synchronizing Users and Groups) To sync users into iPrint
Appliance, you must provide the user name and password of a user who has sufficient rights to
access the user information on the LDAP server.

Directory Service Required Rights

eDirectory + [All Attribute Rights] - Compare & Read
+ [Entry Rights] - Browse (on the container containing the users that
need to be imported into iPrint)

Active Directory Any authenticated user can be used as the proxy user as long as there
are no read restrictions in place on the Organizational Unit (OU) that
contains the users.

Required rights if OU read restrictions are in place:

+ Read (on the Organizational Unit containing the users that need to
be imported into iPrint)

Ensure that This object & all descendant objects is selected in the
Security tab under the advanced options

In your LDAP directory tree, you must provide the fully qualified, comma-delimited user name,
along with its context, in the format expected by your directory service.

Directory Service Format for the User Name
eDirectory cn=user nane, ou=or gani zati onal _uni t, o=organi zati on
Active Directory cn=user nang, cn=or gani zati onal _uni t, dc=domai n_conponent

Password: Password for the User DN.

Directory Type: The directory type that you are connecting to. Select eDirectory, Active
Directory, or Other.

Unique Attribute for User or Group: The LDAP attribute that uniquely identifies a user or
group helps facilitate renaming and moving iPrint users and groups in the LDAP directory. If this
attribute is not set and you rename or move a user in the LDAP source directory, iPrint Appliance
assumes that the new name (or the new location of the same name) represents a new user
rather than a modified user, and creates a new iPrint Appliance user.

For example, you have an iPrint user with a given name of William Jones. If William changes his
name to Bill and you make that change in the LDAP directory, iPrint Appliance creates a new
user named Bill Jones.

To ensure that iPrint Appliance modifies the existing user instead of creating a new user when
the user is renamed or moved in the LDAP directory, you must specify the name of the LDAP
attribute that uniquely identifies the user. For eDirectory, this value is GUI D. For Active Directory,
this value is obj ect GUI D. This attribute always has a unique value that does not change when
you rename or move a user in the LDAP directory. If you want to map users to a different
attribute, you must ensure that the attribute that you use is a binary attribute. For example, the
cn attribute cannot be used because it is not a binary attribute.

Account Name Attribute: This setting is used for two purposes:

+ The value is used as the iPrint Appliance user name when the user is first provisioned from
LDAP. The value of this attribute must be unique.

+ During iPrint Appliance login, iPrint Appliance uses this attribute to locate the user in the
LDAP directory, and then tries to authenticate as that user.
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LDAP directories differ in the LDAP attribute used to identify a User object. Both eDirectory and
Active Directory might use the cn (common name) attribute. A more sure alternative for Active
Directory is to use the sAMAccount Narre attribute. Other LDAP directories might use the ui d
(unique ID) attribute, depending on the structure and configuration of the directory tree.

Consult with your directory administrator in order to determine the best attribute to use. In some
cases where not all users are being imported successfully, you must set up two LDAP sources
pointing to the same LDAP server and have each source use a different value for the Account
Name Attribute. For example, set up one LDAP source and use cn as the Account Name
Attribute, and then set up a separate source to the same LDAP server and use sAMAccount Nane
as the Account Name Attribute.

In addition to the attributes already mentioned in this section, other LDAP attributes can be used
for the Account Name Attribute, as long as the attribute is unique for each User object. For
example, the mai | LDAP attribute on User objects can be used to enable iPrint Appliance users
to log in by using their email addresses.

Use Card Release for printing jobs: Select this option to release WalkUp jobs by using the
identity cards.

Specify the attribute that maps the user to their identity card. When releasing the WalkUp job,
iPrint Appliance maps this attribute to the one specified in the eDirectory or Active directory
database and on receiving the user details, authenticates the user. On successful authentication,
the jobs are released.

3 Click OK.
4 In the Add Search Context, select Users or Groups.

Import Users / Groups

Add Search Context For: & Users ~
Base DN:

Filter:

(&(!(objectClass=computer))(|(objectClass=Person)(objectClass=orgPerson)
(objectClass=inetOrgPerson)))

¥| Search Subtree

| Add | Cance

(o)

Base DN: iPrint Appliance can find and synchronize initial user information from user or group
objects located in one or more containers in the LDAP directory tree. A container under which
user or group objects are located is called a base DN (distinguished name). The format you use
to specify a base DN depends on your directory service.

When you synchronize user information into iPrint Appliance from a source LDAP directory
service, the entire Base DN on the source is imported into iPrint Appliance. For example, if you
sync the context o=users from an LDAP source, the same o=users context is created in iPrint
Appliance.
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Directory Service Format for the User Container

eDirectory ou=or gani zat i onal _uni t, o=or gani zati on

Active Directory cn=or gani zat i onal _uni t, dc=donai n_component

Container names cannot exceed 128 characters. If the container name exceeds 128 characters,
users are not provisioned.

Filter: To import potential iPrint users, iPrint Appliance by default filters on the following LDAP
directory object attributes:

+ Person
+ orgPerson
¢ inet OrgPerson

To import groups based on information in your LDAP directory, iPrint Appliance filters on the
following LDAP directory object attributes:

¢ group
* groupd Nanes
¢ groupd Uni queNanes

You can add attributes to the user or group filter list if necessary. You can use the following
operators in the filter:

+ | OR (the default)
+ &AND
+ INOT

You might find it convenient to create a group that consists of all the users that you want to set up
in iPrint Appliance, regardless of where they are located in your LDAP directory. After you create
the group, you can use the following filter to search for User objects that have the specified
group membership attribute:

(gr oupMenber shi p=cn=gr oup_nan®, ou=or gani zat i onal _uni t, o=or gani zati on)

IMPORTANT: If you create a filter to search for a specific group to find users, users that are
located in any sub-groups to that group are not synchronized.

When synchronizing against Active Directory, you can create a filter that synchronizes users in
sub-groups by using the following rule object identifier (OID):

<attribute name>: <matching rul e O D> =<val ue>

Ensure that you include parentheses in your filter.

Directory Service Filter to search for User objects

eDirectory (gr oupMenber shi p=cn=gr oup_nane, ou=or gani zat i onal _uni t, o=or gani zat
i on)

Active Directory (menber OF =cn=gr oup_nane, ou=or gani zat i onal _uni t, dc=donai n_conponen

t)
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Search Subtree: Select whether you want iPrint Appliance to search for users or groups in
containers below the base DN (that is, in subtrees).

5 Click Add. This adds the user or group.
5a To add another user or group, click Add Search Context, then select Users or Group.
5b Specify the Base DN and other details, then click Add.

6 Click OK to save the directory server configuration.

Deleting an LDAP Configuration

If you delete users that are synced from a particular LDAP source, you must delete the LDAP source
connection then run an LDAP sync. When you delete an LDAP source, the users and groups from
that context are deleted while the context itself is retained.

1 On the Directory Servers Configuration page, select the LDAP configuration that you want to
delete, then click Delete.

Configuring Synchronization Schedule

When planning the schedule, take into account how often your LDAP directory user (and, optionally,
group) information changes and the server resources required to perform the synchronization for the
number of users (and, optionally, groups) that you have.

NOTE: Because the synchronization options apply to all LDAP configurations for the iPrint Appliance,
you cannot have customized synchronization settings for each LDAP configuration.

1 On the Directory Servers Configuration page, click Synchronization.
2 Click Schedule.

2a Select whether to run the LDAP synchronization every day, or on specific days of the week.
You can also perform a sync once a day at a specified time, or multiple times each day.

2b Click Save.

To synchronize users and groups immediately, click Synchronize Now. The summary of users/groups
that are synchronized is available in the Results section.

Securing LDAP Synchronization

If your LDAP directory service requires a secure LDAP connection (LDAPS), you must configure
iPrint Appliance with a root certificate. The root certificate identifies the root certificate authority (CA)
for your appliance, which enables you to export a self-signed root certificate based on your eDirectory
or Active Directory tree.

+ “Exporting a Root Certificate” on page 115
+ “Importing the Root Certificate into the Java Keystore” on page 121

Exporting a Root Certificate

+ “Exporting a Root Certificate for eDirectory” on page 116
+ “Exporting the Root Certificate for Active Directory” on page 116
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Exporting a Root Certificate for eDirectory

1 Launch and log in to iManager for your tree.
2 Click Directory Administration.

3 Click Modify Object.
4

Click the magnifying glass icon to browse to and select the “Tree Name CA” object in the
Security container of the eDirectory tree.

Click OK.
6 Click the Certificates tab.

7 Select the check box for the root certificate (this is not the certificate titled Self Signed
Certificate, but rather the root certificate), then click Validate.

(3,}

8 Select the check box for the root certificate, then click Export.
9 Deselect Export private key, then click Next.
10 Click Save the exported certificate, then select File in binary DER format.

11 Save the file to a location where it can be accessed later and with a file name that you can
remember, such as Sel f Si gnCert. der.

12 Click Close > OK.
13 Continue with “Importing the Root Certificate into the Java Keystore” on page 121.

Exporting the Root Certificate for Active Directory

1 On the Windows server, click Start > Run, then enter nmt.

CITEE—— x|

=== Typethe name of a program, folder, document, or Internet
resource, and Windows will open it for you.

Open: I j

@ This task will be created with administrative privileges.

| 0K I Cancel Browse... |

2 In MMC, type Ctrl +M

3 If the Internet Information Services (IIS) Manager snap-in is not installed on your Windows
server, install it.

4 With IIS selected, click Add, then click OK.
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Available snap-ins:

Add or Remove Snap-ins

.Intemet Information...
=

oy IP Security Monitor
3, 1P seaurity Policy Ma...

| Remote Desktop Ser...
FlRemaote Desktop Ses...

_EJ' Group Policy Manag...
|=[ Group Policy Object ...

Snap-n | vender [ =]
| Falder Micresoft Cor...
_%Group Policy Manag... Microsoft Cor...

Microsoft Cor...
Microsoft Cor...

. Micresoft Cor...

Micresoft Cor...
Microsoft Cor. ..
Microsoft Cor...
Microsoft Cor...
Microsoft Cor...

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Xl
Selected snap-ins:
[ Conscle Root Edit Extensions... |
.‘;"Internet Information Services (|
Bemove |
Mowe Up |
[Mawve Bovmn |
1 | _yl Advanced... |
oK | Cancel |

In the left frame, click Internet Information Services, then click a Windows server that iPrint

Appliance can connect to for synchronizing users.

| Conscle Root

1 |

N‘]- Internet Information §

@E} €, winpow
Comnections

€-id |7 |8
-5 Start Page
RS WiNDOWS-DC (IPRINT

4] |

6 In the Filter list, scroll down to Server Certificates and double-click the icon.

Filter: -
?f,ﬁ. t:_
Qutput Request
Caching Filtering

#% )
Server Worker
Certificates Processes

|

[ |

7 In the Actions list, click Create Self-Signed Certificate.

Import...

Create Certificate Request. ..
Complete Certificate Reguest...

Create Domain Certificate...

| Create Self-Signed Certificate. .. |

8 Name the certificate with a name you can remember, such as the server name, then click OK.
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Create Self-Signed Certificate 2l

| L: Specify Friendly Name

Spedify a file name for the certificate request. This information can be sent to a certificate authority
for signing:

Specify a friendly name for the certificate:

|windows—dc

| OK I Cancel

9 Type Ctrl+M, select the Certificates plug-in, then click Add.

Available snap-ins:

Snap-n | Vendor | -
%Acﬁve Directory Do...  Microsoft Cor...
ﬁr:.ﬁ.ctive Directory Site... Microsoft Cor...
: Active Directory Use.., Microsoft Cor...

=] ActiveX Control Microsoft Cor..,. —

2 ADSI Edit Microsoft Cor...

E Authorization Manager Microsoft Cor...
Microsoft Cor...

ﬁ, DNS Microsoft Cor...

3 Event Viewer Microsoft Cor... LI

10 Select Computer account, then click Next.

Certificates snap-in |

This snap-in will always manage cerfficates for:

My user account

" Service accourt

' Computer account

< Bach Mext = Cancel

11 Click Finish.

Select Computer x|

Select the computer you want this snap-n to manage.

This snap4n will always manage:

% Local computer: fthe computerthis console is running on)

" Another computer: I Brawse,.. |

[ Mlow the selected computer to be changed when launching from the command line. This

only applies f you save the console.
<Back [ Fnmsn | Cancel |

12 In the Snap-ins dialog, click OK.
13 In MMC, expand the Certificates plug-in, expand Personal, then click Certificates.
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= Consolel - [Console Root\Certificates (Local Computer) —10] x|

ﬁ File — Action View Favorites Window Help |_|5|5|

'Y EEREEIE

i Certificates
| Trusted Root Ci
| Enterprise Trus'
| Intermediate Ct
| Trusted Publish
| Untrusted Certi
| Third-Party Roc

| Trusted Pennle =
[ f 4| ol

HEEEBEE

"| Console Root || IssuedTo = | Actions
N Internet Informatio Tl windows-DC. fil-ab.Jocal Certificates .
=l Ifﬁl Certificates (Local C
| Personal More Actions

|Persona| store contains 1 certificate. | |

14 Right-click the certificate you created, select All Tasks, then click Export....

= Consolel - [Console Root\Certificates (Local Computer) - |EI|5|

@ Fle Action View Favorites Window Help |_|E|i|

‘$$|J’_|£'—|_I|RB._=?|EI_

7] Console Root Issued To = I Acti
u} Internet Informaho
Bl G Certificates (Local €
= || Personal .
- || Certificate: e —
[ Trusted Root Ci Cut Request Certificate with New Key...
[ Enterprise Trus Copy Renew Certificate with New Key...
[ Intermediate Cé Delete " orivate Ke
[ | Trusted Publish EEE— Az"?*g:ec' va .‘.-'S---
[ Untrusted Certi Properties vanced Operations »
[ Third-Party Roc Help =
[+ | Trusted Pennls
e | P |

|Con13|ns actions that can be performed on the item. | |

15 In the Certificate Export wizard, click Next.

Certificate Export Wizard

Welcome to the Certificate Export
Wizard

pr This wizard helps you copy certificates, certificate trust
| lists and certificate revocation lists from a certificate
- stare to your disk.

A certificate, which is issued by a certification autharity, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

x|

= Back i Next = I Cancel

16 Ensure that No, do not export the private key is selected, then click Next.

Managing Print System

119



120

=
Export Private Key
You can choose to export the private key with the certificate.
Private keys are password protected. If you want to export the private key with the
certificate, you must type a password on a later page.
Do you want to export the private key with the certificate?
~ Yes, export the private key
' No, do not expart the private key
< Back i Mext = I Cancel
17 Ensure that DER encoded binary is selected, then click Next.
certhcate portwzara ]
Export File Format
Certificates can be exported in & variety of file formats.
Select the format you want to use:
|l.‘=' DER encoded binary X.509 (.CER}l
{~ Base-64 encoded X509 {.CER)
" Cryptographic Message Syntax Standard - PKCS #7 Certificates (.P7B)
™| Include all certificates in the: certification path i possitle
< Back I Next = I Cancel
18 Name the certificate, then click Next.
Certificate Export Wizard x|

File to Export
Specify the name of the file you want to expart

File name:

I windows-dc-cert Browse... |

< Back I Mext = I Cancel

19 Click Finish > OK.

Managing Print System




Certificate Export Wizard x|

Completing the Certificate Export
Wizard

You have successfully completed the Certificate Export

'¢::;:j|;"] You have specified the following settings:
Export Keys Mo
Indude all certificates in the certification path Mo
File Format DER En
L | i

« Badk I Finish I Cancel |

The certificate is saved in C: \ User s\ Your - User - Nane.
20 Ensure that the certificate is accessible from your management browser.

21 Continue with “Importing the Root Certificate into the Java Keystore” on page 121.

Importing the Root Certificate into the Java Keystore

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
Click Upload Certificate.
Drag and drop the root certificate for your LDAP directory.
Click Upload to import the root certificate into the Java KeyStore (JVM Certificates).
Restart iPrint Appliance so that Tomcat rereads the updated Java keystore file.

a b ODN

You can restart the iPrint Appliance service as described in “System Services” on page 91.

You are now ready to configure iPrint Appliance for secure LDAP synchronization, as described in
“Configuring an LDAP Server” on page 110.

Advanced Authentication

iPrint Appliance supports Advanced Authentication for the users releasing the WalkUp jobs. iPrint
Appliance uses only Card or combination of a Card and a Smartphone for multi-factor authentication.
The Smartphone method is used for authentication through your Smartphone that uses an app to
perform the out-of-band authentication. The authentication method must be in order of Card and
Smartphone. We do not support only Smartphone or changing the order to Smarphone and Card.

For more information about using the Advanced Authentication Framework, see the Advanced
Authentication - Administration documentation website.

The following steps describe the authentication flow for Card and a Smartphone authentication:

1 To release a print job, when a user swipes the identity card, the authentication request is initiated
and iPrint Appliance contacts the Advanced Authentication server.
2 The Advanced Authentication server validates the user’s card data.

3 After validating the data, the Advanced Authentication server sends a push message to the
user’'s Smartphone to inform that an authentication request has been initiated.
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4 When the user opens the Smartphone app, the app reaches the Advanced Authentication server
to validate if there is an authentication needed. The authentication is indicated by the Accept
and Reject options. The user’s selection is then sent to the server.

5 The server validates the authentication and iPrint Appliance releases all the print jobs of the user
for that printer.

Prerequisites

+ Ensure that the iPrint Appliance users are available in the Advanced Authentication server. If the
users are not available on both the servers, authentication will fail.

+ Configure the Advanced Authentication server with the following:
— Authentication Chain with the authentication method as Card and Smartphone or only Card
— Authentication Event with the event type as Generic
— Endpoint with type as Other

NOTE: Ensure that a Owner is not set for the Endpoint that is configured for the iPrint
Appliance.

+ Endpoint ID and Endpoint Secret should be available before configuring Advanced
Authentication in the iPrint Management Console

Configuring Advanced Authentication

Ensure all the prerequisites are met before configuring Advanced Authentication in the iPrint
Management Console.

Configure Advanced Authentication (7]
+ Enable Advanced Authentication
Advanced Authentication support is enabled for iPrint users when WalkUp jobs are released with identity cards, Specify the details that you created in the Advanced Authentication Administrative Portal
Advanced Authentication Server Address
Event Name
EndPoint Name
EndPFaint 1D

EndPaint Secrat

Save Resat

Enable Advanced Authentication: Select this to enable advanced authentication for iPrint users
when releasing the WalkUp jobs by using their identity cards.
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Option, Field, or Button Information and/or Action

Advanced Authentication Server Address  The hostname or IP address of the Advanced Authentication
server that you want to use for authentication.

Event Name Specify the name that you created in the Advanced Authentication
Administrative Portal. If inaccurate name is provided, the users will
be unable to release their WalkUp jobs.

Endpoint Name Specify the name that you created in the Advanced Authentication
Administrative Portal.

Endpoint ID Specify the value that is automatically generated when you use the
Advanced Authentication Administrative Portal to create a
Endpoint. You can copy the ID from the portal and paste it here.

Endpoint Secret Specify the value that is automatically generated when you use the
Advanced Authentication Administrative Portal to create a
Endpoint. You can copy the secret key from the portal and paste it

here.
Save Click this to save your changes.
Reset Click this to clear the changes you have made.

Certificate Management

The Certificates page displays details of self-signed certificates. You can also manage the third party
certificate. A work flow is available for renewing the certificates on expiry. Certificate Management
helps you to upload the CA signed certificates and apply them to all the relevant services used by
iPrint Appliance.

Micro Focus iPrint Appliance ships with a self-signed server certificate. You can choose to use the
self-signed certificate or use a trusted third party certificate. All the inbound and outbound
communications to the iPrint Appliance uses server certificate. The server certificate works for both
Micro Focus iPrint Appliance and the iPrint remote renderer (ports 9443 and 8443).

All certificates that are included with the IBM Java package that is bundled with the version of SLES
that iPrint Appliance ships with, are installed when you install iPrint Appliance.

+ “Generating a Certificate Signing Request” on page 124

+ “Additional Options” on page 126

+ “Certificate Expiry” on page 127

Terminology

Server Certificate: This is a certificate that is used for all secure communications with iPrint
Appliance. You can either use the self-signed certificate or trusted CA signed certificate (or third party
certificate). iPrint Appliance supports the certificates in. crt, .cer, .der, .pem .pl2, or.pfx
format.

+ Self-signed Certificate: This is the default certificate (self-signed_cert) that is shipped with
iPrint Appliance. The validity of the certificate is two years. To view details of the self-signed

certificate, click 1
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+ Trusted CA Signed Certificate: You can use trusted server certificate that is signed by a
trusted certificate authority (CA) such as VeriSign or Equifax, instead of the default self-signed
certificate. Click Options to generate Certificate Signing Request (CSR) or Upload certificates
that are received from CA.

Private Key: This key is generated when creating CSR.

Chain Certificate: The chain certificate is a list of SSL certificates, from the root certificate to the
end-user certificate. Ensure all the chain certificates are available.

Generating a Certificate Signing Request

To request for a third party certificate, you must have a Certificate Signing Request (CSR). On
generating a CSR, send it to a Certification Authority (CA). The CA authority provides a digital
certificate that must be uploaded through the iPrint Appliance.

To generate a CSR, do the following:

1 Click Options adjacent to Trusted CA Signed Certificate.
2 Click Generate Certificate Signing request (CSR).
3 Specify the following information:

Common Name (CN): This is auto-populated with the appliance's hostname. If the appliance is
configured with transferable DNS, the CN should match the Print Manager DNS name
mentioned in Print Manager configuration file or the name specified during the initial
configuration of appliance. Else the print service will be down.

Organization (O): (Optional) Large organization name. For example, Micro Focus, Inc.

Organizational Unit (OU): (Optional) Small organization name, such as a department or
division. For example, Purchasing.

Two-letter Country Code (C): (Optional) Two-letter country code. For example, US
State or Province (ST): (Optional) State or province name. For example, Utah.
City or Locality (L): (Optional) City name. For example, Provo.
Key Size: Select the desired algorithm and key size.

4 Click Generate.

Certificate Signing Request generated.
Subject: CN=digitalairlines.example.com,0U=Marketing, O=Micro Focus,L=Newbury,ST=Berkshire, C=UK
Download and submit the CSR to a Certification Authority.

& Download

Upload the CA Signed certificates

X Upload

Delete the generated CSR.

‘O Delete

This generates the CSR file. You can delete the file, if you need a new CSR.
5 To download the CSR, click Download.
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Send the CSR to a certificate authority (CA). The CA takes the CSR and generates an official
certificate based on the information in the CSR. The CA then mails the new certificate and chain
certificates back to you.

6 Click Upload to import the CA reply to the iPrint Appliance.
or

1. If you have not generated the CSR from iPrint Appliance, then to import the certificates click
Trusted CA Signed Certificate > Options > Upload Certificates.

Certificate Management

Validity of Self Signed Certificate: 04 Sep 2019 14:49:34 i

Trusted CA Signed Certificate % Options

© Genarate Cerliicate Signing Hequest (CSR)

L Upload Cerlificates

2. To apply the certificate, drag and drop all the files received from the CA. Specify the
Passphrase and click Upload.

DigiCertCA.der X | star_apac_novell_com.der X | vaserverkey X

Passphrase:

[ X Upload | [ % Cancel |

7 Click OK to apply the certificates. The session expires due to restart of services, you must
relogin to the appliance.

On importing the certificates, the following services will automatically restart:

1. novell-iprint-mobile
2. novell-jetty
3. apache2

Do you want to continue?
Note: Restarting the services causes the session to expire. Refresh the browser and relogin.

OK ) ( Cancel )

8 The Certificates tab displays the active certificate.
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© Update Chain & Download @ Delete

Active Certificate: *.apac.novell.com

Subject - CN=digitalairlines.example.com,OU=Marketing, O=Micro Focus, L=Newbury,ST=Berkshire,C=UK
Issuer : CN=DigiCert SHA2 High Assurance Server CA, OU=www.digicert.com, O=DigiCert Inc, C=UK
Serial Number : 14944990746025615730149085944881015206

Valid From 27 Jun 2017 00:00:00

Valid Till : 04 Jun 2018 12:00:00

Chain Certificates

+ DigiCert SHA2 High Assurance Server CA

Subject . CN=DigiCert SHA2 High Assurance Server CA, OU=www.digicert.com, O=DigiCert Inc, C=UK
Issuer : CN=DigiCert High Assurance EV Root CA, OU=www.digicert.com, O=DigiCert Inc, C=UK
Serial Number . 64B9877074546166222510380951761917343

Valid From : 22 Oct 2013 12:00:00

Valid Till : 22 Oct 2028 12:00:00

9 (Conditional) If you need to update the chain certificates for the active certificate, click Update
Chain and upload the chain certificates.

10 (Conditional) If you want to apply the certificate to another iPrint appliance, click Download. The
downloaded file is in .p12 format. When you upload this certificate (.p12 format) to another
appliance, you must specify the passphrase as changei t.

11 (Conditional) If you delete the third party certificate, a new self-signed certificate is generated
and applied to the appliance.

Additional Options

The Certificate Management screen displays options = to repair the certificates, upload new
certificates, and create a CSR.

+ Repair: Repairs any issues with the certificates.

Repairing Certificates

On successful repair of certificates, the following services might automatically restart:

1. novell-iprint-mobile
2. novell-jetty
3. apache2

Do you want to continue?
Note: Restarting the services causes the session to expire. Refresh the browser and relogin.

OK Cancel

Click OK to repair the certificates. If certificates are repaired, then the session expires due to
restart of services, you must relogin to the appliance.

+ Upload Certificates: The uploaded certificate will overwrite the existing active certificate.

+ Certificate request: Provides options to create a new CSR, download the CSR, or delete the
CSR.
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Certificate Expiry

When there are 30 days left for expiry of the self-signed or third party certificate, a warning message
displays number of pending days for expiry.

IMPORTANT: On expiry of the certificate, iPrint server starts to display warnings and all the print
functionality might not be available.

Certificate Expiry Warning

Server certificates expire in 29 days.

Manage third-party certificates using Certificates Page

OR

Regenerate the self-signed certificate

OK

Click Regenerate the self-signed certificate to renew the self-signed certificate.

Click Manage third-party certificates using Certificates page to upload the third party certificate.

Printer Map (iPrint Map Designer Tool)

You can create a printer map using the iPrint Map Designer tool or HTML pages.

Use the iPrint Map Designer tool to create a map showing printer locations. The tool lets you import
floor plans as background images that can be used to drag and drop printers onto actual locations.
These maps are then published on a Web server, so users can install printers that are closest to their
location.

The iPrint map pages now display browser-specific user instructions during printer installation. If you
have upgraded to iPrint Client 6.0.0 or later for Windows, it is recommended that you recreate your
map pages.

After the map is created, you must use the iPrint Map Designer to modify or update it. Changes to a
map file that are made outside of the iPrint Map Designer are not supported. If you need to add links
to a map, you should create a frameset file and then display the map file in one frame and display
your links in a different frame.

Prerequisites

J Windows 10/8.1/8/7/Vista operating systems
(J Microsoft Internet Explorer 6.0 or later (run as administrator)

3 Micro Focus iPrint Client installed on the workstation
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O All of the background images (maps) are copied to the / var/ opt/ novel | /i pri nt/ ht docs/
i mages/ naps folder on the iPrint Appliance server.

You can use JPEG, GIF, and BMP images for backgrounds and printer icon images. These files
are detected by iPrint Map Designer at startup. A default set of printer icons are included.

(J All of the custom printer icons are copied to the / var/ opt/ novel | /i print/ ht docs/ i mages/
print ers folder on the iPrint Appliance server.

Creating a Printer Map

1 To launch the iPrint Map Designer tool, go to ht t ps: // server _addr ess/ mapt ool . ht min
Internet Explorer, where server_address is the server’s IP address or host name of the server
where the iPrint Manager is running.

2 Select a map from the Background image drop-down list.
3 Add a printer to the map:
3a From the Printer image field, select the type of printer and icon size you want.
Sizes range from 1 to 6, with 1 being the largest. Icons with a C indicate color printers.
3b Click the Printer icon and drag the printer to the desired location on the map.
3c Select a printer from the Printer list.

Next to the Printer list field, click the Browse icon and specify the IP address or host name
of the server where the Print Manager is running.

3d From the Printer list, select the printer that you want to associate with the printer icon.

On selection of the printer, the Printer agent and Print Manager information is populated. By
default, Mouse over text displays the Printer Agent’'s name.

You can add printers from different Print Managers to the same map. Click the Browse icon
adjacent to the Printer list field, specify the IP address or host name of the server where the
Print Manager is running.

3e (Optional) In the Printer Caption field, specify the title for the printer.

3f (Optional) From the menu bar, click Edit > Font to change the base font, color, and size for
text on the map.

4 Click File > Save As to save the map in an HTML format. For example, fi | enane. ht nl . You can
upload this HTML file to a Web server and use an HTML editor to customize the page.

IMPORTANT: Do not click Refresh or exit Internet Explorer without saving the map.

To retrieve and modify an existing map file, click Open and browse to the directory where the map is
located.
Copy Maps to the iPrint Appliance

On successful creation of maps, you must copy the maps to the location / var/ opt/ novel | /i print/
ht docs on the iPrint Appliance.

Users can access the maps by specifying the URL ht t p: // server _DNS_or _| P_addr ess/ i ppdocs/
fil enane. ht m in their browsers.
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Customizing HTML Interface for Installing Printers

You can edit the HTML files provided in var/ opt/ novel | /i pri nt/ ht docs/ exanpl es/ or create
HTML files to customize iPrint printer list for your environment.
1 Create a HTML file (sanpl el. ht m ) to customize iPrint for your environment.

You can associate a printer with the printers’s IPP URL.This URL is displayed when you enable
IPP for a printer.

1a In iManager, click iPrint > Manage Printer.
1b Browse to and select the printer you want.
1c Click Client Support > iPrint Support.
The printer’s URL is displayed under Current iPrint URL.
2 Copy the HTML file (sanpl el. ht nl ) to the var/ opt / novel | /i pri nt/ ht docs folder.
3 Use the web browser to view the map https://server_address/ippdocs/sample1.html

Web Page Samples

The iPrint Appliance includes some sample HTML files in the var/ opt / novel | /i pri nt/ ht docs/
exanpl es/ folder.

+ In the exanpl es directory, Exanpl e 1 shows a fully graphical interface for locating and installing
printers using standard HTML. This type of approach can also be created using the iPrint Map
Designer.

Use the web browser to view the sample map https://server_address/ippdocs/examples/
example1/innerweb.html

+ In the exanpl es directory, Exanpl e 2 shows a lower-maintenance approach for locating and
installing printers using standard HTML.

Use the web browser to view the sample map https://server_address/ippdocs/examples/
example2/innerweb.htm

Backup

The backup process creates a password-protected zip file with the configuration settings of the
appliance. From iPrint Appliance 2 onwards, an automatic backup is triggered every day at midnight.
However, you can also trigger a manual backup and download the file. A single backup file is
maintained and the existing file is overwritten with the latest backed up information.

You can download the file and use the configuration settings to create a new iPrint Appliance. The
existing Appliance’s iManager administrator credentials (cn=admin,o=iPrintAppliance) are required
when migrating to a new appliance.

The driver store setting is applicable for both automatic and manual backup.

1 Under Configuration, click Backup.

2 Disk Space Required: Displays the minimum space required on Primary and Secondary disk to
store the backed up file.

3 Include Local Driver Store: Selecting this option backs up drivers when performing automatic
or manual backup. Because backing up drivers consumes more disk space ensure that enough
space is available in the secondary disk (vastorage).

4 To trigger a manual backup, click Backup Now.
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5 Click Download Backup File to download the backed up file.

6 The Status field displays the status of automatic or manual backup along with the time stamp.

Any configuration change in the iPrint Appliance takes at least 20 minutes to get updated to the
configuration file. We recommend that you wait at least 20 minutes after the last configuration change
before you backup the configuration file.

Product Improvement

Telemetry enables Micro Focus to collect statistical data about your usage of iPrint service. This data
will enable us to ensure that you have the best possible experience with Micro Focus iPrint. Weekly
once the data is sent to the Micro Focus server.

Data That is Collected for Product Improvement

+ “Statistical Data” on page 130

+ “Feature Information” on page 131

Statistical Data

Table 11-1 Telemetry Attributes

Telemetry Attribute

Description

Total Printers

Mobile Enabled Printers

AirPrint Enabled Printers
AirPrint Capable Printers
eDirectory Users

Secure Printers

WalkUp Printers

Mobile Enabled WalkUp Printers
WalkUp Job Hold Duration (Minutes)
Remote Renderers

Remote Driver Store

Secure Remote Renderers

Non Secure Remote Renderers
Secondary Disk Size (GB)

Upgraded Appliance

Global Email Configured
Private Email Configured For Printers

Direct Printers

Number of printers configured for iPrint

Number of printers that are enabled for mobile

Number of printers that are enabled for AirPrint

Number of printers that have AirPrint capability

Number of eDirectory users migrated to iPrint Appliance
Number of printers that are secure

Number of iPrint printers configured for WalkUp functionality
Number of WalkUp printers that are enabled for mobile

Job hold time for all WalkUp jobs

Number of Remote Renderers

Displays whether the configured driver store is local or remote.
Number of secure Remote Renderers

Number of unsecure Remote Renderers

Size of the secondary disk in GB

Displays whether the iPrint Appliance is new or upgraded from an
earlier version.

Displays if a global email was configured for printers.
Number of printers configured with private email

Number of direct printers
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Telemetry Attribute Description

Audit Enabled Printers Number of printers enabled for auditing
Accounting Enabled Printers Number of printers enabled for accounting
IPP Enabled Printers Number of printers enabled for IPP protocol
LPR Enabled Printers Number of printers enabled for LPR protocol

Feature Information
We are collecting the frequency of operations performed for the following features:

+ Download Backup File: Number of times this file was downloaded.
+ Bulk Printer Creation: Number of times the printers were created using this feature.

How Server Receives the Data

After the weekly collection, the data is sent to the iPrint server. If the transfer is unsuccessful, the
system attempts to send it again during the next weekly cycle. No attempts to send the data is made
outside of the weekly cycles.

The data is not encrypted because no sensitive or identifying information is included.

License

The License page displays information about your current iPrint license such as the product version,
date it was issued, expiry details, and so on.

iPrint ships with a 90-day trial license. To continue usage of iPrint, you must update this license to an
Enterprise license. The types of licenses available with iPrint are:

+ Trial License: This is a 90-day license to evaluate the Desktop, Mobile, Email, and so on
features.

+ Enterprise License: This license provides printing from Desktop, Mobile devices, and any
email-enabled devices.

The major features offered are WalkUp, Identity Card release, and QuickPrint (Web printing). An
iPrint extension is also available to print from Chromebook.

+ Desktop License: This license provides printing from Desktop and any email-enabled devices.

The major features offered are WalkUp, Identity Card release, and QuickPrint (Web printing). An
iPrint extension is also available to print from Chromebook.

With the Desktop license, you can evaluate the Mobile-specific features for 90 days. After 90
days, the mobile-specific features will stop working.

+ Mobile License: This license provides printing from Mobile devices and any email-enabled
devices. You can print and release jobs from Mobile apps.

The maijor features offered are WalkUp, Identity Card release, QuickPrint (Web printing), and
printing to Apple certified AirPrint printers. An iPrint extension is also available to print from
Chromebook.
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You can obtain a new license key from the Novell Customer Center (NCC).

+ “Accessing the License Page” on page 132
¢ “Updating the iPrint Appliance License” on page 132

Accessing the License Page
1 Under Configuration, click License.

The License page displays the license details of the iPrint Appliance.

Updating the iPrint Appliance License

To update your iPrint Appliance license:

1 On the License page, browse and select a valid license (.xml) file to upload.
2 Click Upload.

IMPORTANT: If you are running multiple copies of iPrint Appliance, you must update the license
for each copy of iPrint Appliance individually.

After copying the license file, iPrint Appliance is updated. Restarting of the services is not required.

Appliance System Configuration

You can change configuration settings, such as administrative passwords, network settings, and
certificate settings. For more information, see Chapter 10, “Managing iPrint Appliance,” on page 89.

iPrint Printer Configuration (iManager)

iManager enables you to perform the following operations on iPrint Appliance:

*

“Understanding and Managing Certificates” on page 133
+ “Managing the Driver Store” on page 133

+ “Managing the Print Manager” on page 136

+ “Managing Printers” on page 150

¢ “Using iPrint Client Management” on page 166

NOTE: If you are running Windows XP Service Pack 2 or other browsers with pop-up blocking, you
might encounter problems with pop-up windows. To manage iPrint in iManager and to install printers
with iPrint clients, turn off pop-up blocking or allow the URL.
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Understanding and Managing Certificates

When you manage Print Managers, driver stores, and printers that are running on a different server
than the server running iManager, you might receive a certificate error, meaning that the host name or
IP address of the server where you are managing the print object does not match any of the
certificates on the server where iManager is running.

To find and accept the correct certificate:

1 Click the iPrint Certificate Manager link in the error.
2 Review the certificate information for accuracy.
3 Select the action you want to perform for this certificate.
In order to manage the print object, you must accept the certificate.
4 Click OK.
You might need to scroll down in order to click OK to accept the certificate.
5 Restart your task.

Certificates are accepted on a per-user basis.

You can remove accepted certificates by deleting the certstore folder located at: / var/ opt / novel | /
i Manager/ nps/ portal / modul es/ i Pri nt X/ cert st ore. Deleting this folder removes all accepted
certificates.

Managing the Driver Store

Although the default settings lets users print without additional configuration, you might want to
modify some settings so that you can manage your printing resources most effectively.

+ “Creating Additional Driver Stores” on page 133

+ “Understanding the Driver Store Configuration File” on page 134

+ “Changing the eDirectory Server Assignment” on page 134

+ “Loading or Unloading the Driver Store” on page 135

¢ “Updating Printer Drivers” on page 135

+ “Deleting Printer Drivers” on page 136

Creating Additional Driver Stores

Although you can create additional Driver Stores, you only need one for your iPrint system because
the Print Manager saves the downloaded drivers files to disk. If the Print Manager does not have a
requested driver, it copies the driver from the Driver Store and then saves it to disk. This process is
relatively quick, even for the first user to request a printer driver. We recommend that you maintain
only one Driver Store, so you do not need to track which Driver Store contains what printer drivers.
Periodically, the Print Manager checks the Driver Store for updated printer drivers.

If you configure multiple Driver Stores that run on the same server, they all point to the same
repository of printer drivers. This can be useful because each Driver Store has its own eDirectory
object, and you can distribute the objects in your eDirectory tree.

To create a driver store:

1 IniManager, click iPrint > Create Driver Store.
2 Specify the Driver Store name you want for the Driver Store object.
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3 Specify the container name where you want the Driver Store object to reside. The default value is
iPrintAppliance.

4 Specify a host name or IP address of the target server where you want the Driver Store to reside.
5 Specify an eDirectory server that you want the Driver Store to communicate with.

For fault tolerance, you can specify more than one eDirectory server from the same tree. For
more information, see “Changing the eDirectory Server Assignment” on page 134.

6 Click OK.

To modify the Driver Store properties or to add printer drivers, click Manage Driver Store, then select
the Driver Store you want to modify.

Understanding the Driver Store Configuration File

When you create a Driver Store, a configuration file is created in / et ¢/ opt / novel | /i print/conf.
The filename is i dsd. conf . Each time you use iManager to create a Driver Store object and assign it
to the same server, a separate entry is added to i dsd. conf . Although you can have several Driver
Stores assigned to a server, all printer driver files are stored in one file structure on the server. For
information about the entries in the configuration file, see / et ¢/ opt/ novel | /i print/ conf/

i dsd. conf.

Changing the eDirectory Server Assignment

If you need to change the eDirectory server assignment for the Print Manager or Driver Store, edit the
Directory Services Server1= entry in the corresponding configuration file,

print _manager _name. cont ext. i psmd. conf ori dsd. conf, located in/etc/opt/novel | /iprint/
conf.

NOTE: As many as two additional servers can be specified, using Directory Services Server2 and
Directory Services Server3. Directory Services Server1 is considered to be the primary eDirectory
server. Directory Services Server2 and Directory Services Server3 are considered to be secondary
servers.

For example, editing the Directory Services Servers 1, 2, and 3 entries for the i dsd. conf file looks
like this:

cat /etc/opt/novell/iprint/conf/idsd.conf {

DSServer 1 serverl.blr.novell.com

DSServer 2 server2.blr.novell.com

DSServer 3 server3. bl r.novel | .com

| DSCbj ect DN CN=ds- 102- 59- 2, O=novel |

| DSObj ect Passwd yhvuevdbunpuvf ukl nggapvi pxvenmh

| DSHost Addr ess 100. 100. 100. 100

}

Editing the Directory Services Servers 1, 2, and 3 entries for the i psnd. conf file looks like this:
cat /etc/opt/novell/iprint/conf/ipsnd. conf

DSServer1 serverl. blr.novell.com
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DSServer2 server2.blr.novell.com
DSServer 3 server 3. blr.novel I .com
PSMObj ect DN CN=psm dns- nane, O=novel |
PSMbj ect Passwd pgt nl af nf ekh

PSMHost Addr ess serverl.blr.novell.com

Loading or Unloading the Driver Store
You can start and stop the Print Manager in two ways:

+ “Using the Command Line” on page 135

+ “Using iManager” on page 135
Using the Command Line

The Driver Store uses init scripts for starting and stopping the daemon. To load the Driver Store from
the command line, enter/ etc/init.d/ novel | -idsd start

The following init script actions are also valid:

Table 11-2 Driver Store Actions

Action Description

reload or force-reload Stops and then starts the daemon.

start Starts the daemon.

status Displays the status of the daemon and the name of the Driver
Store.

stop Stops the daemon.

Using iManager

On the Driver Store Control property page, you can view the Driver Store’s status and unload or load
the Driver Store daemon.

1 In iManager, click iPrint > Manage Driver Store.

2 Browse to and select the Driver Store you want.

3 Click Driver Store Control > Shutdown to stop the Driver Store process.

4 Click OK.

Updating Printer Drivers

1 Add a new driver.
For more information on adding a new driver, see “Configuring Printer Drivers” on page 45.
2 Associate the printer to the driver.
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NOTE: Only the new iPrint Clients auto-update the drivers. For the existing or old Print Clients, you
need to manually install and associate the drivers.

Deleting Printer Drivers

1 In iManager, click iPrint > Manage Driver Store, then browse to and select the Driver Store you
want.

2 Click Drivers, then select the client platform you want to work with.
3 Select the driver you want to delete.

4 Click Delete.

5 Click OK.

Managing the Print Manager

Although the default settings let users print without additional configuration, you probably want to
modify some of those settings so that you can manage your printing resources most effectively.

NOTE: Printer driver profiles are stored in the Print Manager database file (psmdb.dat). While the

. dat file can be viewed only using iManager and the /psmstatus page, a text copy of the database file
can be viewed using many tools (including text editor, web browser, and others). This text copy is
periodically backed up in the same directory as the . dat file, but in XML format. The directory
location is: / var/opt/novel | /iprint/<print nmanager nane.ou.ou.o0>.psni.

¢ “Understanding the Print Manager Database” on page 136

+ “Understanding the Print Manager Configuration File” on page 137
+ “Changing the eDirectory Server Assignment” on page 137

+ “Using the Print Manager Health Monitor” on page 138

+ “Setting Up a Printer Pool” on page 140

¢ “Using Print Auditing” on page 141

+ “Creating Additional Print Managers” on page 145

+ “Loading or Unloading the Print Manager” on page 146

+ “Moving Print Managers to Another Linux Server” on page 147
+ “Auto Driver/Profile Update” on page 147

+ “Enabling Printer Agent Redirection” on page 148

Understanding the Print Manager Database

The Print Manager uses a database to store information about the printers it controls. The database
creates a backup when you create or delete a printer and also every night at midnight.

NOTE: Although database creation is a quick process, sometimes the backup is delayed because of
other tasks the Print Manager is doing. You might need to wait a short while after you create or delete
a printer before a backup is generated and uploaded to eDirectory.
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The last four backups are saved. When a new backup file is created, the oldest of the four stored files
is deleted. If the oldest backup file is older than four days, then the Print Manager creates a new
backup.

If the database fails to load through normal mechanisms, you can use the following procedure to
access the backup database:

1 Rename /var/opt/novel | /i print/<PSM Name>/ psndb. * to psndbol d. *.
2 Rename /var/opt/novel | /iprint/<PSM Nane>/ psnibsav. * to psndb. *.
3 Start the Print Manager.

Understanding the Print Manager Configuration File

When you create a Print Manager, a configuration file is created in/ et ¢/ opt/ novel | /i pri nt/conf.
The file name is pri nt _manager _nane. cont ext . i psmd. conf . A separate file is created for each
Print Manager that is created and assigned to run on the same server. Only one Print Manager can
run on the server at a time. For information about the entries in the configuration file, see / et ¢/ opt/
novel | /iprint/conf/ipsnd-tenpl ate. conf.

The i psnd. conf file links to the configuration file of the currently loaded Print Manager.

To load a different Print Manager on the server, use the iPrint> Manage Print Manager > Manager
Control page in iManager. If you attempt to load a Print Manager when one is already running, you
receive an error message instructing you to unload the current Print Manager before loading the new
one.

Changing the eDirectory Server Assignment

If you need to change the eDirectory server assignment for the Print Manager or Driver Store, edit the
Directory Services Server1= entry in the corresponding configuration file,

print_manager _nane. cont ext.i psnd. conf ori dsd. conf, located in/etc/opt/novell/iprint/
conf.

NOTE: As many as two additional servers can be specified, using Directory Services Server2 and
Directory Services Server3. Directory Services Server1 is considered to be the primary eDirectory
server. Directory Services Server2 and Directory Services Server3 are considered to be secondary
servers.

For example, editing the Directory Services Servers 1, 2, and 3 entries for the i dsd. conf file looks
like this:

cat /etc/opt/novell/iprint/conf/idsd.conf {
DSServer 1 serverl.blr.novell.com

DSServer2 server2.blr.novell.com

DSServer 3 server 3. blr.novell.com

| DSCbj ect DN CN=ds- 102- 59- 2, O=novel |

| DSObj ect Passwd yhvuevdbunpuvf ukl nggapvi pxvenh
| DSHost Addr ess 100. 100. 100. 100

}
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Editing the Directory Services Servers 1, 2, and 3 entries for the i psnmd. conf file looks like this:
cat /etc/opt/novell/iprint/conf/ipsnd. conf

DSServer 1 serverl.blr.novell.com

DSServer2 server2.blr.novell.com

DSServer 3 server3. bl r.novel |.com

PSMObj ect DN CN=psm dns- nane, O=novel |

PSMbj ect Passwd pgt nl af nf ekh

PSMHost Addr ess serverl.blr.novell.com

Using the Print Manager Health Monitor

The Print Manager Health Monitor provides you with a global view of your print system. The Health
Monitor shows you the current status of the Print Manager and the associated printers and lets you
configure error threshold, customize some print system settings, and generate reports about your
system.

+ “Understanding the Print Manager Health Monitor” on page 138

+ “Accessing the Print Manager Health Monitor” on page 138

+ “Generating Reports” on page 139

+ “Configuring Health Monitor Settings” on page 140

+ “Posting Administrator Messages about a Printer” on page 140

Understanding the Print Manager Health Monitor

The Print Manager Health Monitor is a powerful tool for managing and troubleshooting your print
system.

The opening page of the Health Monitor shows all of your printers; their current state; and general
statistics including the number of print jobs printed in the last hour, in the last day, and since the Print
Manager was last started.

A quick look at these statistics helps you identify which printers are not printing because of errors or
which printers are not being used.You can click a printer name to see additional details about the
printer that can help you troubleshoot a reported printer error and why users are not using the printer.

For example, if the printer status shows Error printi ng, click the printer for a list of known
problems. If one of the known problems is Pri nter not connect ed, use the IP address listed in the
Load String field to ping the printer to determine if the IP address is valid.

By looking at the statistical information, you can correct printer problems or make decisions about
redeploying under used printers to departments that print a lot. For more information, see “An
Overview of the iPrint Manager Health Monitor”.

Accessing the Print Manager Health Monitor

Access the Health Monitor by going to http://server_address/psmstatus, where server_address is the
IP address or host name of the server where the Print Manager is running.

For example: http://printing.my_company.com/psmstatus.
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You can view current Printer Agent states, start up and shut down Printer Agents, and other
information about your print system.

Generating Reports

The report feature of the Health Monitor allows you to generate a report that can be displayed on the
page or saved as a comma-separated-value (.csv) file that can be used in a spreadsheet program.

1 On the Print Manager Health Monitor main page, click Advanced Print Manager Information >
Generate Report.

2 (Optional) To save the report as a file, click Write Results to File under the File Options heading.

The heading specifies the location and filename of the report.

3 Select the information you want included in the report by selecting the corresponding check
boxes.

4 Click Generate Report.
The report is displayed on the screen, even if you selected to save the report to a file.

The following common reports are available for you to generate:

Printer Configurations: To determine what features are enabled for each Printer Agent, generate
the following reports:

+ SSL Required for iPrint Access

+ Auditing Enabled

Printer’s Current State: To view the states of the printers and any printer console messages,
generate the following reports:

+ Printer Agent Status

+ Printer Agent State Reasons

+ Printer Console

Printing Statistics: To view statistics about your print system, generate the following reports:

+ Jobs Printed Ever

Jobs Printed Since Load
Jobs Printed Today

+ Average Job Size Since Load

*

*

+ Average Job Size Today

Gateway Information: To view information about a gateway associated with the Printer Agents,
including the gateway’s IP address, generate the following report:

+ Gateway Load String

Printer Driver Associations: To view the printer drivers associated with each printer, generate the
following reports:

+ Windows 95/98 Driver
+ Windows NT4 Driver
+ Windows 2000/XP Driver
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+ Win XP Driver
+ Linux Driver

Printer and Printer Agent Associations: Because a Printer Agent can service more than one
printer, use the Associated NDS Printers option to view the number of printers serviced by each
Printer Agent.

Configuring Health Monitor Settings

You can configure settings in the Health Monitor to control how the Health Monitor presents
information when certain thresholds are met.

1 On the Print Manager Health Monitor main page, click Advanced iPrint Manager Information >
Configure Settings and Error Thresholds.

2 Adjust the settings you want to change.

See the online help for information about the available settings. For most print systems, the
default settings are sufficient.

Posting Administrator Messages about a Printer

Suppose a printer has been taken offline and sent for repairs, but you keep getting phone calls from
other administrators that the printer has an error in the Health Monitor. This can be resolved by
leaving a message about the printer in Health Monitor. Users can see the message, but only
administrators can edit it.

1 On the Print Manager Health Monitor main page, click the printer you want, then click Message
from Admin.

2 Type the text you want displayed for this printer.
3 Click Apply.

To remove a message, follow the steps above and delete the text in the message box (Step 2).

Setting Up a Printer Pool

You can create a pool of printers to share the load of printing. Users install one of the printers in the
pool. When a printer in the pool has a print job waiting, the Print Manager can redirect that print job to
an idle printer in the pool. The Print Manager attempts to evenly distribute print jobs among all
printers in a pool.

For example, if four printers are in the pool and the first printer is printing a 100-page job, then the
next print job is sent to the second printer. If the second printer completes the print job and the first
printer is still busy, the next print job is sent to the third printer to distribute print jobs throughout the
pool. Printer pools are specific to the Print Manager, and a printer pool cannot span multiple Print
Managers.

Printers that are included in a pool should be the same model and use the same printer drivers. You
can include only printers from the same Print Manager in a pool.

When you create a printer pool, the pool information resides in the Print Manager and can be viewed
only using iManager. Unlike the printers and the Print Manager, a separate eDirectory object for a
printer pool is not created.

After you set up a printer pool, users install only one of the printers in the pool on their workstation.
When a user submits a print job to the installed printer, the Print Manager uses the method described
in the example above to send the print job to the next available printer in the pool. Users should be
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reminded that their print jobs might be printed by any printer in the pool. For this reason, the physical
printers that are members of a printer pool should be located close to one another. You might also
want to enable banner pages, depending on the type of documents being printed.

To configure a printer pool, do the following:

1 In iManager, click iPrint > Printer Pool Configuration.
2 Select the Print Manager for this pool.
3 Select Create Pool from the Select Operation list, then click OK.
4 Specify the name of the printer pool.
This name is used to identify the pool only within iManager.
5 Select the printers you want included in the pool.
6 Click Next, then click OK.

To modify or delete a pool, follow the above steps and select the desired action from the Select an
Operation list in Step 3.

Using Print Auditing

To use print auditing, you first need to enable auditing for each printer you want to audit using
iManager or the Print Manager Health Monitor.

When auditing is enabled for a Printer Agent, a log file is created indicating who printed how many
pages to which printer on a given date. The log file is in a comma-separated format (.csv). The data
from this log file can be viewed from the Health Monitor or downloaded into a spreadsheet.

Figure 11-2 Auditing Management Page

AUDITODZ.CSY [4-03-03 9:58 am  [4-03-0311:10 am | 877 Kb ‘ 7,079 Delete AuditLog Generate Report

AUDITODT.CSW |4-03-03 9:47 am 4-03-03 9:58 am Delete Audit Log Generate Repont

%) Auditing Management - elkManager. novell. us - Mozilla Firefox [Z”E|E|
File Edt View Go Bookmarks Tools Help o
Auditing Management - elkManaser.novell.us
| Audit Log
| Name |Start Date and Time |End Date and Time |File Size |Joh Count
‘ﬂ\UDIT CEY 4-30-03 10:15 am |ﬁ-‘«ctive | 738 ‘ 3 Start New Audit Log | Generate Report
‘AUDITOO4 CSW [4-29-03 1110 pm [4-29-03 1:21 pm 729 ‘ 6 Dielete Audit Log Generate Repart
Jsuoroos s
ooz cov
oot csv

AUDITOO3, CSY ‘4-29-03 11:53 am |4-29-03 1:10 pm | 9349 ‘ 5 ‘ Delete Audit Log | | Generate Report

40 Kb ‘ 325

Done 151.155,127.7 @

From the Auditing Management page, you can complete the following tasks:

+ “Using iManager to Enable Auditing” on page 142
+ “Using the Health Monitor to Enable Auditing” on page 142
+ “Viewing Auditing Information” on page 142
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+ “Managing Audit Logs” on page 144
+ “Configuring Automatic Log Rotation” on page 144
+ “Downloading an Audit Report” on page 145

Using iManager to Enable Auditing

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to enable auditing for.
3 Click Configuration > Auditing.

4 Select the Enable Auditing check box.

Using the Health Monitor to Enable Auditing
1 To access the Print Manager Health Monitor, open http://server_IP_address/psmstatus in a Web
browser.
For example: http://printing.my_company.com/psmstatus.
2 Select a printer, then click Configuration Options.

You can also access Configuration Options by going to https://server_IP_address/PsmStatus/
configOpt/Printer_Name.

3 Select the Enable Auditing check box.

Viewing Auditing Information

You can generate an audit report that shows all print jobs, or you can filter the report based on a user
or a printer or both.

1 In the Print Manager Health Monitor, click Advanced iPrint Manager Information > Auditing >
Generate Report.
If there is more than one audit log, click Generate Report for the audit log you want to view.

2 (Optional) Filter the search by using the Limit Search by User or Limit Search by Printer filters.
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) Audit File ‘audit001.csv' - Mozilla Firefox E
Bookmarks  Tools  Help 0

File Edit ‘Wiew Go

Audit File 'audit001.csv'

(=

S=1E

Limit Search by User

| User Name
s

| Search

<

Limit Search by Printer

|Printer Mame

Ndobe P5CSMZEZ_0

BErother HL-1040 Foomatic_ljet2p

Brother HL-1050 Foomatic_hpijs

Brother HL-1050 Foomatic_ljetd pvS

| Search

Generate Report

Diaone

3 Click Generate Report to view the report with the specified filters.

There are only 250 print jobs listed at a time. To view more print jobs in the report, click Next.

) Auditing Information - Mozilla Firefox

File Edit “iew Go Bookmarks Tools  Help
Auditing Information -
| Report Summary
| iPrint Manager | fanager.novell.us
| Audit Log |auditoot csv
| Selected User |,&lt Users ‘Numher of Jobs Currently Displayed |250
| Selected Printer |,&lt Printers ‘ Page Count for Displayed Jobs |44878
|Aum|Lug[ntﬁesscanned| 250 of 139,024
‘ Job Owner Printer Time Submitted ‘ Time Completed Cnglg:ztﬁion Cp:f:‘ Job Size Job Name
|adnﬁm.noveu.us |HP |02/11f2005 02:59:16 PAA|02f1112005 02:59:16 P |C0n1pleted | 78 ‘ 765361 |C:\ndps\fﬂes\excel1m
|adnﬁm.nuveu.us |HP |02f11f2005 02:59:17 PAA|02f11f2005 02:59:17 P |Curnpleted | 585 ‘ 8642780 |C:\ndps\fﬂes\exceQ.r
|admin.novell.us WP |02/11/2005 02:59: 17 P [02/11/2005 02:59:17 P | Completed | 1| 112048 |CAndpsifilesimsTesth
|admin novell.us |He |02/11/2005 02:59: 18 PM, [02/11/2005 02:59:18 PM |Completed | 1 3869871 |C:indpsifilesiphotot
[admin.novell.us [P 0271172008 02:59:19 P [02/11/2005 02:59:13 P | Completed | 1]] 6475878 |CiindpsifilesiphotoZ.
< | ¥
Done =
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The following table explains the fields that are displayed under the Report Summary.

Field Description

iPrint Manger The Print Manager that the information is from.

Audit Log The audit log filename that was used to create the report.
Selected User Any user filter criteria that were used to create the report.
Selected Printer Any printer filter criteria that were used to create the report.
Number of Jobs The number of jobs submitted by the indicated users and printers.

Currently Displayed

The following table discusses what is displayed in the body of the report.

Field Description

Job Owner The owner of the print job.

Printer The printer the print job was sent to.

Time Submitted The time the print job was submitted to the printer.
Time Completed The time the print job was printed on the printer.
Completion Status The completion status of the submitted print job:

Completed, Cancelled by User, Cancelled by Operator, or Other (Other
usually indicates the job was aborted by the system).

Page Count The number of pages printed.
Job Size The size of the print job (in bytes).
Job Name The print job filename that was submitted and the type of print client that

submitted the print job.

Managing Audit Logs

You can manage your audit logs by using the buttons on the Auditing Management page. When audit
logs are no longer needed, you can manually delete them. To automatically save and create new
logs, see “Configuring Automatic Log Rotation” on page 144.

The active audit log file (audit.csv) logs data for all printers that have been enabled for auditing. You
can generate a report from this file or you can move the data to a saved file by using the Start New
Audit Log option. You cannot download the audi t . csv file. To download a file, it must be saved as a
separate audit log. When you move the data to a saved audit log by using the Start New Audit Log
button, the log file is named audi t xxx. csv, where xxx is the next sequential number of the log. After
a log file is saved, you can download the file to your workstation and import it into a spreadsheet
program.

Configuring Automatic Log Rotation
Audit Log Rotation automatically creates a new log when certain criteria are met.

1 In the Print Manager Health Monitor, click Advanced iPrint Manager Information > Auditing >
Configure Log Rotation.

2 Select Enable Audit Log Rotation.
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3 Specify the number of logs to keep.

When the number of logs to keep is reached, the oldest log is deleted when the next log is
created. When setting this number, take in to account the criteria you are using to create new log
files. If you want a year’s worth of logs, set the number of audit logs to keep to 12 and then select
the By Date and By Month options.

4 Specify the criteria used for log rotation:

By Job Count: Specify the maximum number of print jobs that an audit log can contain before a
new log is created.

By Date: Select when you want the audit logs to rotate.
+ Day: The log rotates each day at midnight.

+ Week: The log rotates each Sunday. If the Print Manager is not loaded on Sunday, the log is
rotated the next time the Print Manager starts.

+ Month: The log rotates at midnight on the first day of the month.

NOTE: If you select Day or Week, ensure that the Maximum Number of Audit Logs to Keep
entry is large enough so that logs are not rotated before you need the data.

By File Size: Specify the maximum file size (in KB) before a new log is created. The maximum
file size is 4194304 KB.

Downloading an Audit Report

When the file is downloaded, you can open the report in a spreadsheet application to sort, view, and
format the data to meet your needs. The active audit log, audi t . csv, cannot be downloaded. You
must first start a new audit log by clicking the Start New Audit Log option, then download the newly
created audit log.

1 On the Print Manager Health Monitor main page, click Advanced iPrint Manager Information >
Auditing.
2 Right-click the name of the audit log you want to download, then click Save Target As.

3 Follow the prompts and save the file to the desired location.

Creating Additional Print Managers

A Print Manager must be created and running before you can create and associate printers. A Print
Manager provides a platform for Printer Agents, which are logical representations of printers that
reside on the server. You can manually load Print Managers on a server.

Use the following guidelines to determine where and when to place a Print Manager:

+ Only one Print Manager can be running on a server.

+ For optimal performance, place the Print Manager and the printers it controls on the same LAN
segment.

+ Consider distributing your printers across multiple Print Managers so that if one manager goes
down, not all of the Printer Agents are affected.

You need the Supervisor right for the container where the Print Manager object is to reside.

1 IniManager, click iPrint > Create Print Manager.
2 Specify the Print Manager name for the iPrint Manager object.
3 Specify the container name where you want the Manager's object to reside.
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4 Specify an eDirectory server you want the iPrint Manager to communicate with.

For fault tolerance, you can specify more than one eDirectory server from the same tree. For
more information, see “Changing the eDirectory Server Assignment” on page 134.

5 Specify the Driver Store name.
6 Select the Start print manager after creation check box.

If you do not select the Start print manager after creation check box, you should start the Print
Manager. You can start the Print Manager by using Manage Print Manager > Manager Control in
iManager or by entering /etc/init.d./novel |l -i psnd start ata command prompt.

IMPORTANT: In a cluster setup, do not select the Start print manager after creation check box.

7 Click OK.
After the Print Manager is created, the daemon is loaded on the server.

To modify the Print Manager properties, click Manage Print Manager, then select the manager you
want to modify.

For information about Access Control roles, see “Setting Access Control for Your Print System” on
page 150.
Loading or Unloading the Print Manager
You can start and stop the Print Manager in two ways:
+ “Using the Command Line” on page 146
+ “Using iManager” on page 147
Using the Command Line

The Print Manager uses init scripts for starting and stopping the daemon. To load the Print Manager
from the command line, enter/ etc/init.d/ novel | -i psmd start.

The following init script actions are also valid:

Table 11-3 Print Manager Actions

Action Description

start Starts the daemon.

stop Stops the daemon.

reload or force-reload Stops and then starts the daemon.

restart Restarts the daemon.

try-restart Tries restarting the daemon.

status Displays the status of the daemon and the name of the Print
Manager.
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Using iManager

On the Manager Control Property page, you can view the Print Manager's status and unload or load
the manager daemon.

1 IniManager, click iPrint > Manage Print Manager.

2 Browse to and select the Print Manager you want to control.

3 Click Manager Control > Shutdown to stop Print Manager.

4 Click OK.

Moving Print Managers to Another Linux Server

Sometimes it is necessary to move the Print Manager from one server to another. If you assigned a
host name to the Print Manager, you should update the DNS entry with the new IP address that the
Manager is running on when the move is completed; otherwise, you cannot manage the Print
Manager and users are cannot print.

IMPORTANT: The URLs generated by iPrint are based on the server’s IP address or a host name. If
you move a Print Manager to a server that has a different IP address or a different host name than is
currently being used, a new URL is generated for each printer. Users must delete and reinstall their
iPrint printers. If you are using NDPS Printers, printing is not affected.

1 In iManager, click iPrint > Manage Print Manager.
2 Browse to and select the Print Manager you want to move, then click OK.
3 Click Shutdown.
Ensure all pending print jobs are complete else the jobs are lost.
4 On the Manager Control page, click Move.
5 Fillin the fields:

Target Server: Specify the host name or IP address for the server that is to host the Print
Manager. For example, 192.0.34.166 or print.my_company.com.

iPrint Service Name: Displays the IP address or host name for the iPrint service.
eDir Server: Specify an eDirectory server that you want the Print Manager to communicate with.
If you are using a host name, you must update your DNS host tables to reflect the move.

6 Click OK to move the Print Manager.

The Print Manager is moved and loaded on the destination server.

Auto Driver/Profile Update

An auto driver/profile update allows you to automatically update the client with the latest drivers and
the modified profiles available on the server, without users needing to manually update the driver or
profile. If you make any changes to the driver in the Driver Store or modify the profile, the client is
prompted for the changes and the client is updated.

NOTE: The client might take few seconds to 24 hours to reflect the changes.
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To enable the auto driver/profile update:

1 Upload the updated driver.
2 Create or modify the profile.

For more information on how to create the profile, see “Using Printer Driver Profiles” on
page 157.

3 Enable the auto driver/profile update:
3a IniManager, click iPrint > Manage Print Manager.

3b Browse to and select the Print Manager for which you want to enable the auto driver/profile
update.

3c Click Printer Agents.

3d Select the Auto driver/profile update for the Printer Agents for which you want to enable
auto driver/profile update.

3e Click OK.

Enabling Printer Agent Redirection

Printer Agent Redirection is useful when you are decommissioning an iPrint printer and want to
automatically redirect printing to a different iPrint printer without users manually deleting and
reinstalling the printer. Redirection can continue even after you delete the Printer Agent for iPrint
printers only.

Printer Agent Redirection is supported with the iPrint client for Windows v4.26 or later.

With Printer Agent Redirection enabled by entering a Printer Redirect URL, the client attempts to
access the printer and is then redirected to the new printer. The client verifies that it can access the
new printer before deleting the installed printer and installing the new printer.

Before implementing Printer Agent Redirection, you should be aware of the following:

+ When you redirect a mobile-enabled printer, you must ensure the redirected printer is also
mobile-enabled else the job fails to print. For example, Printer1 is redirected to Printer2. Later, if
you mobile-enable Printer1, you must ensure to mobile-enable Printer2 before sending a print
job.

+ When you redirect a Printer Agent, the iPrint Printer List Web page is automatically updated to
install the redirected printer. This means when a user clicks to install a printer listed from the list
page, the link has been updated to install the redirected printer.

For example, you redirect a Printer Agent that has the name of Printer_1_Color to a printer
called Color_Printer. On the iPrint Printer List Web page, the user sees and clicks
Printer_1_Color. After the printer is installed, the printer listed in the Windows Printer Folder is
Color_Printer.

+ Printers on maps are not automatically redirected. If you are using maps and you redirect the
Printer Agent, you need to also update your map and republish it to show the newer Printer
Agent. You should update the map before enabling Printer Agent Redirection because as soon
as you enter a redirection URL, the link on the map is broken and any user clicking the link in the
map receives an error.

+ If you redirect a Printer Agent to another printer that is also being redirected, the iPrint client
attempts to install the final destination printer; however, this might cause undesired results.

For example, if you have redirected Printer_1_Color to Color_Printer, and then redirect Printer_A
to Printer_1_Color, the iPrint client attempts to install Color_Printer for Printer_A.
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+ You should enable Printer Agent Redirection before deleting a printer; otherwise, when the client
accesses the Print Manager and cannot find the associated Printer Agent for an installed printer,
the installed printer is deleted.

+ WalkUp printers cannot be redirected.

IMPORTANT: If you are using iPrint Client Management, you should not use Printer Agent
Redirection. Using Printer Agent Redirection for printers being used by iPrint Client Management can
cause undesired results.

Instead, you should update iPrint Client Management with the desired printers.

Managing Printer Agent Redirection

Before deleting Printer Agents from a Print Manager, you should enable Printer Agent Redirection for
iPrint printers by entering another printer URL. By adding the URL before deleting the printer,
workstations can update to the newest printer.

The Printer Agent Redirection lists include NDPS and iPrint printers. If you enable redirection for
NDPS printers, then install the iPrint client on the workstations and edit the UpgradeNDPSPrinter=
entry in the i print.ini file, NDPS printers can be upgraded. However, if you delete an NDPS
Printer Agent, redirection is discontinued.

NOTE: By default, the iprint.ini file is located at: /var/opt/novell/iprint/htdocs/iprint.ini.

1 IniManager, click iPrint > Manage Print Manager.
2 Browse to and select a Print Manager.

3 Click Printer Agent Redirection.
4

For each Printer Agent you want to redirect, use the browse button to select the Printer object in
eDirectory to ensure that you use the correct URL.

If the printer resides in a different tree, you can manually enter the URL in the following format:
ipp://server/ipp/pa_name where server is the IP address or host name of the server and
pa_name is the Printer Agent.

5 Click Apply.

Each URL is validated to ensure that the format is valid and that the Printer Agent is available.
An error is displayed when the URL cannot be validated.

Managing Deleted Printer Agent Redirection

Each time a Printer Agent is deleted, it is moved to the Deleted Printer Agent Redirection list.
Periodically, you should review this page and delete printers that are no longer being accessed or
printers where redirection was not enabled.

1 IniManager, click iPrint > Manage Print Manager.

2 Browse to and select a Print Manager.

3 Click Printer Agent Redirection > Deleted Printer Agent Redirection.

4 Select the Printer Agents to delete.

Use Printer Last Accessed Time and Printer Deleted Time to determine if users are still
attempting to access a specific printer and if sufficient time has passed that you can delete
Printer Agents from the list.
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5 Click Apply.

Each URL is validated to ensure the format is valid and that the Printer Agent is available. An
error is displayed when the URL cannot be validated.

Managing Printers

Although the default settings let users print without additional configuration, you might want to modify
some of those settings so that you can manage your printing resources most effectively.

+ “Creating Secure Printers” on page 150

+ “Creating Additional Printers” on page 156

+ “Deleting Printers” on page 156

+ “Managing Printer Agents” on page 157

¢ “Using Printer Driver Profiles” on page 157

+ “Enabling iPrint Direct” on page 160

+ “Managing Print Jobs” on page 160

+ “Using Printer Banner Pages” on page 161

+ “Modifying the Printer's Gateway Load Commands” on page 163

+ “Configuring LPR Printers” on page 165

+ “Configuring Job Holds” on page 166

Creating Secure Printers

You can set up a secure printing environment by using the following methods:

+ “Setting Access Control for Your Print System” on page 150
¢ “Using SSL/TLS for Secure Printing” on page 154

+ “Password Caching” on page 156

Setting Access Control for Your Print System

Your print system is designed to take full advantage of eDirectory. You receive all the benefits of
eDirectory security and ease of management provided by the industry’s most advanced and robust
directory service. The Access Control feature lets you specify the access that each User, Group, or
Container object has to your printing resources. Currently, access control for printers is only
supported on the Windows iPrint Client.

Access control roles are mutually exclusive, even though the same individual might need to perform
tasks reserved for different roles. For example, only Printer Managers can add or delete printer
operators or printer users. In a similar way, managers and operators must also be designated as
users for a printer before they can submit print jobs to it.

In actual implementation, the defaults prevent most problems that might occur from these distinctions.
For example, a manager is automatically designated an operator and user, and an operator of a
printer is automatically designated a user of that printer.

The creator of an object is automatically granted privileges for all available roles for the type of object
being created.
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The following sections describe some of the security issues and features you might find useful as you
plan your print system setup:

+ “Setting Access Control for Printers” on page 151

+ “Setting Access Control for the Print Manager” on page 152

+ “Setting Access Control for the Driver Store” on page 153

Setting Access Control for Printers

Printer security is ensured through the assignment of the manager, operator, and user access control
roles and by the strategic placement of your printers and printer configurations.

+ “Printer Access Control Roles” on page 151

+ “Assigning Printer Access Control Roles through Printer Objects” on page 152

Printer Access Control Roles

Different User, Group, or container objects can have different access rights to the same printer. For
example, if you want only certain users to be able to send jobs to a particular printer, you can specify
which users should have access and what access roles each user should have.

The following table describes the rights and privileges associated with each of the printer access

control roles:

Table 11-4 Printer Access Control Roles

Role

Description

Manager

Operator

Tasks performed exclusively by the Manager are those that require the creation,
modification, or deletion of objects, as well as other eDirectory administrative
functions. Managers are automatically designated as Operators and Users, so
they can perform all tasks assigned to those operator roles. Typical manager
functions include the following:

+ Modifying and deleting Printer objects

+ Adding or deleting operators and users for a printer
+ Adding other managers

+ Configuring interested-party notification

+ Creating, modifying, or deleting printer configurations

Operators are automatically designated as Users, so they can perform all tasks
assigned to Users roles. Printer management tasks performed by the operator
include the following:

+ Performing all of the functions available through the Printer Control page
+ Pausing, restarting, or reinitializing printers
+ Reordering, moving, copying, and deleting jobs

+ Setting printer defaults, including locked properties

Operators cannot create, modify, or delete eDirectory objects or perform other
eDirectory administrative functions.
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Role Description

User Tasks performed by users include the following:

+ Submitting print jobs

+ Managing print jobs they own (users cannot copy, move, reorder, or
remove jobs they do not own)

To simplify administration, the container a printer resides in is automatically
assigned as a user for that printer, so all users in that container and its
subcontainers can use that printer without being added to the list. You can
delete the container from the list if you want to limit access to certain users,
groups, or roles.

Assigning Printer Access Control Roles through Printer Objects

Different User, Group, or Container objects can have different access rights to the same printer. For
example, if you want only certain users to be able to send jobs to a particular printer, you can specify
which users should have access and what access roles each user should be given.

1 IniManager, click iPrint > Manage Printer.

2 Browse to and select the printer you want to enable Access Control for.

3 Click the Access Control tab.

4 Add or delete Users, Groups, or Container objects to the different access control roles.
5 Click OK.

Setting Access Control for the Print Manager

Print Manager security is ensured through the assignment of the manager access control role.

+ “Print Manager Access Control Role” on page 152

+ “Assigning the Manager Role for Print Managers” on page 153

Print Manager Access Control Role

The only access control role available for the Print Manager is that of manager. The following table
explains the tasks performed by the manager role:

Table 11-5 Print Manager Access Control Role

Role Description

Manager Tasks performed exclusively by the manager are those that require the creation,
modification, or deletion of print system objects, as well as other eDirectory
administrative functions. Typical manager functions include the following:

+ Creating Printer Agents and Print Manager objects

+ Adding or deleting operators and users for a printer

*

Adding other managers
+ Configuring interested-party notification

+ Creating, modifying, or deleting printer configurations
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Assigning the Manager Role for Print Managers

To create manager assignments for your Print Manager objects:

1 IniManager, click iPrint > Manage Print Manager.

2 Browse to and select the Print Manager you want to enable access control for.
3 Click the Access Control tab.
4 Add or delete Users, Groups, or containers to the manager role.

5 Click OK.

Setting Access Control for the Driver Store

The Driver Store security is ensured through the assignment of manager access control roles.

+ “Driver Store Access Control Roles” on page 153

+ “Assigning Managers for the Driver Store” on page 153

Driver Store Access Control Roles

The access control roles available to the Driver Store are manager and public access user. The

following table explains these roles:

Table 11-6 Driver Store Access Control Roles

Role

Description

Manager

Public Access User

Tasks performed exclusively by the Driver Store manager are those that require
the creation, modification, or deletion of Driver Store objects, as well as those
that involve other eDirectory administrative functions. Typical manager
functions include the following:

+ Creating, modifying, and deleting Driver Store objects
+ Adding other managers

+ Adding resources to the Driver Store

A public access user is a role assigned to all entities on the network that are
users of resources provided by the Driver Store. This role is assigned by default
and does not require specific administrative action by the Driver Store
manager. Typically, Print Managers refresh their cached copies of printer
drivers for the printers they are hosting with updated printer drivers from the
Driver Store.

Assigning Managers for the Driver Store

To create Manager assignments for your Driver Store objects:

1 In iManager, click iPrint > Manage Driver Store.

2 Browse to and select the Driver Store you want to enable access control for.
3 Click the Access Control tab.
4 Add or delete Users, Groups, or Containers to the manager role.

5 Click OK.
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Using SSL/TLS for Secure Printing

Secure printing takes advantage of SSL, which requires users to authenticate with their eDirectory
usernames and passwords. Users authenticate once per eDirectory tree per session. Between the
client and the Print Manager, the print data is encrypted and all print communication uses port 443.
Without secure printing, the printer is available to anyone inside the firewall on the network and the
print data is not encrypted to the server. Secure printing works in conjunction with the security level
set for the printer. All print data between the server and the printer is not encrypted because most
printers do not support encrypted data. Also, when you enable iPrint Direct, data is not encrypted
between the client and the printer.

If you are using the latest iPrint Client and server software, iPrint automatically attempts to use TLS
for printing on port 631. TLS printing supports encrypted and non-encrypted print communication
through port 631. Whether or not encryption is used is dependent on the secure printing setting of the
Printer Agent. If secure printing is enabled on a printer, the user is required to authenticate, and the
print data is encrypted. If secure printing is not enabled, the user does not authenticate and the print
data is not encrypted.

Beginning with iPrint Client 4.05, both non-secure and secure printing URLs use ipp://.

+ “Enabling SSL/TLS” on page 154
+ “Saving Passwords for Secure Printers” on page 154
+ “Configuring TLS Printing with Proxies” on page 154

Enabling SSL/TLS

1 IniManager, click iPrint > Manage Printer.

2 Browse to and select the Printer object you want to modify.
3 Click Client Support > iPrint Support.

4 Select the Enable Secure Printing check box.

If a WalkUp printer is selected this option is not available. All WalkUp printers are secure
printers.

5 Click Apply or OK to update the printer settings.

Saving Passwords for Secure Printers

When users print to a secure printer, they are prompted for the eDirectory username and password.
Users can select to have their workstations remember their password for printing. For Windows NT/
2000 users, passwords are saved on a per-user basis.

Configuring TLS Printing with Proxies
To use a proxy with secure printing:

1 Create afile in/etc/opt/novel | / httpd/ conf.d named nod_proxy. conf .
2 Add the following lines to the file:
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LoadMbdul e proxy_nodul e /usr/Ii b/ apache2-worker/nod_proxy. so

LoadMbdul e proxy_connect _nodul e /usr/Ii b/ apache2-wor ker/ nod_proxy_connect. so

LoadMbdul e proxy_http_nodul e /usr/li b/ apache2-worker/nod_proxy_http. so

# This is the port the proxy will listen on
Li sten 8080

ProxyRequests On
ProxyVia On
<Proxy *>
Order deny, al | ow
Allow fromAl I
</ Proxy>
Al | owCONNECT 631 443

3 Set the proxy port on the client to 8080.
4 Restart Apache.

To set up a Squid proxy:

IMPORTANT: Implementing the following changes lets your users print using TLS; however, there

are security risks involved. Contact your Security Administrator before completing these steps.

1 Rename the Squid configuration file by using the following command: nv /et c/ squi d/
squi d. conf /etc/squid/squid.conf.orig

2 Create a new / et ¢/ squi d/ squi d. conf file.
3 Add the following lines to the file:

http_port 3128

#acl all src all

acl manager proto cache_obj ect
acl local host src 127.0.0.1/32
acl to_local host dst 127.0.0.0/8
acl SSL_ports port 80 443 563 631

acl Safe_ports port 80 # http

acl Safe_ports port 21 # ftp

acl Safe_ports port 443 563 631 # https, snews

acl Safe_ports port 70 # gopher

acl Safe_ports port 210 # wai s

acl Safe_ports port 1025-65535 # unregistered ports
acl Safe ports port 280 # http-ngm

acl Safe_ports port 488 # gss-http

acl Safe_ports port 591 # fil emaker

acl Safe_ports port 777 # multiling http

acl CONNECT net hod CONNECT

acl ipp_access port 631

http_access allow all

m ss_access al l ow al |

http_access al | ow CONNECT i pp_access
http_reply_access allow all

i cp_access allow all

m ss_access al | ow al |

i gnor e_expect _100 on
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4 Set the proxy port on the client to 3128.
5 Restart Squid.

Password Caching

When users change their passwords, secure printers might continue printing with the old password
for up to 10 minutes. This is caused by caching inside the iPrint LDAP authentication module, and
affects only the users created inside the local eDirectory tree on iPrint Appliance.

Creating Additional Printers
Before creating additional printers, ensure that you meet the following prerequisites:
(J Have the Supervisor right for the destination container where its associated Printer object is to
reside.
J Be designated as a manager of the Print Manager that controls this printer.
(J Have a Driver Store running.

0 Have a Print Manager running.
To create additional printers:

1 In iManager, click iPrint > Create Printer.
2 Fillin the fields.
Click Help for explanations about the fields.
3 Click OK.
4 Click Next, then select the drivers for this printer.

If the printer drivers for this printer are not listed, you can still create the printer. After the printer
is created, you can add the printer drivers to the Driver Store and then associate the drivers to
the printer by clicking Manage Printer > Drivers.

These drivers are automatically downloaded to users’ workstations when they install the printer
in the future.

Because the list of printer drivers included with this product is limited, you can add drivers to the
Driver Store. See “Updating Printer Drivers” on page 135 for more information.

If you do not select a driver, users are prompted to provide a disk with the appropriate driver the
first time they install this printer on their workstations.

5 Click Next to create the printer.

Deleting Printers
You use iManager to delete existing Printer Agents. Before deleting a Printer Agent, ensure that the

agent is no longer being used by running an report on the printer or by using Printer Agent
Redirection to redirect the printer for a period of time before deleting it.
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WARNING: Deleting a printer permanently removes the printer from the Print Manager. You cannot
use Printer Agent Redirection. The printer is automatically removed from workstations the next time
the workstation communicates with the Print manager.

1 IniManager, click iPrint > Delete Print Object.
2 Browse to and select the objects you want to delete.
3 Click OK.

Managing Printer Agents

You use iManager to manage Printer Agents. You can start up and shut down a Printer Agent, pause
and resume input and output, view printer information, set configuration settings, and change the
printer drivers.

1 IniManager, click iPrint > Manage Printer.
2 Browse to and select the printer you want to manage.
3 Use the tabbed property pages to complete the task you want.

Using Printer Driver Profiles

A printer driver profile allows you to set the driver defaults for a Windows printer driver. When you
associate the printer driver profile to a printer, the printer is installed and configured with your defined
settings. For example, in a law office you might want the default paper size to be legal size. This
means that every time the printer and its corresponding driver is installed on a workstation, the paper
size is set to legal size.

When creating a printer driver profile, you work directly with a platform-specific printer driver; so you
should create and modify profiles from the same operating-specific platform as the printer driver. For
example, to create or modify a Windows 2000 printer driver profile, you must access iManager and
complete the task from a Windows 2000 workstation.

Use the Bi-Directional driver option to enable the selected printer driver to communicate with the
printer. Bi-Directional communication allows the driver to communicate with the printer and discover
its capabilities. This enables you to create more detailed profiles. Bi-Directional drivers communicate
with the printer during profile creation. If your printer is not reachable from the client during profile
creation, only basic profiles are created. When you create a profile for Bi-Directional drivers, you must
provide a Printer Agent.

Use the Universal Printer Driver (UPD) model to simplify the task of managing the vast array of printer
makes and models. This model allows the printer vendor to create a single printer driver that works
with most of the printer and multifunction devices that the vendor manufactures. With this innovation,
the Administrator/User no longer needs to install a unique driver for each and every printer model, but
uses one driver to communicate with their devices.

Installing the UPD on the iPrint server (NetWare or Linux) is the same as installing individual drivers.
Use iManager to upload the driver to the Broker or Driver Store and then assign this driver to the
printers. You should use the latest iManager and also the latest support packs/updates for the iPrint
server. The latest updates include support for Windows 7, printer driver profile updates, and
enhancements for bidirectional communications, which are necessary for UPD function and printer
driver profile creation.
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You can create, copy, delete, and modify the printer driver profiles.

¢ “Creating a Printer Driver Profile” on page 158

+ “Modifying a Printer Driver Profile” on page 159

+ “Copying a Printer Driver Profile” on page 159

+ “Deleting a Printer Driver Profile” on page 159

+ “Associating a Printer Driver Profile with a Printer” on page 160

Creating a Printer Driver Profile

1 In iManager, click iPrint > Printer Driver Profile.

2 Browse to and select the Print Manager where you want the driver profile to be stored and made
available to the printers on that manager.

3 From the Select operation drop-down menu list, select Create Printer Driver Profile and click

OK.

4 In the Create driver profile window, perform the following tasks:

4a

4b

4c

4d
de

4f

49

4h

Specify the Driver Profile name.
You can create a new driver profile or you can use the existing driver profile.

To create a new driver profile, select Create new driver profile and then select the driver for
new profile from the list.

NOTE: If you are enabling printer communication for a WalkUp printer, you must select the
driver of a non-WalkUp printer. Ensure the same driver is used for WalkUp printer.

To use the existing driver profile, select Create using existing driver profile and then select
the driver profile from the list of existing driver profiles.

The associated printer model of the selected driver profile is displayed.
To enable printer communication, select the Requires printer communication check box.

Specify the name of the existing Printer Agent in the iPrint Printer name field. The driver
profile is created and associated with the printer model.

Ensure that your printer is reachable from the client during profile creation, or only basic
profiles are created.

NOTE: Do not specify a WalkUp printer because it is a virtual print queue and not
associated with a printer model. Instead specify a non-WalkUp printer.

Click Next.

The Loading Driver Configuration window appears and shows the progress.

When the driver profile is loaded, the Save Driver Profile page is displayed. Click Next.
The complete page opens.

Click OK.

The driver profile is created.

After creating a printer driver profile, you must associate it with a printer. For information on
associating the driver profile, see “Associating a Printer Driver Profile with a Printer” on
page 160.
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Modifying a Printer Driver Profile

1 IniManager, click iPrint > Printer Driver Profile.

Browse to and select the Print Manager where you want the driver profile to be stored and made
available to the printers on that manager.

3 From the Select operation list, select Modify Printer Driver Profile and click OK.

Select the Driver Profile that you want to modify and click Next.
You can select only one driver profile at a time for modification.

(Optional) Specify the name of the existing Printer Agent in the iPrint Printer name field and click
Next.

Ensure that the printer model matches the profile printer model.
This option is displayed only if the printer model is displayed.

The printer model is displayed if you have selected Requires printer communication when
creating the printer driver profile.

The Loading Driver Configuration window is displayed to indicate the progress.

When the driver configuration is completed, the Modify Driver Profile page is displayed. Click
Next.

The complete page is displayed.
Click OK.
The driver profile is modified.

Copying a Printer Driver Profile

1 In iManager, click iPrint > Printer Driver Profile.

Browse to and select the Print Manager where you want the driver profile to be stored and made
available to the printers on that manager.

From the Select operation drop-down list, select Copy Printer Driver Profile, then use the
Destination printer manager name list to select the Printer Manager where you want to copy your
driver profile. Click OK.

Select the Driver Profiles that you want to copy and click Next.
The complete page is displayed.

Click OK.

The driver profile is copied.

Deleting a Printer Driver Profile

1
2
3
4

In iManager, click iPrint > Printer Driver Profile.

Browse to and select the Print Manager where the driver profile that you want to delete is stored.
From the Select operation drop-down list, select Delete Printer Driver Profile and click OK.
Select the driver profiles that you want to delete and click Next.

The complete page is displayed.

Click OK.

The driver profile is deleted.
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Associating a Printer Driver Profile with a Printer

In iManager, click iPrint > Manage Printer.
Browse to and select the printer you want to modify.
Click Drivers > Drivers Platform.

Select the printer driver from the list of available drivers.

a A WON =

Select the profile that you want to associate with this printer from the list of Available Driver
Profiles for Selected Driver.

If you do not want a profile to be associated, select None.
6 Click OK to save the changes.

Enabling iPrint Direct

A printer that is enabled for iPrint Direct sends print jobs directly to the printer instead of sending the
job to the Print Manager first. A job is sent to the printer in LPR or raw 9100 format, depending on the
setting in the gateway autoload command for the printer. Although this greatly reduces server
communication, the ability to audit print jobs is lost. iPrint Direct supports direct banner printing (if the
banner is already configured) and driver updates. The printer information is gathered directly from the
printer by using SNMP.

NOTE: Direct Banner for iPrint Direct is supported only on Windows.

1 In iManager, click iPrint > Manage Printer.
2 Browse to and select the printer for which you want to enable iPrint Direct printing.
3 Click Client Support > iPrint Direct.
4 Select the Enable iPrint Direct Printing option.
This option is not available for a WalkUp printer.
5 Click OK.

NOTE: For detailed information on iPrint Direct, see Technical Information Document (TID#7001343)
on the Novell Support Site.

Managing Print Jobs

The following sections provide specific information about the print job management features. Users
designated as managers or operators for a printer can perform these tasks for all jobs routed to that
printer; individual job owners can perform these tasks only for their own print jobs.

+ “Viewing Print Job Information” on page 160
+ “Deleting Print Jobs” on page 161
+ “Changing the Order of Print Jobs” on page 161

Viewing Print Job Information

You can view information about individual print jobs waiting to be processed by a specific printer.

1 IniManager, click iPrint > Manage Printer.

2 Browse to and select the printer the job was sent to.
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3 Click Printer Control > Jobs. Information about the print jobs is displayed.
If a WalkUp job is selected the Pause, Resume, and Promote buttons are not available.

Deleting Print Jobs

Administrators can delete any print job after it has been submitted if the job has not yet started
printing. Users can delete only their own print jobs.

1 IniManager, click iPrint > Manage Printer.

2 Browse to and select the printer the job was sent to.

3 Click Printer Control > Jobs.

4 Select the check box next to the job you want to delete.

5 Click Delete.

Changing the Order of Print Jobs

Occasionally, you might need to print a job ahead of other jobs that have already been submitted to a
printer but have not yet started printing. Administrators, managers, and operators can move any job
up or down the list. Users can move only their own jobs, and can move them only down the list.

1 In iManager, click iPrint > Manage Printer.

2 Browse to and select the printer the job was sent to.

3 Click Printer Control > Jobs.

4 Select the check box next to the job you want to modify.

5 Click Promote to move a print job up the list.

If a WalkUp job is selected the Promote button is not available.

Using Printer Banner Pages

Banner pages create a cover sheet for each print job that a printer produces. You use the Printer
Banner Configuration task to customize the information printed on a banner to your needs. If you
select to display eDirectory information such as the eDir e-mail address, the Print Manager needs
rights to read these attributes. Follow the steps in “Using eDirectory Attributes with Custom Banners’
on page 162.

¢ “Configuring a Custom Banner” on page 161
+ “Associating a Custom Banner to a Printer” on page 162
+ “Using eDirectory Attributes with Custom Banners” on page 162

Configuring a Custom Banner

1 IniManager, click iPrint > Printer Banner Configuration.
2 Browse to and select the Print Manager you want.
3 Select an operation and click OK.
Create Custom Banner: Lets you create a new custom banner.
Delete Custom Banner: Lets you delete an existing banner.
Modify Custom Banner: Lets you edit the settings of an existing custom banner profile.
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4 Complete the fields with the information you want. If you create multiple banners, you should use
banner names that are descriptive enough to identify them when you associate the banner to a
printer.

5 Select the Banner Text Location.

This is where the banner option information appears on the banner page. The banner
information is grouped together and then placed as a unit either starting at the top of the page,
centered on the page, or starting at the bottom of the page.

6 Select the banner options you want and the font size you want to display the information.
7 Click OK to save the changes.

Associating a Custom Banner to a Printer

In iManager, click iPrint > Printer Banner Configuration.
Browse to and select the Print Manager where the Printer Agents are hosted.
Select Assign Custom Banner, then click OK.

From the Custom Banner drop-down list, select the banner you want.

a b WON =

Select the check box next to each printer you want this banner associated with.

When you select the check box, the banner name appears in the Assign Banner field. To
associate a different banner, select the desired banner from the Custom Banner drop-down list,
and select the check box for the printer you want to change. If you do not want a banner to be
used, select None.

You can also assign banners when you use the Manage Printer task.

1 In iManager, click iPrint > Manage Printer.
2 Browse to and select the printer you want to modify.
3 Click Configuration > Custom Banners.
This option is not available for a WalkUp printer.
4 In Available Banners, select the banner that you want this printer to use.
5 Click OK to save the changes.

If you select to display eDirectory information such as the eDir e-mail address, the Print Manager
needs rights to read these attributes. Follow the steps in “Using eDirectory Attributes with
Custom Banners” on page 162.

Using eDirectory Attributes with Custom Banners

Custom banners lets you select the information you want displayed on the banner page. Some of the
banner options use information contained in eDirectory. In order for the Print Manager to obtain this
information, you must modify the trustee rights and give the Print Manager read rights to these
properties. Because rights flow down the eDirectory tree, you can assign the trustee right at a
container level above the users, or to the tree.

1 IniManager, click Rights > Modify Trustees.

2 Select the container or tree where you want to modify the rights.

3 Click Add Trustee, then select the Print Manager object.

4 Click Add Property, then select the Show All Properties in Schema check box.

5 Select the attributes that you want:
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Banner Option eDirectory Property

eDir mail stop mailstop
eDir e-mail address EMail Address
eDir location L
eDir telephone number Telephone Number
eDir user first name Given Name
eDir user full name Full Name
eDir user last name Surname
6 Click OK.
7 Ensure that at least the Read right is selected.
8 Click Done.

NOTE: If your client, printer, and server are not all configured for the same language, you might
experience problems with the output of your banner pages, such as the job name being corrupted. If
you are working in this type of mixed environment, you should consider not using banner pages.

Modifying the Printer’'s Gateway Load Commands

1 In iManager, click iPrint > Manage Printer.
2 Browse to and select the printer you want to modify.
3 Click Configuration > Gateway.
This option is not available for a WalkUp printer.
4 Edit the gateway autoload command.
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The following table describe the gateway load commands and parameters that can be used.

Gateway Load Parameters

Description

IPRINTGW

The gateway executable that is loaded for the Printer Agent.

PA=

The name of the Printer Agent to be supported by this gateway
instance.

PORT=

The port on the physical printer to be used for print job
submission. Valid values are:

LPR: Specifies the LPR print protocol and resolves to the
standard LPR port - 515.

RAW: Specifies the RAW print protocol and resolves to the
default RAW port - 9100 unless the port number is specified
separately in the load string. Port 91 can also be used instead of
9100.

Number: The actual port number for the physical printer.

NODATA: Specifies the LPR print protocol, but document data is
not submitted to the physical printer.

NULL: SNMP and ping are disabled for this gateway instance.
Document data is not submitted to the physical printer.

STRICTLPR

Limits the port number on the gateway side of LPR
communication to the standard LPR range of sockets (721 -
1020).

This parameter is needed only for some older printers that
enforce the range of ports specified by the original LPR
specification for LPR clients.

HOSTADDRESS=
HOSTNAME=
HOST=
IPADDRESS=

Any of these specifies the hostname / IP address for the physical
printer to be supported by this gateway instance.

NOTE: If the hosthame / address value has :nn at the end of the
value, the port number for the printer is derived from this value.

However, the most common approach is to specify the port with
the PORT= parameter.

PRINTERNAME=
PRINTER=

The printer / queue name for LPR protocol print sessions to the
physical printer. The default value is PASSTHROUGH.

USERNAME_CN

Passes only the user name for LPR communication.

For example, if the user name is admin and container is novell,
then on passing this parameter, the user name passed is
"admin". If this parameter is not passed, the user name is
passed in FQDN format (admin.novell).

USERNAME_TRUNCATED

Truncates the length of the user name to 31 characters as per
standard LPR protocol.

GETCOMMUNITYSTRING=
GET=

Specifies the community string for SNMP requests. This is only
needed when a printer has been configured with a community
string that is different from the default string "public".
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Gateway Load Parameters Description

SQUERYACTIVE= Specifies the interval between SNMP requests to the physical
printer while the printer is idle. The default value is 300 seconds
(5 minutes).

SPOLL= Specifies the interval between SNMP requests to the physical
printer while the printer is active or idle.

SETCOMMUNITYSTRING= Sets the community string to be used for the SNMPGet and
Get Next requests.

JPOLL= Sets the job polling interval (in seconds).
NOTE: When the JPOLL option is not set, the job polling interval
is 2 seconds.

NOSNMP Disables SNMP requests for this gateway instance to its

respective physical printer.

WAITONPRINTER= Specifies the number of minutes to timeout for communication to
the physical printer.

NOTE: For write attempts, this parameter is only effective if the
value is greater than the minimum default timeout value. If
SNMP is disabled by the NOSNMP or the NULL parameter, the
minimum default is 15 minutes. If SNMP is active, the minimum
default is 5 minutes.

THROTTLE= Specifies a delay of nn seconds while establishing
communication with the physical printer and between print jobs.
This is primarily used for solving a problem where the end of a
job is lost when submitting an LPR job to a windows system.

KYOCERA= Sets the Printer Manufacturer (Make) attribute for this Printer
Agent to "Kyocera".

RICOH= Sets the Printer Manufacturer (Make) attribute for this Printer
Agent to "Ricoh".

TROY= This has no effect.

5 Click OK to save the changes.

Configuring LPR Printers

To complete the LPR configuration, users need to know the LPR Host and the LPR Printer/Queue
information, which is the Printer Agent name, provided in iManager. The iPrint Client is not required
for LPR printing.

UNIX, Macintosh, and other LPR clients can print to iPrint printers through LPR.

IMPORTANT: In order for LPR to work, the Printer Agent name cannot contain spaces. If it does, you
need to re-create the Printer Agent or select a different printer.

To set up an iPrint printer to accept LPR print jobs, you need to enable LPR/LPD printing for the
printer.

1 IniManager, click iPrint > Manage Printer.
2 Browse to and select the printer you want to enable LPR printing for.
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3 Click Client Support > LPR Support.
This option is not available for a WalkUp printer.
4 Select the Enable LPR/LPD Client Support check box.

The LPR Host and LPR Printer/Queue fields display information required when setting up
printing for Macintosh, UNIX, or other LPR clients.

LPR Host: The server name where the Print Manager is running.

LPR Printer/Queue: The same as the Printer Agent's name. The Printer Agent name cannot
contain any spaces; otherwise, LPR does not work properly.

5 (Optional) Enable the following options:

Filter All LF to CRLF and Append FF to Jobs: Selecting this check box changes bytes in the
LPR data stream of all incoming LPR print jobs from Line Feeds to Carriage Returns with Line
Feeds and appends a Form Feed to the end of the print job. Typically, these changes are made
at the LPR client; however, if you are sure of your users’ configurations, you can implement this
option.

Address Ranges: Add an address range only if you want to restrict access to this printer to LPR
clients within the address range. When the list is empty, all addresses are allowed to print
(default).

6 Click Apply or OK to update the printer settings.

7 From the UNIX, Macintosh or other LPR client, set up a printer using the LPR Host and LPR
Printer/Queue information displayed in Step 4.

Configuring Job Holds

1 In iManager, click iPrint > Manage Printer.
2 Browse to and select the printer you want to modify.
3 Click Configuration > Job Holds.
This option is not available for a WalkUp printer.
4 Modify the settings.
Operator Hold: A job does not print until the operator releases it.
User Hold: A job does not print until the user who has submitted the job releases it.
5 Click OK to save the changes.

Using iPrint Client Management

iPrint Client Management (iCM) includes functionality similar to the Remote Printer Management
feature included in Novell Distributed Print Service, which lets you designate printers to be installed
on a workstation when a user logs in to the workstation using the Novell Client. Previously, this
functionality was only available with NDPS printers, but now it is available for iPrint printers. iCM also
lets you control the iPrint Client configuration, making it easier to configure the iPrint Client without
visiting each workstation. When the user logs in to the workstation using the Novell Client, the iPrint
Client settings you designate are configured on the user’s workstation.

iCM is available for Windows 2000/XP/2003/2008/Vista/7/8/8.1/2012/2012 R2 workstations, and
requires the following:

+ iPrint iManager plug-in for Linux or the iPrint iManager plug-in for NetWare dated May 2006 or
later

+ Novell iPrint Client v4.17 or later (install after the Novell Client)
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¢ iprint.ini

+ eDirectory schema update from NetWare 6.5 Support Pack 8 or later.

NOTE: iPrint Client Management does not support dynamic groups.

IMPORTANT: Novell iPrint Windows Client components of version 5.72 and later do not require the
Novell Client. However, Novell iPrint Windows Client components of versions prior to 5.72 need
Novell Client 4.91 for Windows 2000/XP/2003 or later. For more information, see “Configuring iCM for
Windows / Active Directory (AD) environments without Novell Client” on page 168.

All of the required components are included in NetWare 6.5 Support Pack 8 except the Novell Client
4.91 for Windows 2000/XP, which is available from the Novell Support Web site (http://
support.novell.com/produpdate/patchlist.html#client).

The iPrint iManager plug-ins also work with Mobile iManager. Mobile iManager is available at Novell
Downloads (http://download.novell.com/SummaryFree.jsp?buildid=BJosshiLid0~).

NOTE: You can install the iPrint iManager plug-in for NetWare NPM on Mobile iManager or iManager
running on NetWare. You can install the iPrint iManager plug-in for Linux on Mobile iManager or
iManager running on Linux or NetWare. Depending on your iManager configuration, you might see
two iPrint roles. The iPrint role is for iPrint running NetWare tasks, and, the iPrint (Linux) role is for
iPrint running Linux tasks.

With iCM, you manage a set of attributes on a given eDirectory tree regardless of whether the printers
are hosted on an Open Enterprise Server NetWare or a Linux server, because iCM is configured and
managed through eDirectory objects.

Use the following information to install and configure iCM:

+ “Understanding the Schema Update” on page 167
+ “Deploying iPrint Client Management” on page 168

+ “Configuring iCM for Windows / Active Directory (AD) environments without Novell Client” on
page 168

+ “Managing iPrint Client Settings” on page 168
+ “Automatically Installing Printers” on page 169
¢ “Using Advanced Settings” on page 170
¢ “iCM in OES Environment” on page 171
+ “iICM with iPrint Appliance” on page 172

Understanding the Schema Update

iPrint Client Management requires you to extend the eDirectory schema. The i pri nt . sch file (found
in -/ opt/novel I / sch/iprint. sch) contains the schema extension, which adds some optional
attributes to Organization, Organizational Unit, Groups, and User object class definitions. The
attributes are:

¢ iPrintiCMPrinterList

¢ iPrintiCMClientTrayURI

+ iPrintiCMClientProxyURI

¢ iPrintiCMClientFlags
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Users should be able to read these new attributes on their user objects; however, if you plan to
configure iCM at an Organization, Organizational Unit, or Group object level, users might need the
Read right to read the attributes. The first time you access iCM on an Organization, Organizational
Unit, or Group object in iManager, iManager attempts to assign the Read right to the attributes. Then
users should be able to read these attributes through inheritance on subcontainers and groups. If
iManager cannot assign the read right to the Organization, Organizational Unit, or Group object, your
configuration is saved, but a message appears explaining that rights to the attributes could not be
granted. You need to grant rights to these iPrint attributes by using either the eDirectory
Administration or Trustee task in iManager.

TIP: To avoid multiple explicit rights assignments for the iCM attributes, you should make your first
iCM assignment as high in the eDirectory tree as possible so that the rights can flow down the tree.
You could even make an iCM assignment so that the Read right is set, and then disable the iCM
assignment because this does not remove the Read right to the attributes.

Deploying iPrint Client Management

1 Distribute the iPrint Client version 4.26 or later.
If the iPrint Client is already distributed, see “Updating the iPrint Client” on page 202.

If youuseiprint.ini todistribute the iPrint Client, you need to allow enough time for users to
update to the new client before configuring iCM. If you do not allow enough time, the client
attempts to update a workstation at the same time it is trying to deploy the settings in iCM.

2 Configure iPrint Client Management in iManager.

See “Managing iPrint Client Settings” on page 168 or “Automatically Installing Printers” on
page 169 for more information.

Configuring iCM for Windows / Active Directory (AD) environments
without Novell Client

The Novell iPrint Windows Client (version 5.72 and later) now supports Windows / Active Directory
environments without the Novell Client. This new feature provides shared authentication with the
Windows Login, and also supports iCM for printer distribution and client settings. The following
prerequisites should be met:

+ Synchronization of users, groups, and containers (via Novell Identity Manager or a similar
synchronization tool)

+ Standardization on LDAP user names that require unique user names and require the uniquelD
attribute to be set

Managing iPrint Client Settings

You can standardize the iPrint Client settings for users by using iCM Client Configuration to define the
attributes for an Organization, Organizational Unit, Group, or a User Object. The attributes are
delivered as a complete set, meaning that if you change only one attribute, all of the attributes are
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delivered to the client. The changes are not additive, so you cannot change the value of an attribute
for an object and change the value of a different attribute on another object. Only the set of attributes
closest to the user’s object are used.

When a user logs in, iCM walks up the tree from the user’s container to the highest container in the
user’s fully distinguished name. Then iCM starts applying the iCM attributes in each container as it
walks back down to the user object. Then the user's group membership list is queried for the same
attributes. Those closest to the User object have a higher priority. The set of attributes on or closest to
the User object is always used.

WARNING: Using iCM on group objects can simplify making assignments, but using iCM on multiple
groups can cause undesired results. You should create a new Group object with a descriptive name
so that you can control the desired results for users that you assign to that group.

To configure the iCM client attributes:

1 IniManager, click iPrint > iPrint Client Management.

2 Browse to and select the Organization, Organizational Unit, Group, or User object you want to
automatically configure iPrint Client Settings for.

3 Click Client Configuration.

4 Configure the attributes you want for the iPrint Client on the workstation.
Click Help for explanations about the attributes.

5 Click OK to save the changes.

Automatically Installing Printers

iPrint Client Management Printer Configuration lets you designate printers to be downloaded and
installed automatically on user workstations when users log in to the network. These printers appear
in the user’s printers folder, ready for use. You can also use this feature to remove printers, assign a
printer to be the default printer, and set a printer to be a temporary printer so that it is removed when
the workstation is rebooted.

iCM configures printers on workstations based on assignments made on the User object, Group
object, Organization, and Organizational Unit container. When you use iManager to designate a
printer for automatic installation on a user's workstation, the associated eDirectory Container, Group,
or User object is updated with this information.

The actions taken are cumulative, meaning that action is taken for each assignment you made. For
example, if you add two printers at one level, then add three more printers at another level, the
workstation has all five printers installed. If you have more than one printer set as the default, the last
printer installed is set as the default.

When a user logs in, iCM starts searching at the highest container in the user’s full distinguished
name, looking for the iCM Printer Configuration associated to containers and groups. The search
continues through subcontainers down to the User object. Printers continue to be added or removed
to the workstation as specified by iCM. If the Allow Only Specified Printers to Reside on Workstation
option is enabled, any actions to printers specified above that container or group in the user’s fully
distinguished name are ignored, but any actions to printers specified between that point and the User
object are taken.

+ If the client finds a printer designated for installation that has not yet been installed, it is
automatically installed.

+ If a currently installed printer is added to the Printers to Remove list, that printer is automatically
uninstalled.
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+ If you designate a different printer to be the default, the change is made.

+ Using Do Not Update Workstations turns off iCM for printers at that container, group or user, but
actions for iCM printers found on other containers or groups are taken.

WARNING: Using iCM on group objects can simplify making assignments, but using iCM on multiple
groups can cause undesired results. You should create a new Group object with a descriptive name
so that you can control the desired results for users that you assign to that group.

To automatically install printers:

1 In iManager, click iPrint > iPrint Client Management.

2 Browse to and select the Organization, Organizational Unit, Group or User object you want to
automatically install printers for.

3 Configure the attributes you want for the Printer Configuration option.

Do Not Update Workstations: iCM for printers is disabled and printers are not installed or
removed from workstations. Printers already installed are not altered.

Allow Only Specified Printers to Reside on Workstations: Allow only the iPrint printers
specified in the Printers to Install list to reside on the workstation. All other iPrint printers on the
workstation are removed. Non-iPrint printers are not affected.

4 Use the buttons to modify the Printers to Install list.

If you select a printer to be the default and want to remove the Set as Default attribute, click the
button next to to the Default Printer field.

5 Modify the Printers to Remove list.
6 Click OK to save the changes.

Using Advanced Settings

The iPrint Client Management Advanced Settings page lets you configure how far up the eDirectory
tree iCM should look for iCM client settings and printers. You can also configure whether the iCM
results dialog box should display on the workstations, which is useful for troubleshooting the iCM
results.

1 IniManager, click iPrint > iPrint Client Management.

2 Browse to and select the Organization, Organizational Unit, Group or User object you want to
configure the settings on.

3 Click Advanced Settings.
4 Configure these settings as needed:

Ignore iPrint Client Management (iCM) settings on parent containers: Limits the scope
used to find iCM client settings and assigned printers to the object where the assignment is
made and below. You can enable this setting on User, Group, and Container objects. You should
enable this setting to limit traffic on the network, especially across slow network links.

When a user logs in, iCM checks the User object and group memberships, then it walks up the
eDirectory tree from the user object to the root-most container to determine where iCM
assignments have been made. If iCM encounters the Ignore Settings on Parent Containers
attribute, iCM stops walking up the tree on that object. Then, iCM implements the iCM client
settings and printers on the workstation.

To determine the iCM printers for the workstation, iCM searches down to the User object, adding
and removing iCM printers as specified on each Container, Group, or User object. For iCM client
settings, iCM uses the set of iCM client attributes closest to or on the User object.
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The attributes are delivered as a complete set, meaning that if you change only one attribute, all
of the attributes are set on the client. The changes are not additive, so you cannot change the
value of one attribute for an object and change the value of a different attribute on another
object. Only the set of attributes closest to or on the user’s object are used.

The following table describes the behaviors when enabling this setting on different objects.

Object Behavior

User Only the iCM client settings and printers assigned to the User object
are used. iCM does not check any group memberships, the User
object's container, or parent containers.

Group iCM checks assignments on the User object and all associated
groups, but does not check the User object's container or parent
containers. All group memberships are read and assignments are
considered even if this setting is enabled on just one group. This is
useful if you want to apply iCM client settings or assigned printers
from a group membership, but do not want any iCM client settings or
assigned printers from the User object's container.

IMPORTANT: Using iCM on Group objects can simplify making

assignments, but using iCM on multiple groups could cause undesired
results. You should create a new Group object with a descriptive name
so that you can control the desired results for users that you assign to

that group.
Organization or iCM checks assignments on the user object, all associated groups,
Organizational Unit and each container up to a parent container where this setting is
enabled.

Display iCM results in a dialog box on workstations: Displays a window on the workstation
that shows the printers that were installed and removed.

5 Click OK to save the changes.

iCM in OES Environment

Traditionally iCM was used in the following methods:

+ “iCM with Novell Client” on page 171
+ “iICM without Novell Client” on page 171

iCM with Novell Client

In OES iPrint, when a user logs in to the corporate eDirectory using the Novell Client, the iCM settings
are pushed to the user’'s machine.

iCM without Novell Client

In iPrint Appliance, users cannot login directly using the Novell Client. This is because iPrint
Appliance syncs only user names from the corporate eDirectory, but not the passwords. For iCM to
work with iPrint Appliance, you can use one of the following methods:

+ Novell Client users continue to login to the existing corporate eDirectory instead of iPrint
Appliance. This way, the existing OES server is used for desktop printing, and the iCM settings
are available only in the source eDirectory.
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Limitation: In this method, the iCM settings are fetched only from the source eDirectory. Any
iCM setting changes made on iPrint Appliance are not applied.

+ Use iCM without Novell Client. In this method, the local Windows/AD credentials must match the
eDirectory credentials. This method is suitable for an AD environment where users are synced
from AD to the local eDirectory so that the credentials are automatically matched. For more
information, see “ICM with iPrint Appliance” on page 172.

Limitation: In this method, the iCM setting are fetched only from iPrint Appliance. iCM setting
changes made on the existing corporate eDirectory must be manually added on iPrint Appliance.

iICM with iPrint Appliance

iPrint Appliance does not support traditional iCM with the Novell Client. iPrint Appliance supports iCM
using Windows Local/AD credentials.

Depending on your environment, you can deploy iCM in the following ways:

Apply iCM Settings from the Original Tree

In this configuration, iCM settings are applied from the original tree if iCM is not migrated from OES,
and OES iPrint is still used for desktop printing and iCM. You can use this configuration with or
without the Novell Client.

The limitation of using this configuration is that the iCM settings are fetched only from the source
eDirectory. Any iCM changes made locally on iPrint Appliance are not applied.

Apply iCM Settings from iPrint Appliance eDirectory

In this configuration, iPrint Appliance is used for desktop printing, and iCM settings are created on the
appliance only.

With Novell Client: With iPrint Appliance, users cannot login directly using the Novell Client because
iPrint Appliance syncs only user names from the corporate eDirectory, but not the passwords.
Therefore, iCM cannot be used with Novell Client. iCM can be used against the source eDirectory
server.

Without Novell Client: To fetch iCM settings from iPrint Appliance, you can use iCM without the
Novell Client. In order for iPrint clients to use the Windows Local/AD credentials for iCM, the following
conditions must be met:

+ You must set the iPrint Appliance address set as the primary PSM address on the client by using
the commandiprntcnd -S <i Print Appliance | P Address>.

+ The client’s Active Directory user name must match their iPrint Appliance credentials. If you
import users from Active Directory to iPrint Appliance, the credentials are automatically matched.

+ In order for iCM to work with imported users and groups, you must enable browse/read rights
and inheritance for iCM for the following attributes, using iManager:

¢ iPrintPrinterlPPURI

¢ iPrintiCMClientFlags

¢ iPrintiCMClientProxyURI
¢ iPrintiCMClientTrayURI
¢ iPrintiCMPrinterFlags

¢ iPrintiCMPrinterList
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¢ iPrintiCMTrustedSiteList
+ Group Membership

IMPORTANT: For the user accounts imported from OES, iCM settings are not migrated. You must
reassign the iCM settings on iPrint Appliance for the OES user accounts.

To configure the iCM attributes:

1
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On a Web browser, use either the host name or the IP Address to access iManager. For
example, https://10.0.0.1/nps or https://iprint.example.com/nps.

Specify admi n as the user name.

Specify the password, then click Login.

In the left pane, under Roles and Tasks, click Rights.

Click Modify Trustees.

Under Object name, click the search icon, then choose the entire tree.
Click OK.

Click the Assigned Rights link next to the Public domain.

Click the Add Property button in the upper right of the table.

In the Add Property pop-up window, select Show all properties in schema.
In the Property name box, select the attributes listed above, then click OK.
Select the Inherit check box next to the attributes you added.

Click Done.

For more information on using Windows Local/AD credentials for iCM, see the “Configuring iCM for
Windows / Active Directory (AD) environments without Novell Client” on page 168.

What’s Next

iPrint Appliance is now configured for printing through desktop and laptops. You can start printing to
iPrint printers.
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Installing and Setting Up iPrint on Client
Workstations

This section describes how to install iPrint Client and printers on your workstation. When a printer is
selected for installation, iPrint verifies if the iPrint Client is installed and then installs it if necessary. If
iPrint Client is already installed, the printer driver is downloaded and the printer is installed on your
workstation.

¢ “Installing iPrint Client” on page 175

+ “iPrint Portal: Installing Printers” on page 178

+ “iPrint Portal: QuickPrint” on page 179

+ “Windows: Installing Printers” on page 180

¢ “iPrint Client Tray Icon on Windows” on page 186

+ “Windows: Context Menu-based Desktop Printing” on page 188

+ “Macintosh: Installing Printers” on page 190

+ “MAC Workstations” on page 198

¢ “Updating the iPrint Client” on page 202

+ “Managing through iprint.ini” on page 202

+ “Windows Terminal Servers” on page 206

¢ “Uninstalling the iPrint Client” on page 207

Installing iPrint Client

iPrint Client must be installed on your workstation to install the printers. The client is located in the /
var/opt/novel | /i print/htdocs directory. You can distribute the client to user’s workstations in a
variety of ways:

+ “iPrint Portal” on page 175

+ “Welcome Page” on page 176

+ “IPP page” on page 177

+ “iPrint Map” on page 177

+ “Distribution Software” on page 177

iPrint Portal

To access iPrint Portal, specify https://<iprintappliance_IP or hostname>/print in the web browser. To
download iPrint client, click Download iPrint Client.
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Figure 12-1 iPrint Portal

@ Micro Focus iPrint Portal Login
Printers C Refresh
Clear All
Location: 5 norprinter12 [ & v
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Model: [Y] Install | = QuickPrint

Welcome Page

The welcome page includes clients for laptops and app store links for mobiles.

1 To launch the welcome page, specify the host name or IP address of the appliance server. For
example, http://iprint.example.com

Figure 12-2 iPrint Appliance Welcome Page

Step 1: Install iPrint Step 2: Choose a Printer Step 3: Print
iExint Mobile Apps Mobile Devices Mobile Devices
* Apple App Store (O3 From your mobile device, open the iPrint app and To print documents, pictures or files from an
* Google Play Store Android select your favorite printers. AirPrint enabled devices application on an AirPrint enabled device (i0S), click
- Windows Phone Store Windows Phone (108) will automatically find printers available on your the print button. If you are not using an AirPrint
+ Blackberry World Store Blackberry network. enabled device or the application does not support

AirPrint, simply tap the "Open in" button on your i0OS
device or tap "Share With" on your Android device.
Select the iPrint app to print.

Windows / Mac Desktops
iPrint Client for Windows

. If your administrator has configured the iPrint map,
+ Windows 8/8.1/10 32 Bit 64 Bit

follow the URL your administrator has provided. Windows + Mac Desktops
« Windows 7 32 Bit 64 Bit Otherwise, click here to go to the iPrint Printer
+ Windows Vista 32 Bit 84 Bit Installation Page Micro Focus iPrint is integrated with your print system
« Windows XP 32 Bit and will allow you to print directly from any application

by selecting Print.
iPrint Client for Mac

+ Mac OSX 10.8 and later
+ Mac OSX 10.7
+ Mac OSX 10.6 and earlier

2 Depending on your operating system, download the client and install it on your workstation. On
installing the client, you can proceed to install the printers.

For example, on Mac ai pri nt. dny file is downloaded. Double-click the file to extract the . pkg
file and launch the iPrint Client install.
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IPP page

To launch iPrint Installation page, access the iPrint server URL http://server_IP_ address or
host_name/ipp in the web browser.

Figure 12-3 iPrint Printer Installation

@ Micro Focus. iPrint

Instal Prie Chant

J COLOR_PRINTER

] EXAMPLE_ PRUNTER
S DuameLe_paseR
jogh EXAMPLE_PRINTERZ

& privter

Ind Floor HP PRINTER

13t Floor KERDX PRINTER

15t Floor XEROX PRINTER

Tosting

e o ¢ of

Click Install iPrint Client to download and install the client. After installing the client, restart the web
browser and select the printer for installation.

iPrint Map

The iPrint map shows the location and details of every printer in the company (both local and global).
From desktops or laptops, you can choose printers on a map using a web browser. If the iPrint client
is not available, it will prompt to download and install the iPrint client. After installing the client, restart
the web browser and select the printer for installation.

Distribution Software

The Windows iPrint Client is packaged in several different, specialized installations. Depending on
your distribution method or need, select the file you want. The following table compares the different

types of installations.

Table 12-1 iPrint Clients for Windows

iPrint Client Filename

Description

ni pp. exe

ni pp. zip

ni pp-s. exe

ni pp- su. exe

Installs the iPrint Client and displays dialog boxes and progress windows
that require user intervention.

This is the default installation program.

A WinZip version of the client that can be used with distribution software
programs. After the file is unzipped, run set upi pp. exe. For a list of the
command line parameters that you can use with set upi pp. exe, enter
set upi pp. exe / h ata command prompt.

Installs the iPrint Client. A screen displays the progress of the
installation, but requires no user intervention.

Uninstalls the iPrint Client. A screen displays the progress of the
uninstall, but requires no user intervention.
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iPrint Portal: Installing Printers

A new printer portal with intuitive GUI that includes QuickPrint functionality, search and quick access
(bookmark) to printers based on filters.

To access iPrint Portal, specify https://<iprintappliance_IP or hostname>/print

Installing a Printer: To install a printer, hover the cursor on the printer and click |_£| . You can also
expand a printer to view the printer properties and then click Install. The installation of secure and
WalkUp printers is controlled through ACLs that are set for that user.

Figure 12-4 iPrint Portal Printer Installation

Printers & Refresh
£ Printer10  [1] Install v
EP Printer1 ~

Color Z Yes

| [1] Install | | & QuickPrint |

Quick Access (bookmark) Printers: Printers can now be filtered on location, type, and model. You
can also filter with the Search field, just type description or any such printer details. The browser url
can be bookmarked and shared.

Figure 12-5 Filter Printers

Clear All

Location:
Show All v

Type:
Show All v

Model:
Show All v

Tags:
Show All v

Search:

¥ Download iPrint Client
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iPrint Portal: QuickPrint

QuickPrint is printing documents via a Web browser. iPrint service renders and coverts the document
into a print-ready format using the renderer, hence, no drivers are required to be associated with the
printer.

Using any web browser, the user selects a printer and document, then prints. The QuickPrint feature
is controlled through ACLs set for that user.

To print using web browser, do the following:

1 Launch the iPrint Portal (https://<iprintappliance_IP or hostname>/print).

2 Expand a printer and click QuickPrint or select the QuickPrint icon next to a printer.

Figure 12-6 Expand Printer to View QuickPrint

@ Micro Focus iPrint Portal

Printers C Refresn
Clear All
Location: 5 LexmarkBW ~
Show All v
Location : 8thfloorlab
Type: Description : Lexmark BW
Show All L6
Color : Yes
Model: | 0 Install || & QuickPrint
Show All

Figure 12-7 QuickPrint Adjacent to a Printer

@ Micro Focus iPrint Portal

Printers
Clear All
Location: 5 LexmarkBW [1] & ~  QuickPrint
Show All v '
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3 Select a file, modify the printer options and click Print.

@ Micro Focus iPrint Portal Login
= LexmarkBW

Drag and Drop to print the file:

Choose File |screen_1.png

Copies:
K

Page Size
l Ad v

Page Range
SAl eg:2-5

Page Crientation
l PORTRAIT v

) Two Sided

) Color

| = Print | X Close

Windows: Installing Printers

When installing a printer if the iPrint Client is not installed, you will be prompted for installation. You
can install the printers in a variety of ways:

+ “IPP Page” on page 180

¢ “Command Line (iprntcmd)” on page 184

+ “iPrint Map” on page 186

+ “iPrint Client Management Utility on Windows” on page 186

IPP Page

You can install the iPrint printers using the following browsers:

+ “On Microsoft Internet Explorer” on page 180
+ “On Mozilla Firefox” on page 182
+ “On Google Chrome” on page 183

On Microsoft Internet Explorer

1 Launch the browser, and use the host name or IP address to access the web page.
For example, http://server_IP_ address_or_dns_name/ipp.
All the available printers are listed.
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@ Micro Focus:iPrint Installation

Install iPrint Client

Instructions

Click on the printer that you want to install. In the "Internet Explorer Security” warming message, click "Allow" to
proceed with the installation of the printer. To avoid prompts of security warning messages, select the "Do not
show me the warning for this program again” check box.

e | Printer Location L

E secure 8th floor Ram’s place [i]
E secure1_changed 8th floor Ram’s place [ ]
E test_print bangalore 0
walkup_test (WalkUp) (i ]
2 Click on the printer that you want to install.
Depending on the version of the Internet Explorer, you are prompted with a security warning
message, click Allow.
r il
Internet Explorer u
‘e /#» Do you want to allow this website to open a program on your
[fw computer?
From: 192.168.222 66
Program: Micro Focus iPrint Printer Installation Utility
Address: iprint;/a%20ipp://blrg-119-
195.labs.blr.novell.com/ipp/test_print
[] Always ask before opening this type of address
Allow ] I Cancel
e Allowing web contentto open a program can be useful, but it can
g potentially harm your computer. Do not allow it unless you trust the
source ofthe content What's the nsk?
The Internet Explorer security warning message dialog box is displayed.
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Internet Explorer Security M

A website wants to open web content using
this program on your computer

This program will open outside of Protected mode. Internet Explorer's
Protected mode helps protect your computer. If you do not trust this
website, do not open this program.

IEI Name: Micro Focus iPrint Printer Installation Ut...
Publisher:  Nowell, Inc.

[ Do not show me the warning for this program again

Allows ] [ Don't allow

3 Click Allow to proceed with the installation of the printer.

4 (Optional) To avoid future prompts to launch the iPrint applications, select the Do not show me
the warning for this program again check box.

On Moazilla Firefox

1 Launch the browser, and use either the host name or the IP address to access the web page.
For example, http://server_IP_ address_or_dns_name/ipp.
All the available printers are listed.

@ Micro Focus:iPrint Installation

Install iPrint Client

Instructions

Click on the printer that you want to install. In the "Launch Application” dialog box, click
"OK" to proceed with the installation of the printer. To aveid prompts to launch the iPrint
applications, select the "Remember my choice for iPrint links" check box.

[ sallpriver | primerbocatn | Descripton | fo_
% secure 8th floor Ram'’s place o
% securei_changed 8th floor Ram’s place o
E test_print bangalore 0
walkup_test (WalkUp) o

2 Click on the printer that you want to install.
The Launch Application dialog box is displayed.
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& — —— — |
Launch Application o 0 M

This link needs to be opened with an application.

Send to:

Micro Focus iPrint Printer Installation Utility

Choose an Application Choose...

"] Remember my choice for iprint links.

oK l l Cancel l

3 Select Micro Focus iPrint Printer Installation Utility in the Launch Application dialog box, then
click OK to proceed with the installation of the printer.

4 (Optional) To avoid future prompts to launch the iPrint applications, select Remember my choice
for iPrint links check box.

On Google Chrome

1 Launch the browser, and use either the host name or the IP address to access the web page.
For example, http://server_IP_ address_or_dns_name/ipp.
All the available printers are listed.

@ Micro Focus.iPrint Installation

Install iPrint Client

Instructions

Click on the printer that you want to install. In the "External Protocol Request” dialog box, click "Launch
Application” to proceed with the installation of the printer. To avoid prompts for external protocols, select the
"Remember my choice for all links of this type" check box.

st Prinr v T ] ]
E secure 8th floor Ram's place [i ]
E securel_changed 8th floor Ram's place [i ]
E test_print bangalore i ]
walkup_test (WalkUp) [}

2 Click on the printer that you want to install.

The External Protocol Request dialog box is displayed.
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Open URL:iPrint Protocol?

Remember my choice for URL:iPrint Protocol links

Open URL:iPrint Protocol Don't open

3 Click Open URL:iPrint Protocol on the Open URL:iPrint Protocol dialog box to proceed with the
installation of the printer.

4 (Optional) To avoid future prompts to launch external protocol links, select the Remember my
choice for URL:iPrint Protocol links check box.

Command Line (iprntcmd)

i prntcnd. exe is a DOS command line utility that lets you install or remove iPrint printers without a
web browser and capture LPT ports to iPrint printers. This command is useful when you have legacy
applications that require output to an LPT port or when you want to add printers through a login script.

Use the following parameters when executing the i pr nt cmd command.

Table 12-2 Parameters Used with i prnt cnd

Parameters Description

-a | --addprinter options printer_uri Installs the specified printer. You can replace
options with any or all of the following:

* no-gui: Does not display the printer
installation dialog box when installing a
printer.

+ default: Installs the specified printer as the
default printer.

¢ temp: The installed printer is removed when
the workstation is rebooted.

NOTE: These options are available only in the
Windows Client.

-d | --delprinter printer_uri Removes the specified printer.

-f | --fetchdriverlocal printer_uri Pulls drivers from the server and stores them in
the local cache directory, such as the
c:\ndsp\drvr_cache directory.

-g | --getdefault Displays the default printer installed on the
workstation.

-h | --help Displays help for the command.

-j | --listjobs printer_uri Lists the print jobs for the specified printer that

are on the server in a pending or printing state.

-1 | --listlocalprinters Lists printers installed on the workstation.
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Parameters

Description

-L | --listprintersonserver psm-hostname or psm-
address

Lists iPrint printers on the specified Print
Manager where psm-hostname or psm-address
can be a host name or IP address.

-p | --printfile printer-uri file path

Sends a printer-ready file to the specified iPrint
printer.

This option is used to test the print path (job flow)
from the client workstation to the server and
subsequently to the printer. This requires a print-
ready file as an input. The printer or the driver
does not need to be installed on the client
workstation.

-P | --ppdlist

Lists the PPDs installed on this workstation.

-s | --setdefault printer_uri

Sets the specified printer as the default.

-t | --testpage printer_uri

Prints a test page to the specified printer.

-v | --version server_uri server_user

Displays the server platform and version
information, where server_uri is the URI for the
server and server_user is a valid user for the
server.

-U | --uploaddriver [osx] <ids-IPaddress> or <ids-
hostname> <username> <password> [INF-Filepath
<model-name>] | [driver-Filepath]

Uploads Windows drivers or Mac divers. For
Windows drivers, specify the (INF-Filepath) path
of the Windows driver. For Mac drivers, specify
the [OSX] option and [driver-Filepath] path of the
Mac driver file (PPD or PDE).

-w| --trustedwebsiteforlnternet Expl orer
printer_installation_page_uri

Adds the specified URI of the printer installation
page to the trusted site list for Internet Explorer.

The trusted site list allows users to view and add
the printers directly from the printer IPP site or
printer map page, without running the Internet
Explorer browser with administrator privileges on
Windows Vista.

For example, http://printing.my_company.com/
ipp.

-C

Clears the password from the cache.

Use quotes around printer-uri if it contains spaces.

Syntax

i prntcnd paraneters

Example

To install a printer named ColorPrinter1 and set it as the default printer, you would enter the following

command:
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iprntcmd -a -s ipp://printing.ny_conpany.coniipp/ColorPrinterl

iPrint Map

The iPrint map shows the location and details of every printer in the company (both local and global).
From desktops or laptops, you can choose printers on a map using a web browser. If iPrint client is
not available, it will prompt to download and install the iPrint client. After installing the client, restart
the web browser and select the printer for installation.

iPrint Client Management Utility on Windows

You use the iPrint Client Management utility to share your Windows or Active Directory login
credentials with the iPrint Client. You can configure the iPrint Client Management (iCM) PSM address
by using the iPrint Client tray icon. To view the iPrint Client tray icon’s iCM tab, enteri prnt cf g i cmat
the command line. Then, enter the PSM address (IP/DNS) in the iPrint Client tray icon’s iCM tab and
the system will use the DSServer (Directory Service Server) configuration of the PSM server to obtain
the details of your iCM profile. If the PSMServer is not set, you can still specify the DSServer by
populating the registry entry directly.

You can also set the address of the PSM server by using the i prntcnd - S <I P/ DNS> command, in
combination with a remote-policy pushing engine like ZENworks.

iPrint Client Tray Icon on Windows

On Windows workstations, the iPrint Client adds an icon to the notification area. The iPrint icon
displays notification when a job is printed and allows you to access the iPrint Client settings. Right-
clicking the icon displays the following menu options:

iPrint Settings: Opens the iPrint Client Settings page.
Document Status: Displays the status and other information for the last 10 documents printed.

Refresh iCM: Displays the iCM configuration settings. If the administrator has modified the iCM
settings, then clicking this button immediately applies the setting for the user.

Launch Printer Folder: Opens the Windows printer folder.

Find/Install Printers: (Optional) Opens a browser window to the Menu Link URL specified on the
Tray Icon tab.

Close: Removes the iPrint icon from the notification area until the next reboot. To make the icon
reappear in your notification area, click Start > Programs > Novell iPrint > iPrint Client Settings >
Tray Icon and deselect the Enable the iPrint icon in the system tray. Click OK. Then repeat the
process to enable the icon.

To permanently remove the icon, see “Tray Icon” on page 187.

Configuring the iPrint Client Settings

+ “Proxy Server” on page 187

+ “Passwords for Remote iPrint Servers” on page 187
+ “Tray Icon” on page 187

+ “Print Job Notifications” on page 188
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Proxy Server

A proxy server is located between a client and another server that the client is trying to communicate
with. Often proxy servers are used in conjunction with a firewall to keep internal addresses private
while exposing only the proxy server’s address to external users. If you have users that need to
submit print jobs through a proxy server, you can use the iPrint Clients Proxy setting. The Client
sends all print-related requests, such as a print job, to the proxy server. The proxy server then
redirects the print job to the correct iPrint server.

For example, Juan is a laptop user who has installed and printed to a variety of iPrint printers at the
company’s headquarters. While on the road, Juan wants to submit a report to his manager. Rather
than sending the report by e-mail or fax, Juan decides to send it to the printer near his manager’s
office. When Juan tries to send the report to the printer, he receives an error that the printer cannot be
found. He knows that the company uses a firewall and a proxy server. He types the proxy server
address in the iPrint Proxy settings, then tries to print the report again. This time the print job is
accepted. The print job travels from his laptop to the proxy server. The proxy server redirects the print
job to the printer’s Print Manager, where the print job is spooled and forwarded to the printer.

To set the proxy server address for iPrint in iManager:

1 Click Start > Programs > Novell iPrint > iPrint Client Settings > Proxy.

2 To use a proxy server, select the check box, then specify the URL for the proxy server.
To disable using a proxy server, deselect the check box.

3 Click OK.

Passwords for Remote iPrint Servers

You can manage passwords for print services that you indicated should be remembered by your
workstation. The ability to delete passwords is useful if you are connected to a print service that you
no longer use.

To manage passwords for print services in iManager:

1 Click Start > Programs > Novell iPrint > iPrint Settings > Passwords.

2 Select the password you want to remove, then click Clear Password.

Tray Icon

The iPrint icon in the notification area lets you receive notification when a job has printed, and lets you
view a list of print jobs that you have submitted.

1 Click Start > Programs > Novell iPrint > iPrint Settings > Tray Icon.

2 Select the check box to enable the iPrint icon in the system tray.

3 In the Menu link URL, specify the URL to install the printers.

This provides a new option Find/Install printers when you right-click the printer icon in the
system tray.
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Print Job Notifications

iPrint can notify you through a pop-up message in the notification area when your document has
printed or needs attention.
1 Click Start > Programs > Novell iPrint > iPrint Settings > Notifications.

2 Select the check box to enable the job notification.

Windows: Context Menu-based Desktop Printing

iPrint option is now available as a context menu on Windows. This feature is only available with iPrint
Appliance server 3.0 and later.

To print from the context menu, do the following:
1 Install the iPrint client. For more information, see “Installing iPrint Client” on page 175. On
successful installation an iPrint option is available when you right-click a file.
2 Right-click on a file or files, then select iPrint, an iPrint dialog is displayed.

You can print without opening a document. For example, if you received a document in an email,
and no application is available to view it, you can still print with the context menu option.

iprint.docx 9/7/2017 2:44 PM Micre
Open
MNew
Print
7-Zip »
& iPrint

Scan for Viruses...

Create shortcut
Delete
Rename

Properties

3 Click Select a printer.

3a The recently used printers are populated in the drop-down menu of Printer. Select a
previously used printer or Click Choose printer to select a different printer.

3b Specify an iPrint server and click Find.
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Select Printer

Server:
192.168.3.4

Printer Name

S printer 1
¥2 walkUp_Printer
& Printer 2

Location

8th floor
7th floor
8th floor

- { Find

Description

Xerox
Secure
Email-enabled

o ] ‘

For secure or a WalkUp printer, you must login to the server. On logging in, printers are

displayed through ACLs set for that user. You can login using only the username or in a
LDAP format (comma separated).

4 Click Print. The documents are successfully printed.

. Micro Focus iPrint

Document

B auditods
o iprint_test bt

B new.odl

Printer

o ficch on bir8-12-128.di
E Status: Ready

Options

Copies:

[[] Both Sided
[ Coler Print

1 draw.odg
] ipnntapp3_bet

2 newl xisx

gitalaidines. com

#® iprint_audit pptx

¥ iPrint_feature &
7 iprintapp3_live

| ipnntapp3_tes.

Paper Size: LETTER

Orientation: Portrait

Print Close

The Options displayed are set in the Mobile > Global Settings page of the Management
Console. The values can be changed as per your printing requirements.
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NOTE: If some file formats are not supported for printing, the file will not be listed for printing.

The info icon lists the unsupported files.
To see the list of supported file formats, see TID 7022058.

Macintosh: Installing Printers

When installing a printer if the iPrint Client is not installed, you will be prompted for installation. You
can install the printers in a variety of ways:

+ “IPP Page” on page 190
+ “Command Line (iprntcmd)” on page 196
+ “iPrint Map” on page 197

IPP Page

You can install the iPrint printers using the following browsers:

+ “On Microsoft Internet Explorer” on page 180
¢ “On Mozilla Firefox” on page 182
+ “On Google Chrome” on page 183

On Safari

1 Launch the browser, and use either the host name or the IP address to access the iPrint Printer
List page.

For example, http://server_IP_ address_or_dns_name/ipp.
All the available printers are listed on the iPrint Printer List web page.

@ Micro Focus.iPrint installation

Install iFrint Chan

Instruction:
Click on the printer name you would like to instail

=) COLOR_PRINTER Znd Floar HP PRINTER

Li]
S} ExXAMPLE_PRINTERS 132 Floor XEROX PRINTER o
E EXAMPLE_PRINTERZ 8t Floor XEROX FRINTER 0
5} Printer Testing (1]

2 Click on the printer that you want to install.
The iPrint Printer Installation dialog box is displayed.
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https://www.novell.com/support/kb/doc.php?id=7022058

@O iPrint Printer installation

Printer DirectRAW

Location Mear to me

Description

Driver HP LaserJet 500 color MFP M570

9 The printer is not installed. Do you want to install it?

3 Click Install to proceed with the installation of the printer.

3a If you are installing a secure printer, the iPrint Printer Installation dialog box prompts for user

credentials.

iPrint Printer installation

Credentials for printing.my_company.com

Realm Name IPRINT

| iprint]

| Save Password

Cancel

Cancel Install

3b Specify user credentials.
3c (Optional) To avoid future prompts, select Save Password check box.
3d Click OK after you have specified your credentials.

4 Click OK when the printer installation is complete.
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On Mozilla Firefox
1 Launch the browser, and use either the host name or the IP address to access the iPrint Printer
List page.
For example, http://server_IP_ address_or_dns_name/ipp.

All the available printers are listed on the iPrint Printer List web page.

@ Micro Focus.iPrint Installation
sl it Clant

Instructions
Click on the printer that you want to install. in the "Launch Application” dialog box, click “OK” to proceed with the installation of the printer. To
avoid prompts to launch the iPrint applications, select the "Remember my choice for iPrint Links™ check box,

[ miPrer ] Prmerloaaton | Deapton | inbo]
E COLOR_PRINTER 2né Floar HF PRINTER (i ]
|k EXAMPLE_PRINTERY 31 Floor XERON PRINTER L]
(R ExaweLe_punTER 131 Floor AEROX, PRINTER [i]
R Printer Testing L]

2 Click on the printer that you want to install.
The Launch Application dialog box is displayed.

@® @ Launch Application

This link needs to be openad with an application.
Send to:

Movell iPrint Printer Installation Utility

Choose an Application Choose...

| Remember my choice for iprint links.

3 Select Novell iPrint Printer Installation Utility in the Launch Application dialog box, then click
OK to proceed with the installation of the printer.

4 (Optional) To avoid future prompts to launch the iPrint applications, select Remember my choice
for iPrint links check box.

The iPrint Printer Installation dialog box is displayed.
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@O iPrint Printer installation

Printer DirectRAW

Location Mear to me

Description

Driver HP LaserJet 500 color MFP M570

9 The printer is not installed. Do you want to install it?

5 Click Install to proceed with the installation of the printer.

5a If you are installing a secure printer, the iPrint Printer Installation dialog box prompts for user
credentials.

iPrint Printer installation

Credentials for printing.my_company.com

Realm Mame IPRINT

| iprint]

| Save Password

Cancel

Cancel Install

5b Specify user credentials.
5¢ (Optional) To avoid future prompts, select Save Password check box.

5d Click OK after you have specified your user credentials, then click OK to proceed with the
installation of the printer.

6 Click OK when the printer installation is complete.
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On Google Chrome

1 Launch the browser, and use either the host name or the IP address to access the iPrint Printer
List page.

For example, http://server_IP_ address_or_dns_name/ipp.
All the available printers are listed on the iPrint Printer List web page.

@ Micro Focus. iPrint Installation

Instaf #Ernt Chent
Instructions
Click on the printer that you want to install. In the "External Protocol Request” dialog box, click “Launch Application” to proceed with the
installation of the printer. To avoid prompts for external protocols, select the "Remember my choice for all links of this type” check bax.,
infa|
f COLOR_PRNTER 2nd Floar HP PRINTER ]
J) EXAMPLE_PRINTER1 13t Floar HERGK PRINTER L
E EXAMPLE_PRINTERZ 15t Fioar AERDY FRINTER 0o
=) Priver Testing (i ]

2 Click on the printer that you want to install.
The External Protocol Request dialog box is displayed.

External Protocol Reguest

‘ Google Chrome needs to launch an external
application to handle iprint: links. The link reqguested iz
iprint:ffeerver_IP_ address_or_dns_name/ipp/
COLOR_PRINTER

The following application will be launched if you accept
this reguest:

iPrint Printer Installer

If you did not initiate this request, it may represent an
attempted attack on your system. Unless vou took an
explicit action to initiate this request, you should press
Do Mething.

Remember my choice for all links of this type.

Do Nothing Launch Application

3 Click Launch Application on the External Protocol Request dialog box to proceed with the
installation of the printer.

4 (Optional) To avoid future prompts to launch external protocol links, select the Remember my
choice for all links of this type check box.

The iPrint Printer Installation dialog box is displayed.
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@O iPrint Printer installation

Printer DirectRAW

Location Mear to me

Description

Driver HP LaserJet 500 color MFP M570

9 The printer is not installed. Do you want to install it?

5 Click Install to proceed with the installation of the printer.

5a If you are installing a secure printer, the iPrint Printer Installation dialog box prompts for user
credentials.

iPrint Printer installation

Credentials for printing.my_company.com

Realm Mame IPRINT

| iprint]

| Save Password

Cancel

Cancel Install

5b Specify user credentials.
5¢ (Optional) To avoid future prompts, select Save Password check box.

5d Click OK after you have specified your user credentials, then click OK to proceed with the
installation of the printer.
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During the printer installation, iPrint downloads and installs the printer driver, if one is associated with
the printer, and installs the printer on the user’s workstation. The first time a printer is installed, printer
drivers are forced to the workstation, even if the workstation contains a newer driver. Print Managers
refresh their saved copies of printer drivers for the printers they are hosting with updated printer
drivers from the associated Driver Store.

Command Line (iprntcmd)

The Macintosh iPrint Clients include the iprntcmd utility that performs the same functions as iprntcmd
in the Windows iPrint Client. In addition, you can use iprntcmd to upload PPD drivers to a Driver Store

from the iPrint Client. iprntcmd is located in / usr/ bi n on Macintosh.

Use the following parameters when executing the i pr nt cnd command:

Table 12-3 Parameters Used with iprntcmd

Parameters

Description

-T | --tray-icon

-r | --run-listener

-a or --addprinter <printer_uri>
-d or --delprinter <printer_uri>

-d or --delprinter all

-d or --delprinter all --force

-g or --getdefault

-h or --help

-j or --listjobs <printer_uri>

-l or --listprinters

-L or --listprintersonserver <psm-hostname or psm-
address>

-p or --printfile <printer-uri filepath>

-P or --ppdlist
-s or --setdefault <printer_uri>

-t or --testpage <printer_uri>

Displays an iPrint icon to the notification area and
starts the i print-1i stener-gui process, ifitis
not running.

Launchesthei print-1i st ener processifitis not
already running.

Installs the specified printer.
Removes the specified printer.

Removes all printers. This option requires your
confirmation before removing all the printers.

Remove all the printers. This option removes all the
printers forcibly without any user intervention.

Displays the default printer installed on the
workstation.

Displays help for the command.

Lists the print jobs for the specified printer that are
on the server in a pending or printing state.

Lists printers installed on the workstation.

Lists iPrint printers on the specified Print Manager
where psm-hostname or psm-address can be a
host name or IP address.

Sends a printer-ready file to the specified iPrint
printer.

Lists the PPDs installed on this workstation.
Sets the specified printer as the default.

Prints a test page to the specified printer.

Installing and Setting Up iPrint on Client Workstations



Parameters Description

-u or --uploadids <ids_uri> <ppd with/without a Uploads the specified PPD files to the indicated

wildcard> Driver Store where ids_uri is the IP address or host
name for the Driver Store, and ppd is the directory
path and filename to the PPD files. You can use a
wildcard in the PPD filename.

-U or --uploadbroker <rms_uri> <rms_name> <ppd Uploads the specified PPD files to the indicated

with/without a wildcard> Broker where rms_uri is the IP address or host
name for the Broker’'s associated Print Manager,
rms_name is the username with rights to add
drivers to the broker, and ppd is the directory path
and filename to the PPD files. You can use a
wildcard in the PPD filename.

-U | --uploaddriver [osx] <ids_uri> <username> Uploads the specified PPD files to the indicated
<password> [INF-Filepath <model-name>] | [driver- Driver Store where ids_uri is the IP address or host
Filepath] name for the Driver Store, and INF-Filepath is the

path of the driver package, and driver-Filepath is
the path of the printer driver file.

-v or --version <psm-hostname or psm-address> Displays the server platform and version
information where server_uri is the URI for the
server.

-i or —-info <printer-uri> Displays the printer information.

Syntax
i prntcnd options paraneters

You must use quotes around parameter information that contains a space, such as printer names and
printer drivers.

Example

To install a printer named Color Printer 1 and set it as the default printer, enter the following:
iprntcmd -a "ipp://printing.ny_conpany.coniipp/Color Printer 1"

iprntcmd --setdefault "ipp://printing.ny_Conpany.coniipp/Color Printer 1"
For uploading PPD files from Mac clients, enter the following:

iprntcmd -u <ids-hostnane or ids-address> <ppd path with/w thout wld cards>
When prompted for a username, examples of two acceptable formats are:

adm n or cn=adm n, 0=O gNane

For more examples, use the man i prnt cmd command on your server console.

iPrint Map

The iPrint map shows the location and details of every printer in the company (both local and global).
From desktops or laptops, you can choose printers on a map using a web browser. If iPrint client is
not available, it will prompt to download and install the iPrint client. After installing the client, restart
the web browser and select the printer for installation.
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MAC Workstations

+ “Automatic Update Notification” on page 198

+ “iPrint Client Tray Icon on Mac” on page 198

Automatic Update Notification

When a workstation boots up, iPrint checks the default printer to ensure that the workstation is using
the latest iPrint Client. If necessary, a notification is launched to update the newer client.

; e Later
=" Micro Focus iPrint

H=] - .
= Client Update Available
Update

On clicking Update, the client is downloaded and the installer is launched to update the client. The
user can click Later five times after which the iPrint Client is forcefully downloaded on the workstation
and client installer is launched.

If the notifications are disabled on the client workstations, then the user can click the Check for
Updates option from the tray menu.

Job Status
Message Board
Configuration
Find/Install Printers
About

Check for Updates

Hide Tray lcon

iPrint Client Tray Icon on Mac

On Macintosh workstations, the iPrint Client adds an icon to the notification area. The iPrint icon lets
you receive notification when a job has printed and access iPrint client settings quickly. If the iPrint
icon does not appear in your notification area, run the command i prnt cnd - T command from your
terminal.

Left-clicking the iPrint icon displays the following menu options:

+ “Printers” on page 199

+ “Job Status” on page 199

+ “Message Board” on page 199

+ “Configuration” on page 199

+ “About” on page 201

+ “Find/Install Printers” on page 201
+ “Hide Tray Icon” on page 201
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Printers

Displays the iPrint printer list, printer status, location of the printer, driver associated with the printer,

and the description for the reason of printer status. You can also uninstall your printers from here.
To uninstall a printer:

1. Left-click the iPrint icon, then click Printers.
2. Select the printer that you want to uninstall.

Press Shift to select more than one printer.
3. Click Uninstall to uninstall the printer.

or

Click Uninstall All to uninstall all the printers.

Job Status

Displays the name of the job, the status of the job, the size of the job, and the name and locationof

the printer for the job. This option also allows you to clear the job information from the job status tab.

To clear job information:

1. Left-click the iPrint icon, then click Job Status.
2. Select the job that you want to clear.

Press Shift to select more than one job.
3. Click Clear to remove the job information.

or

Click Clear All to remove all the job information.

Message Board

The message board stores all the information related to the status of the printers, the jobs issued,
automatic removal of printer from the client, automatic redirection of printer, and automatic driver
updates.

To remove the data from the message board:

1. Left-click the iPrint icon, then click Message Board.
2. Click Clear to remove the data from the message board.

Configuration

You can configure the following iPrint settings:
+ “Managing Notifications” on page 200
+ “Using a Menu Link URL” on page 200
+ “Using a Proxy Server” on page 200
+ “Uninstalling an iPrint Printer When You Uninstall the iPrint Client” on page 200
+ “Setting the Trace Level” on page 201
+ “Keeping Driver Files on Upload or Download” on page 201
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Managing Notifications
iPrint notifies when your document has printed or your iPrint client needs attention.
To turn the iPrint notification on:

1. Left-click the iPrint icon, then click Configuration.
2. Select Notify when jobs get printed or need attention.

3. Click Save to save the settings.

Using a Menu Link URL

A menu link URL points you to the iPrint printer list or a customized printer installation page. You can
find and install your printer from that page.

To specify the menu link URL:

1. Left-click the iPrint icon, then click Configuration.
2. Specify the menu link URL in the Menu link URL field.
3. Click Save to save the settings.

Using a Proxy Server

A proxy server is located between a client and another server that the client is trying to communicate
with. Proxy servers are often used in conjunction with a firewall to keep internal addresses private by
exposing only the proxy server’s address to external users. If you have users that need to submit print
jobs through a proxy server, you can use the iPrint Clients Proxy setting. The Client sends all print-
related requests to the proxy server. The proxy server then redirects the print job to the correct iPrint
server.

For example, Juan is a laptop user who has installed and printed to a variety of iPrint printers at the
company’s headquarters. While he is on the road, Juan wants to submit a report to his boss. Rather
than sending the report by e-mail or fax, Juan decides to send it to the printer near his boss. When he
tries to send the report to the printer, he receives an error that the printer cannot be found. He knows
that the company uses a firewall and a proxy server. He types the proxy server address in the iPrint
Proxy settings, then tries to print the report again. This time the print job is accepted. The print job
travels from his laptop to the proxy server. The proxy server redirects the print job to the printer’s Print
Manager, where the print job is spooled and forwarded to the printer.

To set the proxy server address:

1. Left-click the iPrint icon, then click Configuration.
2. Specify the URL in the Proxy URL field.
3. Click Save to save the settings.

NOTE: If you do not want to use the proxy server, delete the URL specified in the Proxy URL
field and save the settings.

Uninstalling an iPrint Printer When You Uninstall the iPrint Client

1. Left-click the iPrint icon, then click Configuration.
2. Select Uninstall iPrint Printers on iPrint client uninstallation.

3. Click Save to save the settings.
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Setting the Trace Level
The trace level determines how much debugging information is displayed.
To set the trace level:

1. Left-click the iPrint icon, then click Configuration.
2. Select one of the following options:
Off: No error tracing.
Shell: Debug output is displayed on the shell where the application started.

File: Debug output is sent to / home/ <user >/ . i print/trace. t xt >. If the user's home directory
cannot be determined, the debug output is sent to/ var/opt/novel | /1 og/iprint/client/
<pi d>-<ui d>_trace. t xt.

All: Debug output is sent to both the shell and the file.

3. Click Save to save the settings.

Keeping Driver Files on Upload or Download

This option allows you to store your driver files in the temporary folder when you upload or download
the drivers for printer installation.

1. Left-click the iPrint icon, then click Configuration.

2. Select Keep driver files on upload or download.

3. Click Save to save the settings.

When you upload driversfor printer installation, temporary files are stored at/t np/i pri nt -
<user nanme>/ t np- xxxxxx. This file is removed after upload, if the Keep driver files on upload or
download option is not selected.

When you download drivers for printer installation, temporary files are stored at /t np/ i pri nt -
<user nanme>/ t mp- xxxxxx/ downl oad- xxxxxx. This file is removed after download, if the Keep
driver files on upload or download option is not selected.

About

Displays the version of the iPrint Client installed on your workstation.

Find/Install Printers

Opens a browser window to the menu link URL specified in the Configuration tab of the tray icon. The
menu link URL points you to the iPrint printer list or a customized printer installation page.

You can find and install your printers from there.

Hide Tray Icon
Removes the iPrint icon from the notification area until the i print-1i st ener-gui process is

restarted. To make the icon reappear in your notification area, run the i prnt cnd - T command from
your terminal.
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Updating the iPrint Client

Periodically, users need updates to the iPrint Client. You need to decide how to manage this. If you
want iPrint to automatically update the clients, see “Automatically Updating the iPrint Client” on
page 202, or you can choose to distribute a newer client through a software distribution package.

You are allowed five times to reject the iPrint Client update. After that the iPrint Client is forcefully
updated on your workstation.

Managing through iprint.ini

A configuration file named i print.i ni is located on each server where a Print Manager is running.
Theiprint.ini file should be synchronized across all servers where iPrint and a Print Manager are
running. The i print.ini file is located on the iPrint appliance at/ var/ opt/ novel | /i print/

ht docs/ .

The file controls the following tasks only on a Windows OS:

+ “Automatically Updating the iPrint Client” on page 202
+ “Creating a Short Printer Name Profile” on page 203

¢ “User Printers” on page 203

IMPORTANT: When you apply a support pack, the existing i pri nt.ini file is saved asi pri nt. bak
and anewiprint.ini isadded. If you made changes to thei print.ini file, you must delete the
newiprint.ini file from the support pack and rename i print. bak toi print.ini. If you want the
new functionality that is included with the latest i pri nt . i ni , you should re-create the settings in

i print.bakinthenewiprint.ini.

Automatically Updating the iPrint Client

When a workstation boots up, iPrint checks the default printer to ensure that the workstation is using
the latest Novell iPrint Client. If necessary, a newer client is installed. You can use a configuration file
to control how this update takes place.

Aniprint.ini configuration file is located on each server where iPrint is installed. This file controls
whether the user is prompted before the updated client is installed or the updated client is installed
without user intervention. When the client is installed without user intervention, the user still sees the
installation program.
1 Using a text editor, edit the i pri nt. i ni configuration file.
Theiprint.ini fileislocatedin/var/opt/novell/iprint/htdocs/
2 Change the Al | owAut oUpdat e setting for the desired behavior.

3 Save the file.

IMPORTANT: Theiprint.ini file should be synchronized across all servers where iPrint and an
Print Manager are running.
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Creating a Short Printer Name Profile

By default, the installed printer name on the client follows the full UNC/URL format: \\ipp://
dns_name\printer_name. For example, \\ipp://Printing.My_Company.Com\ColorPrinter. These printer
names are often too long to fit in an application’s display field for the printer name. You can use a
Short Printer Name Profile to replace the UNC server name (or dns_name) for all printers on a Print
Manager with any name you want to display. For example, if you want to display just the company
name, you could use \\My_Company\ColorPrinter.

NOTE: You should keep the UNC path and printer name to fewer than 32 characters.

The Short Printer Name Profile is available only on Windows NT, XP, 2000, 2003 and later
workstations. When you implement a Short Printer Name Profile, printers that are already installed
are not affected. Only newly installed printers after the change use the shortened name. For printers
already installed, you must delete and reinstall the printers to implement any changes to their names.
1 Editiprint.ini ina text editor.
The iprint.ini fileislocatedinvar/opt/novell/iprint/htdocs/

2 Change the value of the ShortinstallName parameter to the value you want displayed.

Short | nst al | Name=your _nane

Replace your_name with the value you want displayed. To reset the parameter to its default
setting, use def aul t as the value.

Use only lower ASCII characters and do not use a slash, quote, space, or comma.
3 Save the file.

IMPORTANT: Thei print.ini file should be synchronized across all servers where iPrint and a
Print Manager are running. The Installed Printer Name Profile affects all printers on a Print Manager.

User Printers

A printer can be installed as a workstation printer or a user printer. The User Printer feature takes
advantage of the Microsoft Access Control List ability to restrict users ability to view the printer. Only
the user which installed the printer can install, see, use, and delete the printer. Hence, it is the User's
Printer, and not the Workstation's Printer. User printers are not available to other users on the
workstation.

+ “Enabling User Printers” on page 203

+ “Deleting User Printers” on page 204

Enabling User Printers

To enable user printers, edit the i print.ini file and change the value for Al | owUser Printers =
val ue to one of the following:
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Table 12-4 User Printer Settings

Value Description

0 Follow Windows standards and only let users with sufficient permissions to install
the printer to the desktop. This allows all users to see and use this printer. This is
considered a global or workstation printer.

1 If the current user does not have permissions to add a workstation printer (option
0), automatically add the printer so that only the current user can install, view,
modify, or delete this printer. This is considered a private or user printer.

2 Only add user printers. All users (including Administrators or Power Users) that
add a printer can install, view, modify, or delete the printer they installed. All
printers are private or user printers.

3 Only add workstation printers. No permissions are required. All users have rights
to install, view, modify, or delete iPrint printers even if the Windows workstation
has been locked down. Non-iPrint printers are not affected.

The user printer feature is now enabled for your users. For workstations above Windows 8.1 and
later, an additional option Al | oWWBACLPri nters = entry must be setintheiprint.ini file for the
User Printer feature to work. The acronym WSACL within the AllowWSACLPrinters stands for
Workstation Access Control List.

Table 12-5 User Printer Settings for Windows 8.1 and above

Value Description

0 The WSACL printers enables user printing feature on OS Windows 8.1 and later.
Windows 2012 R2 with V4 driver support. By, default the setting is disabled.

1 Enable the Al | owUser Pri nt er s settings, then enable this setting. For operating
systems below Windows 8.1, the User printer feature works in the legacy way.

IMPORTANT: If the printers are created (legacy way) on Windows 8.1 or later workstations, you must
delete the printers and install new printers. Enabling Al | owUser Pri nt er s settings on those printers
will not enable the new User printer functionality.

Example: Three workers—Albert, Juan, and Carla—share the same computer during the day. Albert
prints to an accounting printer, Juan prints to a plotter, and Carla prints to a printer in the CEQO’s office.
The administrator set AllowUserPrinters = 2. Each worker can install the printer he or she needs but
cannot see printers installed by the other users.

Deleting User Printers

To delete a User printer, do the following:

1 Start > Control Panel > Hardware and Sound > Devices and Printers.
2 Select the User printer that you want to delete and right-click:
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+ Remove iPrint Printer: Click this option to delete User printers created on workstations
Windows 8.1 and above. This option is available with iPrint client 6.07 and later.

+ Remove device: Click this option to delete User printers created on workstations below
Windows 8.1.

iPrint Client Management

iCM lets you designate printers to be installed on a workstation when a user logs in to the workstation
using the Novell Client. For more information, see .“Using iPrint Client Management” on page 166

+ “Enabling and Disabling iPrint Client Management” on page 205
+ “Applying iCM” on page 206
+ “Setting the Default Attributes Container for iPrint Client Management” on page 206

Enabling and Disabling iPrint Client Management

You can use thei print.ini fileto enable and disable iPrint Client Management (iCM). Use the
i CMEnabl ed value in the following ways:

¢ iCMEnabled =1

iCM is fully enabled. iCM attributes are identified from the full tree hieararchy.
¢ iCMEnabled = 0
iCM is disabled.

IMPORTANT: Using this command disables all iCM configurations created in the Novell Client.
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Applying iCM

A new option Refresh iCM is introduced to apply the configuration changes made by the
administrator.

Figure 12-8 Refresh iCM

iPrint settings
Document status

Refresh iCM

Launch Printer Folder

I Close

The user clicks Refresh iCM to immediately apply the iCM settings modified by the administrator. A
window is displayed with results of settings that were modified.

When an user click Refresh iCM and if no window is displayed, then the user has to logout and
relogin to the workstation to apply the changes.

Setting the Default Attributes Container for iPrint Client Management

You can use the i print.ini file to set the default container that iCM should read values from. To
configure this scope, use the following command:

¢ iCMScope = DEFAULT

Using this command stops the system from reading iCM attributes beyond the container you
specify. The iCM attributes are read on the full tree hierarchy. The iCM attributes are considered
within the specified tree hierarchy.

For example, you can use the OU=UNI T, O=COMPANY command to set the iCMScope to the
Organizational Unit in the OU from the base of the tree. The user should be present within the
specified container for iCM function to work.

NOTE: Setting the attribute in this way does not work above the specified container.

Windows Terminal Servers

You can set up iPrint on a terminal server to allow terminal server clients to install the iPrint Client and
print to iPrint printers.

+ ‘“Installing the iPrint Client on a Terminal Server” on page 207

¢ “Configuring iPrint for Terminal Server Clients” on page 207
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Installing the iPrint Client on a Terminal Server

1 Log in to the terminal server with Administrator or equivalent rights.
2 |Install the iPrint Client.

You can download the iPrint Client from the iPrint Appliance Welcome page or copy and execute
ni pp. exe from the iPrint server in sys: \ apache2\ ht docs\ i ppdocs.

NOTE: On terminal servers, the client auto-update does not work. To update the client with a newer
release, you must install it manually.

Configuring iPrint for Terminal Server Clients

You can configure iPrint to work in any of the following ways, depending on the rights the terminal
server client has.

+ Install user printers only: User printers can only be installed and deleted by the user who
installed the printer. User printers are not available to other users on the workstation.

+ Install workstation printers only: Workstation printers can be installed and deleted only by
users with sufficient rights. After a workstation printer is installed, all users using the workstation
can print to it.

+ Try to install workstation printer first: If the user has insufficient rights to install the printer, the
printer is installed as a user printer.
To configure iPrint for terminal server clients:

1 Log in to the terminal server with Administrator or equivalent rights.
2 Click Start > Programs > Novell iPrint > iPrint Settings.

3 Click Terminal Server, then select the configuration option you want.
4 Click OK.

Uninstalling the iPrint Client

Uninstalling the iPrint Client is dependent on your workstation’s operating system.

¢ “Uninstalling the Macintosh iPrint Client” on page 207
+ “Uninstalling the Windows iPrint Client” on page 208

Uninstalling the Macintosh iPrint Client

You can uninstall iPrint from your workstation.

1. Select Go > Computer > Applications > iPrint Uninstallation.
2. Double-click iPrint Uninstallation.
3. Click Yes to uninstall the iPrint Client.
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Uninstalling the Windows iPrint Client

To remove the Novell iPrint Client, use the Add or Remove Programs option in the Windows Control
Panel.

NOTE: When you uninstall the Windows iPrint Client, all iPrint printers are removed from the
workstation.
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3 Mobile Device Management (MDM)

+ “Managing the iPrint App with Android for Work” on page 209

+ “Managing the iPrint App with ZENworks Configuration Management 2017” on page 209
+ “Managing the iPrint App with ZENworks Mobile Management 3.2.x” on page 210

+ “Configuring Mobilelron to Manage the iPrint App” on page 211

Managing the iPrint App with Android for Work

The Micro Focus iPrint App available in the Google Play Store is enabled to manage configurations.
The supported devices are Android 4.0 and later.

Managing the iPrint App with ZENworks
Configuration Management 2017

The Micro Focus iOS iPrint App 3.0.4 available in the Apple Play Store is enabled for ZENworks
Configuration Management 2017. For information about provisioning iPrint iOS app, see Provisioning
Applications in the ZENworks 2017 Mobile Management Reference guide.

Key-Value Pairs
Key-value pairs allow you to populate user login information and set configuration options.

Table 13-1 iPrint Key-Value Pairs

Key Value
server Specify the URL of your iPrint site. For example, iprint.acme.com.
serverl When specifying multiple servers, the subsequent servers will be server 2, server 3,

and so forth. You can provide same or different user for each server.

user nane Specify ${LoginName} for ZENworks to automatically populate the app with the login
name of the ZENworks user.

Alternatively, you can specify name of an individual user.

configlLocked The value is true or false. If the value is true, the app users will not be able to modify
the iPrint app configuration on their devices. This value of the data type must be string
and not boolean.

Examples for Key-Value Pairs

+ Multiple Servers and Same Users: If there are two iPrint servers and you want all the app
users to print through both the servers, specify the server values and user nane as the key.
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Table 13-2 Multiple Servers and Same Users

Key Value

server iprint.acme.com
serverl iprint2.acme.com
user name ${ Logi nNane}

+ Multiple Servers and Different Users: If there are two iPrint servers and you want different set
of app users to print through each server, specify the server values and subsequent user nane
as the key. Use the key-value pair as server and user nane and server 2 and user nanme2.

Table 13-3 Multiple Servers and Different Users

Key Value

server iprint.acme.com
user name admin

serverl iprint1.acme.com
user nanel admin1

+ Sample Format of Configuration File

<key>Confi gurati on</ key>

<di ct >
<key>server </ key>
<string>i print.acne.conx/string>
<key>server 1</ key>
<string>iprintl. acne.conx/string>
<key>user nane</ key>
<string>adm n</string>
<key>user nanel</ key>
<string>adm nl</string>
<key>confi gLocked</ key>
<string>true</string>

</dict>

Managing the iPrint App with ZENworks Mobile
Management 3.2.x

ZENworks Mobile Management (ZMM) 3.2.x is a mobile device management solution that provides
organizations with centralized management and control of the wireless device platforms in their
enterprise network.

The Micro Focus iPrint App available in the Google Play Store is enabled for ZMM. You can now
manage the Micro Focus iPrint app using ZMM solution. For information about adding iPrint app for
Android devices, see Adding and Managing Apps for Android Devices in the Managing User,
Resources, and Applications guide.
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Configuring Mobilelron to Manage the iPrint App

iPrint App is enabled for Mobilelron. You must configure Mobilelron to manage the iPrint mobile app.

+ “Supported Features” on page 211

*

“Adding the iPrint App to Mobilelron” on page 211

*

“Pre-Populating Fields for iPrint Login” on page 213

*

“Distributing the iPrint App to Devices” on page 214

Supported Features

iPrint mobile app provides an additional feature to pre-populate the following fields on the iPrint login
screen on both iOS and Android devices:
+ Server IP Address

+ UserID

Adding the iPrint App to Mobilelron

+ “Adding the Android iPrint App” on page 211
+ “Adding the iOS iPrint App” on page 212

Adding the Android iPrint App

To add the Android iPrint app to Mobilelron, upload the *. apk file and then apply the Android label to
the application:

1 Download the Micro Focus iPrint for Mobilelron Appconnect (*. apk) file from the Novell
downloads site (https://download.novell.com).
2 Upload the file to Mobilelron:
2a In the Mobilelron Admin Portal, click the Apps tab.
2b On the App Distribution Library tab, in the Select Platform drop-down list, select Android.
2c¢ Click Add App.
The Add App Wizard is displayed.
2d Click Next, then specify the following information:
Distribution Type: Select In-house App.

Silently Install: If your device supports a silent install, select Yes. If the device does not
support a silent install or if you are unsure, select No.

App Upload: Browse to and select the . apk file that you downloaded.

2e Click Next, then specify the following information:
App Name: M cro Focus i Print is already specified for you. This cannot be changed.
Display Version: The version is already specified for you. This cannot be changed.
Code Version: The version is already specified for you. This cannot be changed.
Description: Specify a short description for the app.

Override URL: For information about this feature, see the blue information icon next to this
field.
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Featured: Select whether you want to feature this app.

Category: Select the category that most closely matches the app. You can add a new
category as described in the dialog box.

2f (Optional) Click Next, then click Browse to upload any screen shots that you have for the
app.
The mandatory image size is displayed in the dialog box.
2g Click Finish to close the Add App Wizard.
3 Apply the Android label to your application:

3a From the App Distribution Library tab on the Apps tab, select the Micro Focus iPrint app
that you created, then click Actions > Apply To Label.

The Apply To Label dialog box is displayed.
3b Select the Android label, then click Apply > OK.

Adding the iOS iPrint App

To add the iOS iPrint app to Mobilelron, import it from the Apple Appstore and then apply the iOS
label to the application:
1 Import the app from the Apple Appstore:
1a In the Mobilelron Admin Portal, click the Apps tab.
1b On the App Distribution Library tab, in the Select Platform drop-down list, select iOS.
1c Click App Store Import.
The App Store Search dialog box is displayed.
1d In the App Name field, type M cro Focus i Print.
1e In the App Store field, select the country appropriate to your location.
1f Click Search.
1g Click Import next to the Micro Focus iPrint app, then click OK after it is imported.
1h Close the App Store Search dialog box.

1i From the App Distribution Library tab on the Apps tab, click the Edit icon next to the Micro
Focus iPrint app that you imported.

The Edit App for iOS dialog box is displayed.
1j Make any desired changes to the app details and icon, then click Save.
2 Apply the iOS label to your application:

2a From the App Distribution Library tab on the Apps tab, select the Micro Focus iPrint app
that you just created, then click Actions > Apply To Label.

The Apply To Label dialog box is displayed.
2b Select the i0S label, then click Apply > OK.
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Pre-Populating Fields for iPrint Login

Pre-populate the server URL and user ID fields for both the iOS and Android apps.
You must modify the app configuration for Android, and create a new app configuration for iOS.

+ “Creating the iOS iPrint App Configuration for Mobilelron” on page 213
+ “Key-Value Pairs” on page 213
+ “Modifying the Android iPrint App Configuration for Mobilelron” on page 214

Creating the iOS iPrint App Configuration for Mobilelron

1 In the Mobilelron Admin Portal, click the Policies & Configs tab.
2 On the Configuration tab, click Add New > AppConnect > Configuration.
The New AppConnect App Configuration dialog box is displayed.
3 Specify the following information:
Name: Provide a name for the configuration, such asi Print i OS Confi gurati on.
Description: (Optional) Provide a description for the configuration.
Application: Specify the iPrint iOS bundle ID, which is com novel | . print.

4 In the App-specific Configurations section, click the Plus icon to add a new field to the key-
value pair table; you can then specify the key-value pair to be included in the configuration.

The key-value pairs that you can add are shown in Table 13-4, “iPrint Key-Value Pairs,” on
page 213. Key-value pairs that you add to the table represent the information that will be pre-
populated for iPrint login.

5 Click Save.

Key-Value Pairs

Table 13-4 iPrint Key-Value Pairs

Key Value
server Specify the URL of your iPrint site. For example, iprint.acme.com.
server?2 When specifying multiple servers, the subsequent servers will be server 2, server 3,

and so forth. You can provide same or different user for each server.

user Specify $USERI D$ for Mobilelron to automatically populate the app with the users’
Mobilelron user ID.

Alternatively, you can specify an individual user’s user ID.

confi gl ocked The value is true or false. By default, the value is true and the app users will not be able
to modify the iPrint app configuration on their devices.

Examples for Key-Value Pairs

+ Multiple Servers and Same Users: If there are two iPrint servers and you want all the app
users to print through both the servers, specify the server values and user as the key.
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Table 13-5 Multiple Servers and Same Users

Key Value

server iprint.acme.com
server 2 iprint2.acme.com
user $USERI D$

+ Multiple Servers and Different Users: If there are two iPrint servers and you want different set
of app users to print through each server, specify the server values and subsequent user as the
key. Use the key-value pair as server and user and server 2 and user 2.

Table 13-6 Multiple Servers and Different Users

Key Value

server iprint.acme.com
user $USERI D$
server?2 iprint2.acme.com
user 2 $USERI D$

Modifying the Android iPrint App Configuration for Mobilelron

1 In the Mobilelron Admin Portal, click the Policies & Configs tab.

2 On the Configuration tab, in the Name column, click the name of the iPrint configuration for the
iPrint app that you uploaded, as described in “Adding the Android iPrint App” on page 211.

3 Click Edit.
The Modify AppConnect App Configuration dialog is displayed.
4 Specify the following information:
Name: Provide a name for the configuration, or keep the default.
Description: (Optional) Provide a description for the configuration, or keep the default.
Application: Select M cro Focus i Print from the drop-down list.

5 In the App-specific Configurations section, keep or remove the key-value pairs that are shown
in Table 13-4, “iPrint Key-Value Pairs,” on page 213. Key-value pairs that remain in the table
represent the information that will be pre-populated for iPrint login.

6 Click Save.

Distributing the iPrint App to Devices

You must distribute the iPrint app to devices in your organization via Mobilelron if this is the first time
your organization is using Mobilelron with iPrint, or any time a new device enters the organization.

Some users might have independently download the iPrint app from the app store before their device
is managed by Mobilelron. Even in this scenario, you must push the app to their device via
Mobilelron. (These devices will lose any cached or downloaded files within the iPrint app after their
device becomes managed and the iPrint app is pushed to their device.)
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Troubleshooting iPrint Appliance

You might encounter the following issues when using iPrint Appliance.

NOTE: The iPrint Appliance print server maintains log files to help with debugging the server's
activity. The log files are located at the following locations:

+ Novell iManager: / var/ opt/ novel | / t ontat 6/ | ogs/ cat al i na. out

+ Novell iPrint Mobile: / var/ opt/ novel | /1 og/i printnobile/iprint_nobile0.I og

+ Management Console: / var/ opt/novel | /jetty8/1ogs/jetty.stderrout. out

¢ Export Backup: / var/ opt/novel | /1 og/i pri nt mobi | e/ backup. | og

+ Upgrade Restore: / var/ opt/novel | /1 og/i printmobile/restore. | og

+ Print Manager: / var/opt/ novel I /1 og/iprint/ipsnd.|og

¢ Driver Store: /var/opt/novel | /1 og/iprint/idsd.log

+ eDirectory: / var/ opt/ novel | / eDi rect ory/ | og/ ndsd. | og

+ Apache: /var/ | og/ apache2/ error_l og

+ “Server Issues” on page 215

+ “LDAP Issues” on page 217

+ “Renderer Issues” on page 218
+ “General Issues” on page 223

Server Issues

+ “Recreate the Print Manager Database” on page 215
+ “POODLE Security Vulnerability” on page 216
+ “Error When Configuring Secondary Hard Disk (/vastorage) on Xen” on page 216

+ “Processor Utilization Increases When 10,000 Users Are Imported from an External LDAP
Source” on page 217

Recreate the Print Manager Database

If you have accidentally deleted the Print Manager, then it can be restored by using the XML backup
file. The /var/opt/ novel | /i print/<Print Manager. cont ext>. psnf padbt xt . xnl file includes all
the relevant information to restore the Print Manager database. When the Print Manager is deleted,
the padbt xt . xni file is copied to the / t np folder and renamed with the name of the Print Manager
and timestamp.

Perform the following steps to restore the Print Manager:

1 Locate the XML file. It will be available in the / t np directory.
¢ Syntax:
<Print Manager nane>.<Context>_<Year- Mont h- Dat e>__ <HR MN\: SEC>
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+ Example:
i Printnew. i PrintAppliance_202-16__22:58: 48
2 Create the Print Manager object.

When creating the Print Manager, refer to the backup XML to ensure you are using the same
information:

+ Print Manager Name = first part of the <dn> within the XML
+ Container Name = latter part of the <dn> within the XML

+ eDir Server name = <dserver> part of the XML, however, browse to the object. Don't use
the network address.

+ Driver Store Name = <ids> part of the XML

¢ iPrint Service = <hostname> of the XML. It is very important this part is identical. Changing
this value could result in all workstations auto removing and auto re-installing all printers
installed to workstations.

3 Shutdown the Print Manager.
rcnovel | -i psnd stop
4 Import the data from the backup XML file:
¢ Syntax:

/opt/novel | /iprint/bin/ipsmd -x /tnp/systend-private-<HEX Val ue>-
apache?2. servi ce-<Characters>/tnmp/ <Print Manager name>. <Context>_<Year -
Mont h- Dat e>__ <HR: MN: SEC> -u cn=<eDir adni n nane>, o=<Or gani zat i onNane>

¢ /opt/novell/iprint/bin/ipsnd -x /tnp/systend-private-
ac0dbc6a87f 24f 2f 940484c¢10937a5f 0- apache?2. servi ce- WePGnZ/ t np/
i Printnew. iPrintAppliance_2018-02-16__22:58:48 -u cn=adni n, o=MyCont ai ner

Provide the admin password
5 On successfully completing the import, start the Print Manager:
rcnovel I -ipsnd start
The Print Manager is successfully loaded.

POODLE Security Vulnerability

LDAPS and HTTPS in eDirectory allow SSLv3 for secure communication, and SSLv3 has been found
to have protocol vulnerability as per CVE-2014-3566. After installing the Appliance, ensure that you
disable SSLv3 to prevent POODLE security vulnerability.

To disable SSLv3 through LDAP, add number 128 to the IdapBindRestrictions attribute on the LDAP
server object.

Error When Configuring Secondary Hard Disk (/vastorage)
on Xen

When installing the iPrint, search index, or database appliances on Xen, configuring hard disks (/
vast or age or/ var ) during installation can result in the following error:

PCl: Fatal: No config space access function found.
Unable to read sysrq code in control/sysrq

i 8042: No controller found

end_request: /O error, dev xvda 18576
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This issue can cause a small delay; however, the server will operate normally.

Verify that the disks are added as expected by running the following command from the appliance

console:

df -h

/ dev/ xvdal 20G 5.5G 114G 30%/

/ dev/ xvdcl 12G 2.0G 9.4G 18%/vastorage
/ dev/ xvddl 2.0G 257M 1.7G 14%/var

Processor Utilization Increases When 10,000 Users Are
Imported from an External LDAP Source

When syncing users from an external LDAP source, the processor utilization increases if you try to
import 10,000 users.

The reason for this behavior is that the User Sync is scheduled to run every 8 minutes, by default.
Therefore, each time the User Sync is started, which is every 8 minutes, the processor utilization
increases to around 50%, and remains in that state for up to 5 minutes. The utilization might further
increase if you import over 10,000 users.

To workaround this issue, you can change the sync interval by editing the cr ont ab file.

1 Launch the cront ab file located at / et ¢/ cr ont ab.
2 Browse to the line where the sync interval is set to 8 minutes.
# run iprint mgrate every 8 mnutes

*/8 * * * * root /usr/bin/python /opt/novell/iprintnobile/python/m grate/
m grateUsers. pyc >> /var/log/ipmgrate.log 2>&1

3 Change the time to the desired time interval.

For information on scheduling time intervals for cron jobs, see the article about Cron on Wikipedia.

LDAP Issues

¢ “Unable to Import All Users from the Active Directory Source Using LDAP Sync” on page 217

+ “Active Directory Administrator Users Unable to Perform Administrative Tasks Post LDAP
Import” on page 218

+ “LDAP Import Fails to Import Administrator User from Active Directory Environments” on
page 218

Unable to Import All Users from the Active Directory Source
Using LDAP Sync

You might not be able to import all users from the Active Directory source using LDAP sync. By
default, in Active Directory, LDAP search returns only 1,000 objects. This issue is caused by a default
setting in Active Directory that limits LDAP searches to 1,000 results.

To work around this issue, you can use the Nt dsut i | . exe tool to modify the MaxPageSize value to
expand or limit the search, depending on the size of the Active Directory tree.
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For more information, see the Microsoft support article on How to view and set LDAP policy in Active
Directory by using Ntdsutil.exe.

Active Directory Administrator Users Unable to Perform
Administrative Tasks Post LDAP Import

Admin users migrated to iPrint Appliance through LDAP Import cannot perform administrative tasks
such as managing iManager. This is because the LDAP Import feature imports only the user names
but not the passwords. iManager fails to authenticate AD users with no passwords.

LDAP Import Fails to Import Administrator User from Active
Directory Environments

When importing users from Active Directory environments, LDAP import fails to import the
administrator user account.

The Active Directory administrator user is not required for iPrint Appliance. iPrint Appliance contains
an in-built administrator account. The admin account of iPrint Appliance manages all users imported
from Active Directory.

Renderer Issues

+ “RPC Error is Displayed When Accessing Management Console” on page 219

¢ “Upgrading iPrint Renderer From 1.0 or 1.0.1 to 1.1 Corrupts the iPrintRenderer.conf File” on
page 219

+ “PowerPoint Job Fails to Print” on page 219

+ “Jobs Fails to Print” on page 219

+ “Remote Renderer Status is Inactive” on page 219

+ “Remote Renderer Status is Inactive After Appliance Upgrade” on page 220

+ “iPrint Rendering Service Hangs” on page 220

+ “Printer Drivers are Missing After Registering the Remote Renderer” on page 220
+ “Local Renderer Fails to Print the Password-Protected PDF Files” on page 220
¢ “Printer Prints Junk Characters” on page 221

+ “Remote Renderer Fails to Start Because of Login Failure” on page 221

+ “Adobe Acrobat 11 Pro Hangs While Rendering PDF Files” on page 222

+ “Disk Space Gets Filled Up During Continuous Job Submission” on page 222

+ “iPrint Rendering Service Fails to Start If the Windows User Account Password Changes or
Expires” on page 222

+ “iPrntRendCmd Stops Responding During Configuration or Other Command Line Operations” on
page 222

*

“Upgrade Option Missing for Remote Renderer” on page 223
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RPC Error is Displayed When Accessing Management
Console

Certificate validation fails if the third party certificate is already configured and activated before
configuring iPrint Appliance server.

To resolve this issue, configure the iPrint Appliance server again and then upload and activate the
certificates.

Upgrading iPrint Renderer From 1.0 or 1.0.1 to 1.1 Corrupts
the iPrintRenderer.conf File

If you have upgraded the renderer from 1.0 or 1.0.1 to 1.1, the i Pri nt Render er. conf file gets
corrupted. On corruption of this file, the renderer also fails to uninstall.

To resolve this issue, do the following:

1 Replace the contents of the ¢: / NDPS/ Render er/ Conf /i Pri nt Render er. conf file with the
following:

Wor d=doc, docx, rtf, docm dot m
Excel =xI s, x| sx, x| sm x| sb

Power poi nt =ppt, ppt x, ppt m ppsm
i nBui | t PDFRender er =pdf
#Adobe=pdf

2 On your client workstation, uninstall the Renderer.

3 Install the latest renderer. For more information, see “Installing and Configuring a Remote
Renderer” on page 82.

PowerPoint Job Fails to Print

If the remote renderer configured with Microsoft Office 2013 is under continuous load, then it may fail
to print PowerPoint jobs. This issue is not caused if the remote renderer is configured with Microsoft
Office 2010.

To resolve this issue, stop and start the remote renderer.

Jobs Fails to Print

If the remote renderer is configured on Windows 8.1, Windows 2012, and Windows 2012 R2 server,
then over the period of time, you might encounter consistent print failure. This is because the in-built
pdf renderer might have stopped responding.

To resolve the issue, restart the remote rendering service using the following commands:

1 To stop the renderer, runi prntrendcnmd -q
2 To start the renderer, run iprntrendcmd -

Remote Renderer Status is Inactive

Sometimes the remote renderer status might change to Inactive and activating it from the
Management Console also fails to change the status.
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To resolve this issue, restart the renderer using the following commands:

1 To check the status of the service, runi prntrendcnd -s
2 To start the renderer, run iprntrendemd -

Remote Renderer Status is Inactive After Appliance
Upgrade

If you have a remote renderer associated with the iPrint Appliance, then upgrading the iPrint
Appliance changes the remote renderer status to Inactive. To resolve this issue, follow the steps from
‘Downloading the Remote Renderer” on page 83 to “Registering the Remote Renderer” on page 84
to download, install, and register the new renderer.

iPrint Rendering Service Hangs

The iPrint Rendering Service might hang with the service status “Stopping.”

This issue is caused when the remote renderer fails to restart when using the configuration or
registration commands.

To workaround this issue:

1 Launch the Windows Task Manager.

2 Click the Processes tab.

3 Check the Show processes from all users box.

4 Right-click iPrint Rendering Service.exe, then click End Process.

5 Start the remote rendering service by using the i prntrendcnd -1 command or through the
window services panel.

Printer Drivers are Missing After Registering the Remote
Renderer

After registering the remote renderer, self-signed and un-signed drivers are not installed.
To resolve this issue, run the command, i prntrendcnd -rt <FDN or | P Address>

On the prompt, accept the certificate for each driver.

Local Renderer Fails to Print the Password-Protected PDF
Files

The local renderer fails to print password-protected or corrupt PDF files.

You might get a message in the audit page that the job is complete or success message for email
printing, if the local renderer uses the pre-packaged driver for printing.
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Printer Prints Junk Characters

When trying to print a document, the printer might print only junk characters in the following
scenarios:

*

*

This issue is caused because the local renderer does not support all the font types. To resolve
this issue, you can install the Microsoft TrueType fonts on your iPrint Appliance server.

1. Loginasroot.

2. Type the following command to navigate to the f ont s directory, then press Enter:
cd /opt/novell/iprintnobile/fonts/

3. Install the supported RPM files by typing the following command, then press Enter:
rpm-ivh *.rpm
The RPM files are now installed on the iPrint server.

4. Run the script to retrieve the fonts by typing the following command, then press Enter:
sh fetchmsttfonts-11.1-5.7.10-fetchnsttfonts. sh. txt
The fonts are downloaded from Sourceforge and installed on your iPrint server.

Few of the Linux drivers might fail to print due to absence of certain filters. You can verify this
information, using the command: | pstat -p

The command displays the status of the drivers. Change the driver for which you have received
the failure messages. This is applicable only for local renderer.

If the remote renderer is registered with Built-in-PDF Renderer for processing the PDF jobs, it
might print junk characters for PDF files.

To resolve this issue, you need to reconfigure the remote renderer using i prntrendcnd -c¢
command.

If the remote renderer is not registered for PDF file processing, the printer might print only junk
characters and not the actual content. This can be caused by an incompatible printer driver.

To work around this issue, use the drivers that are compatible with your printer.

Remote Renderer Fails to Start Because of Login Failure

The remote rendering service might not start if the credentials provided are incorrect, or if the user
account does not have the Log on as a service rights.

To resolve this issue, you must assign the Log on as a service rights to the user account with which
you want to set up the renderer, on the local machine:

N O g A WON -

Go to Start > Control Panel > Administrative Tools > Local Security Policy.
In the left pane, double-click Local Policies.

Click User Rights Assignment.

In the right pane, under Policy, double-click Log on as a service.

Click Add User or Group.

Add the user account to the list, then click OK.

Click OK, then close the Local Security Policy window.
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Adobe Acrobat 11 Pro Hangs While Rendering PDF Files

When rendering PDF files using Adobe Acrobat 11 Pro, Adobe Acrobat might stop responding and
not complete the rendering process.

To work around this issue, kill Adobe Acrobat from Windows Task Manager, then try again.

Disk Space Gets Filled Up During Continuous Job
Submission

When handling a large number of print requests, the remote renderer might not be able automatically
delete the converted job data, and the disk space allocated for the remote renderer might fill up.

To work around this issue, you must manually delete the stored jobs.

1 Launch the command prompt.

2 Stop the iPrint Rendering Service manually using the command iPrntRendCmd -q.
3 Delete the files in the jobs folder located at C: \ NDPS\ Render er\ j obs.

4 Start the iPrint Rendering Service using the command iPrntRendCmd -I.

iPrint Rendering Service Fails to Start If the Windows User
Account Password Changes or Expires

The iPrint Rendering Service might not work if the password of the user account associated with the
service changes or expires.

To work around this issue, you must update the new password for the iPrint Rendering Service on the
Services utility.

Click Start > Run.

Specify servi ces. nmsc, then click OK.

Right-click iPrint Rendering Service, then click Properties.

Click the Log On tab.

Under This account, update the new password, then click Apply.

Click OK.

Right-click iPrint Rendering Service, then click Start or Restart to start the service.

N O g A WODN -

iPrntRendCmd Stops Responding During Configuration or
Other Command Line Operations

When configuring or modifying the remote renderer, the i pr nt r endcnd command might stop
responding.

To work around this issue, close the command prompt that is currently open, launch a new command
prompt window, and then try the i pr nt r endcnd command again.
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Upgrade Option Missing for Remote Renderer

The remote renderer on iPrint Appliance does not provide an upgrade option.
This is a known limitation of the remote renderer in the iPrint Appliance 1.1 and earlier versions.

To resolve this issue, follow the steps from “Downloading the Remote Renderer” on page 83 to
“Registering the Remote Renderer” on page 84 to download, install, and register the new renderer.

General Issues

+ “Unable to customize iPrint maps” on page 223

+ “Unable to upload Xerox GPD and HP UPD driver from iManager” on page 224
+ “Fails to Print Jobs With Conversion Failure Error” on page 224

+ “iPrint Appliance Migration Target Server SSL Authentication Fails” on page 225
+ “RPC Error When Enabling Printers for Mobile Printing” on page 225

+ “Email Printing Fails When the Filename Includes Extended Characters Or Double-byte
Characters” on page 225

+ “Unable to Configure Email Printing When SSL Is Enabled for IMAP/POP on a Mail Server” on
page 225

+ “DataStore Creation Fails” on page 226
+ “Garbage Characters Printed When Printing from Gmail on Internet Explorer” on page 226
+ “Canceled by Operator” Messages in the Audit Logs” on page 226

+ “Secure Printer Continues Printing after Changing the User Password (Local Appliance
eDirectory Users Only)” on page 226

Unable to customize iPrint maps

The existing maps cannot be modified on updating the iPrint Appliance server with the latest
patches.To resolve this issue, edit the HTML tags in the existing maps and replace with the new tags.

1 Open the iPrint map file in any HTML editor. For example, firstfloor.htm

2 The snippet from the map file that needs modification:

<ht i >
<head>
<title>
</title>

<meta http-equiv="content-type" content="text/htm; charset=UTF-8">
<style id="iprint_style">
#ipp_printer { color: windowext; font-famly: sans-serif; font-size:
10pt; font-style: nornal; font-weight: nornal; }
</style>
</ head>
<body style="cursor: default;">

3 Replace only the above snippet with the new tags, do not modify any other tags in the file.
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<ht m >
<head>
<meta http-equiv="content-type" content="text/htm; charset=UTF-8">
<style id="iprint_style">
#ipp_printer { color: windowext; font-famly: sans-serif; font-size
10pt; font-style: nornal; font-weight: nornmal; }
</style>
<l'ink href="styles/iprintappliance.css" rel="styl esheet">
<script src="scripts/iprint.js">
</script>
<script src="../ippdocs/nls/en/iprntmsg.js">
</script>
</ head>
<body bgcol or="#ffffff" onl oad="OnLoadPDi splay();">
<div id="instruction">
<di v id="instructionHeadi ng">

</ di v>

<div id="instructionContent">

</ div>
</ di v>
<di v id="BodyMai nDi v" style="position: relative;">
</ di v>

4 Save the file and relaunch the map in the Map tool. You can now successfully modify the map.

Unable to upload Xerox GPD and HP UPD driver from
iManager

The drivers cannot be uploaded due to out of memory issue. To resolve this issue, we recommend
you to increase the Java heap size to 1GB for iManager.

Perform the following steps:

1 Inthe /et c/opt/novel | /tontat 6/ conf/novel | -tontat 6. conf file append the variable
JAVA OPTS with the value - Xmx1024M

¥ Use JRVA OPTS to set java.library.path for libtcnative.so

#JBRVA OPTS="-Djava.library.path=/usr/lib"

$J2va_0OPTS="-Djava.library.path=/opt/novell/eDirectory/lib64"

#JAVA OPTS="-Djava.library.path=/opt/novell/eDirectory/libé4:/var/opt/novell/tomcaté/lib"

Eeva OPTS="-Djava.library.path=/opt/novell/eDirectory/libé4:/var/opt/novell/tomcaté/lib:/usr/1ib64 -Xmx1024M'|
# What user should run tomcat

TOMCAT USER="wwwrun"

TOMCAT_GROUE="WW"

#TOMCATifJSER="tOmCat"

#TOMCAT_GROUP:"T.GIHCET."

2 Execute the following command to restart tomcat:

rcnovel | -tontat6 restart

Fails to Print Jobs With Conversion Failure Error

If the printer drivers are faulty the jobs might fail with a conversion failure error.

To resolve this issue, reinstall the driver for that particular printer.
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iPrint Appliance Migration Target Server SSL Authentication
Fails

iPrint Appliance Migration target server SSL authentication might periodically fail.

To resolve this issue, close the miggui application and launch it again.

RPC Error When Enabling Printers for Mobile Printing

When enabling printers for Mobile printing using the iPrint Appliance Management Console, you
might encounter an RPC error.

To resolve this issue, you can log out and log in to the iPrint Appliance Management Console if the
browser session is open for a long time, or you can refresh the Printers page. If you are still seeing
the RPC error, restart the Print Manager service, and then try to enable the printer for mobile printing.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the iPrint Appliance Configuration icon.

3 Under Configuration, click Services.

4 Select Print Manager.
The Action and Options drop?down menus are activated.

5 Click the Action drop-down menu, then click Restart.

Email Printing Fails When the Filename Includes Extended
Characters Or Double-byte Characters

Printing through email fails, if the name of the file includes either extended characters or double-byte
characters.

To resolve this issue, rename the file to include only supported characters.

Unable to Configure Email Printing When SSL Is Enabled
for IMAP/POP on a Mail Server

If SSL is enabled for IMAP/ POP on a mail server, you might be unable to configure email printing
using the iPrint Appliance Management Console.

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.
2 Click Manage iPrint Appliance > Directory Servers.

3 Click Upload Certificate to import the root certificate for your LDAP directory into the Java
KeyStore (JVM Certificates).

4 Click Reboot to reboot iPrint Appliance.

After iPrint Appliance reboots, configure email printing from the iPrint Appliance Management
Console.
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DataStore Creation Fails

When trying to create a DataStore, you might see a message: “Failed to parse the XML file: XML
document structures must start and end within the same entity.”

To work around this issue, run the configuration script located at/ opt / novel | /i pri nt nobi | e/ bi n/
config. sh.

If you are still seeing the error, you must reinstall iPrint Appliance.

Garbage Characters Printed When Printing from Gmail on
Internet Explorer

If you are using Gmail on Internet Explorer and you try to print an email, you might see garbage
characters in place of line breaks. This is caused by a character encoding issue.

To work around this issue, you must change the default text encoding to UTF-8 in your Gmail
settings.

1 Launch Internet Explorer, then go to www.gmail.com.
2 Sign in to Gmail with your user name and password.
3 Click the settings icon in the upper-right corner of the screen, then select Settings.

4 Under General settings, in the Outgoing message encoding section, select Use Unicode (UTF-
8) encoding for outgoing messages.

5 Click Save Changes.

“Canceled by Operator”’ Messages in the Audit Logs

In the audit log files, you might see the following message:
Cancel ed by operat or
This issue occurs if the files are not rendering correctly.

To work around this issue, ensure that the rendering service is active, and that the renderer is
configured correctly.

Secure Printer Continues Printing after Changing the User
Password (Local Appliance eDirectory Users Only)

When users change their passwords, secure printers might continue printing with the old password
for up to 10 minutes. This is because of caching inside the iPrint LDAP authentication module, and
affects only the users created inside the local eDirectory tree on iPrint Appliance.

To fix this issue, add the parameters LDAPDNCacheTTL and LDAPDNCacheEnt ri es to the
i print_g.conf file, located at/etc/opt/novell/iprint/httpd/ conf/iprint_g.conf as shown
below:

To change the caching time to 30 seconds:

<| FModul e nod_aut hnz_| dapdn. c>

LDAPDNCacheTTL 30
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</ | f Modul e>

To disable caching:

<| FModul e nod_aut hnz_| dapdn. c>
LDAPDNCacheEntries -1

</ | f Modul e>

After updating the i pri nt _g. conf file, launch the terminal window, and then restart the Apache
service using the iPrint Appliance Management Console:

1 On a Web browser, use either the host name or the IP address to access the Management
Console. For example, https://10.0.0.1:9443 or https://iprint.example.com:9443.

2 Click the iPrint Appliance Configuration icon.

3 Under Configuration, click Services.

4 Select Apache server for Novell for iPrint.
The Action and Options drop?down menus are activated.

5 Click the Action drop-down menu, then click Restart.
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Advanced Configuration for iPrint
Mobile Service (Optional)

In addition to the Management Console, there are a few additional parameters that can be configured
to fine-tune the iPrint service, based on your network and printing requirements. The iPrint Appliance
Server Configuration file, located at/ et ¢/ opt/ novel | /i pri nt nobi | e/ conf/i pri nt nobi | e. conf,
allows you to customize the iPrint Mobile service per your requirements.

You must configure the i pri nt nobi | e. conf file manually. When assigning a value to any parameter,
ensure that you uncomment the line, in order for the changes to take effect. After configuring the file,
you must restart the iPrint Mobile service through the Management Console.

The advanced configuration is optional. For most environments, the configuration does not require
modifications.

The iPrint Appliance server configuration file contains the following information:

Table A-1 iPrint Appliance Server Configuration File Contents

Parameter Default Function
Value
home_directory /var/opt/ A directory on the file system that is used to store the data.

novell/ This folder contains the service metadata and temporary
iprintmob  job data.

ile

conversion_wait_time 300 Duration of time (in seconds) that the job submission
threads wait for the job conversion threads.

db_backup_interval 10000 Duration (in milliseconds) after which the database is
backed up on the disk.

is_test_setup false Set this flag if the server is being set up for testing and no
dedicated email address is available. Print job requests are
read-only from the Cabinet folder.

job_submission_thread_timeout 60 Duration (in seconds) for which an excess idle thread waits
before terminating.

delete_completed_job_data true Deletes the converted email print job data stored at/ var/

opt/novel | /i printnobile/jobs/.Setthe value to false
to retain the converted job data for email print jobs.

The /var/opt/novell/iprintmobile/jobs/ folder does not
maintain the IPP job data. IPP job data includes job data
from the Novell iPrint app and Airprint. The job data for apps
and AirPrint are stored in the PA spool directory of the Print
Manager.

WARNING: If you set the value to false, you must ensure
that you delete the print job data regularly to free up disc

space. If the disk space gets full, then email print jobs are
not processed.
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Parameter Default Function
Value

fallback_to_local_converter false If the remote renderer fails, you can run the job through a
local converter.

num_email_receiver_threads 0 Configure this parameter to the maximum number of
threads to be used for processing multiple mailboxes. By
default (when set to 0), the number of threads to email
addresses ratio is 1:5 (1 thread per 5 email addresses).

use_global_address_for_notifications false By default, notifications are sent from the printer-specific
email address. Change the value to 'true' if you want to
send notifications to users using the global email address.

renderer_time_out 180000  Duration (in milliseconds) after which a registered renderer
times out and moves to an inactive state.

verify_certificates false Disable certificate validation.

renderingOnlyServiceEnabled true RenderOnly Configuration

backendRenderingPollinglnterval 500 Backend Rendering Polling Interval (in milliseconds)

incoming_mail_server_port - This configuration overwrites the default port information
configured by Appliance for IMAP and POP mail protocols
to communicate with the mail servers. For default port
information, see “Incoming Mail Server Parameters” on
page 233.

outgoing_mail_server_port - This configuration overwrites the default port information
configured by Appliance for SMTP mail protocol to
communicate with the mail servers. For default port
information, see “Outgoing Mail Server Parameters” on
page 234.

email_polling_interval 30000 Configures the interval (in milliseconds) at which emails are
fetched from mail servers.

subject_optional_for_printer_specific_ true Stops printing emails without the correct iPrint email print

emails command. By default this value is 'true.' Emails forwarded
to the printer-specific email address, with or without a
subject line, are printed.

email_reconnect_interval 30 If the email server is unavailable, iPrint Appliance tries to
reconnect to the email server after the specified duration (in
seconds).

stellent_conversion_thread_count 5 Number of threads allocated for job conversion.

pdf_conversion_thread_count 10 Number of threads allocated to PDF job conversion.

convert_stellent_pdf_using_external_r true If this is set to false the PDF job data is not send to the

enderer remote renderer, even if the remote renderer is configured
and active.

enable_client_login false By default this value is ‘false’. Set this value to ‘true’ if you
require user authentication in apps for printer-based
license.

driver_update_interval 60 Duration (in minutes) after which driver update is triggered.
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Parameter Default Function
Value

default_network_interface ethO Change the default value, if you have multiple NIC cards
configured and you want to publish the AirPrint printers via
a different Network interface.

direct_pdf_print - Add and set this value to ‘true’ to enable direct pdf printing.
If this parameter is not added or set to ‘false’, then the
printing is done in the earlier way where the jobs are
rendered by the Renderer.

proxy_server_hostname - Add and specify the value as IP address or host name
along with port number.

Whenever a user adds the proxy configured iPrint server in
the iPrint mobile app, it will automatically get configured
with the Proxy server. All the requests of the mobile app
users will be redirected to the iPrint server thru the proxy
server.

For example, http://proxy.mycompany.com:8080
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B Email Service Parameters

¢ “Incoming Mail Server Parameters” on page 233
+ “Outgoing Mail Server Parameters” on page 234

Incoming Mail Server Parameters

iPrint Appliance uses POP3 and IMAP protocols to access email servers to poll for email-based pri
jobs. The default POP3 and IMAP protocol ports are listed below:

nt

Protocol Port
IMAP 143
IMAP4 over SSL 993
POP3 110
POP3 (Secure) 995

The information in this table is captured from an email provider support pages. This is not an
exhaustive list. Please refer to your email provider for additional information and compatibility.

Mail Server Protocol Address Port Notes
1&1 POP3 pop.1and1.com 995
IMAP4 imap.1and1.com 143
AT&T POP3 pop.att.yahoo.com 995 SSL-enabled
AOL Mail IMAP imap.aol.com 143
Comcast POP3 mail.comcast.net 110
Google Gmail POP3 pop.gmail.com 995 SSL-enabled
IMAP imap.gmail.com 993 SSL-enabled
Hotmail POP3 pop3.live.com 995 Secure Password
Authentication (SPA)
Mac POP3 mail.mac.com 143
IMAP4 mail.mac.com 143
Netscape IMS POP3 pop.3.isp.netscape.com 110
Verizon POP3 pop.verizon.net 110
995 SSL-enabled
Yahoo! POP3 pop.mail.yahoo.com 465 SSL-enabled
995 SSL-enabled
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Mail Server Protocol Address Port Notes

Yahoo! Plus POP3 plus.pop.mail.yahoo.com 995 SSL-enabled

Outgoing Mail Server Parameters

The iPrint Appliance uses SMTP protocols to send email to users who submit email-based print jobs
in order to report their job status. The default SMTP protocol ports are listed below:

Protocol Port
SMTP 25

SMTP (Secure via SSL) 465
SMTP (Secure via TLS) 587

The information in this table is captured from an email provider support pages. This is not an
exhaustive list. Please refer to your email provider for additional information and compatibility.

Mail Server Protocol Address Port Notes

1&1 SMTP smtp.1and1.com 587

AT&T SMTP smtp.att.yahoo.com 465 Requires

authentication

AOL Mail SMTP smtp.aol.com 587

Comcast SMTP smtp.comcast.net 110

Google Gmail SMTP smtp.gmail.com 465 SSL-enabled
587 TLS-enabled

Hotmail SMTP smtp.live.com 587 TLS-enabled

Mac SMTP smtp.mac.com

Netscape IMS SMTP smtp.isp.netscape.com 25 SSL-enabled

Verizon SMTP smtp.verizon.net 587 SSL-enabled

Yahoo! SMTP smtp.mail.yahoo.com 995 SSL-enabled

Yahoo! Plus SMTP smtp.mail.yahoo.com 465 SSL-enabled
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iPrint Appliance Support Matrix

This section provides information on the following.

+ “Mobile Server Support” on page 235

+ “Mobile Operating System Support” on page 235

+ “Directory Services Support” on page 236

+ “Management Console Support” on page 236

+ “Advanced Authentication Framework Support” on page 237
+ “Mobilelron Support” on page 237

+ “Remote Renderer” on page 237

+ “Supported Document Formats By the Local Renderer and Remote Renderer” on page 238
+ “iPrint Appliance Server and Client Support” on page 238

+ “OES Source Platform Support for Migration” on page 239

+ “Clients for Email Printing” on page 239

+ “Supported Browsers for iPrint” on page 240

Mobile Server Support

Table C-1 Moblie Server Support

Features Version

Email + Novell GroupWise 2012
+ Microsoft Exchange 2013
+ Gmall
+ |IBM Domino server 9

+ Lotus Notes

Mobile Operating System Support

Table C-2 Mobile Operating System Support for Apps

Type Version
i0S * 13.x
* 12X
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Type Version

Android + Oreo (8.x)
+ Nougat (7.x)
+ Marshmallow (6.x)
+ Lollipop (5.x)
+ KitKat (4.4)
¢ Jelly Bean (4.1.x,4.2.x,4.3.1)

¢ Ice Cream Sandwich (4.0.x)

Amazon Kindle Fire Phone OS 4.6.6.1
Windows * 10
* 8.1

Directory Services Support

Table C-3 Directory Services Support

LDAP Directory Service Version
eDirectory + 8.8.x
¢ 8.7.x
Active Directory + Active Directory configured on Windows Server 2012 R2

Standard Edition

+ Active Directory configured on Windows Server 2008 R2
Enterprise Edition

Management Console Support

Table C-4 Management Console Support

Access Version

Browser + Internet Explorer 11 or later
+ Firefox 30 or later
¢ Chrome 35 or later
+ Safari latest on MAC
+ Edge
+ iOS 10 tablet with default browsers

+ Android 6.x tablet with default browsers
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Advanced Authentication Framework Support

+ Advanced Authentication 5.6
+ Advanced Authentication 5.5

Mobilelron Support

Table C-5 Mobilelron Support

Mobilelron Core Version

iPrint Mobile App Version

9.3
8.5
7.5

3.0.x mobile app for iOS and Android
2.0 mobile app for iOS and Android

1.1 mobile app for iOS and Android

Remote Renderer

+ Table C-6, “Operating Systems Support,” on page 237

+ Table C-7, “Software Support,

Table C-6 Operating Systems Support

” on page 237

Support Version

Operating System .

Windows 10 64-bit Enterprise
Windows 8.1 64-bit Enterprise
Windows 7 SP2 64-bit Enterprise
Windows 2016 Standard

Windows 2012 R2 Standard
Windows 2008 R2 64-bit Enterprise
Windows Vista (32-bit and 64-bit)

Table C-7 Software Support

Support Version

Microsoft Office .

*

Ms Office 2016 (64-bit) Standard
Ms Office 2013 (32-bit and 64-bit) Standard

Adobe Acrobat Adobe Acrobat XI Professional
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Supported Document Formats By the Local Renderer

and Remote Renderer

Table C-8 Local Renderer Supported Document Formats

Software File Formats
OpenDocument ODT, ODP, ODG, ODS
Graphics JPG, BMP, TIF, GIF, PNG
Others PDF

TXT

HTML (Static)

Static HTML content refers to the HTML content that
does not change or have dependencies on external
files such as MySQL database and JavaScript.

Table C-9 Remote Renderer Supported Document Formats

Software

File Formats

Microsoft Word
Microsoft Excel
Microsoft PowerPoint

Others

DOC, DOCX, DOCM, DOTM, RTF
XLS, XLSX, XLSM, XLSB

PPT, PPTX, PPTM, PPTX

PDF

iPrint Appliance Server and Client Support

Table C-10 iPrint Appliance Server and Client Support

Support Version

Hypervisor .
*

*

Xen on SLES 11 SP4 and SLES 12
Citrix XenServer 6.5

Hyper-V: Windows Server 2012 Hyper-V and Windows
Server 2008 Hyper-V

VMware ESXi 5.5 and 6.x
VMware Workstation on Windows 10

VMware Workstation on SLES
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Support Version

Desktop iPrint Client + Mac 10.15 and Mac 10.14

NOTE: Support for driver package on Mac is available from
Windows iPrint client 6.06 and later.

+ Windows 10

+ Windows 8.1

+ Windows 8.1 Surface Pro tablet
+ Windows 7

+ Windows Server 2016

+ Windows Server 2012 R2

+ Windows Server 2008 R2

Appliance Installer (virtual m/c format) + OVF
* VHD
+ XEN
* XVA

OES Source Platform Support for Migration

Table C-11 Source Platform Support for OES iPrint Service

Services NW6.5  OES2 OES11 OES11  OES11  OES2015 OES 2015
SPs . SP1 SP2 SP1
iPrint v v v v v v v

If the source platforms are NW 5.1, NW 6.0 SP5, OES 1 SP2, OES 2 SP1 or OES 2 SP2, you must
upgrade to the latest supported source platform as listed in the above table.

Clients for Email Printing

+ Novell GroupWise 2012 and Novell GroupWise 2014
+ Microsoft Outlook 2010 and 2013

+ |IBM Lotus Notes 9

+ iOS 9.x and 10.x default mail client

+ Mail clients on Android 4.x or later

+ Windows 8.1 Mobile default mail client

¢ Gmall

+ Microsoft Exchange 2010 and 2013
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Supported Browsers for iPrint

The section provides information on which Web browsers are supported for different iPrint tasks and
operations.

+ “iPrint Client Supported Browsers” on page 240
+ “Supported Browsers for iManager” on page 240

+ “Supported Browsers for the iPrint Map Designer” on page 241

iPrint Client Supported Browsers

The following table indicates which browsers are supported with the various iPrint Client platforms:

iPrint Client Platform Supported Browsers

Macintosh + Safari 8.6 or later
+ Mozilla Firefox 38.1 or later

+ Google Chrome 43 or later

Windows 8.1 ¢ |Internet Explorer 10 or later
* Mozilla Firefox 3.0.x or later

+ Google Chrome

Windows 10 + Internet Explorer 10 or later
+ Mozilla Firefox 3.0.x or later
+ Google Chrome

* Microsoft Edge

Supported Browsers for iManager

The iPrint plug-in with iManager supports the following browsers:

+ Internet Explorer

+ Mozilla Firefox

When you upload printer drivers and PPD files, you should use the following browsers for the
operations indicated:

+ “Uploading PPD Files Using iManager” on page 240
+ “Uploading Windows Printer Drivers Using iManager” on page 241

Uploading PPD Files Using iManager

iPrint Client Platform Supported Browser Upload PPD file to Driver Store
on Linux

Windows Internet Explorer 10 or later Supported using the Add from File
button.
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NOTE: On Mac operating systems, PPD upload is not supported. PPD files for Mac can be uploaded
using Internet Explorer on Windows. Alternatively, you can also upload the PPD files for Mac using
the i prnt cmd command from a terminal session. For uploading the PPD files for Mac, refer
“‘Command Line (iprntcmd)” on page 196.

Uploading Windows Printer Drivers Using iManager

Client Supported Browser Upload Windows Printer Driver to
Driver Store on Linux

Windows Internet Explorer 10 or later Supported

Supported Browsers for the iPrint Map Designer

The iPrint Map Designer works only with Microsoft Internet Explorer 10 or later.
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D iPrint Commands and Utilities

This section contains information about iPrint commands and utilities.

+ “iprntcmd(1)” on page 244
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iprntcmd(1)

Name

i prntcmd - iprint administrative utility.

SYNTAX

i prnt cnd <options> <parameter>

DESCRIPTION

iprntcmd provides command-line functionality for iPrint administrative tasks on a workstation.

OPTION SUMMARY

You must use quotes around parameters that contain spaces.

Most of the commands listed below are common for Windows and Mac operating system. If a
command is valid for only Windows or Mac, we mentioned the specific operating system in that
command.

OPTIONS

Option type <parameter>
-a | --addprinter <printer-uri>
Installs the specified printer.
-c | --clearallpasswords
Clears all saved passwords.
-T | --tray-icon
Displays an iPrint icon to the notification area and launches the i pri nt -1 i st ener - gui process,
if it is not running.
-r | -=-run-listener
Launches the i print-1istener process ifitis not already running.
-d | --delprinter <printer-uri>
Removes the specified printer.
-d | --delprinter all

Remove all the printers. This option requires your confirmation before removing all the printers.

-d | --delprinter all --force
Remove all the printers. This option removes all the printers forcibly without any user
intervention.

-g | --getdefault
Displays the default printer installed on the workstation.
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-h | --help
Displays help for the command.
-j | ~-listjobs <printer-uri>
Lists the print jobs for the specified printer that are on the server in a pending or printing state.
-l | --listprinters
Lists printers installed on the workstation.
-L | -listprintersonserver <psm-hostname or psm-address>

Lists iPrint printers on the specified Print Manager, where psm-hostname or psm-address can be
a host name or IP address.

-p | --printfile <printer-uri> <file path>
Sends a printer-ready file to the specified iPrint printer.
-P | --ppdlist
Lists the PPDs installed on this workstation.
-s | --setdefault <printer-uri>
Sets the specified printer as the default.
-t | --testpage <printer-uri>
Prints a test page to the specified printer.

-u | --uploadids <ids-uri> <ppd path with/without wildcards>

(Mac workstation) Uploads the specified PPD files to the indicated driver store, where ids_uri is
the IP address or host name for the driver store, and ppd is the directory path and filename to the
PPD files. You can use a wildcard in the PPD filename.

-U | --uploadbroker <rms-uri> <rms-name> <ppd path with/without wildcards>

Uploads the specified PPD files to the indicated Broker, where rms_uri is the IP address or host
name for the Broker’s associated Print Manager, rms_name is the username with rights to add
drivers to the broker, and ppd is the directory path and filename to the PPD files. You can use a
wildcard in the PPD filename.

-U | --uploaddriver [osx] <ids_uri> <username> <password> [INF-Filepath <model-name>] |
[driver-Filepath]

Windows workstation: Windows Driver Upload

-U <ids_uri> <username> <password> | NF- Fi | epat h <nodel - nane>

Uploads the Windows driver to the indicated Driver Store where ids_uri is the IP address or host
name of the Driver Store, and INF-Filepath is the file path of the Windows driver.

Windows workstation: Mac Driver Upload
-U [osx] <ids_uri> <usernanme> <password> driver-Filepath

Uploads the specified Mac Driver package (Mac PPD or PDE driver package) files to the
indicated Driver Store where ids_uri is the IP address or host name of the Driver Store, and
driver-Filepath is the path of the Mac driver file (PPD or PDE).

-v | --version <psm-hostname or psm-address>

Displays the server platform and version information, where server_uri is the URI for the server.
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-i | -~-info <printer-uri>

Displays the printer information.

--icm-refresh [no-gui]

Applies the iCM settings modified by the administrator. If the [no-gui] option is used, the modified
settings are applied but no iCM GUI is displayed. To view the logs, see c: \ NDPS/ User s/
user _nane/icn og. t xt.

-S | --setprimarypsm <IP/DNS>
Sets the PSM address for iCM configuration.

-f | --fetchdriverlocal <printer-uri>

Fetches the printer driver on local machine.

EXAMPLES

Syntax

i prntcnd --<option> ipp://<host_address>/ipp/<printer_nanme>
Example to add a printer

iprntcnd --addprinter ipp://printing. MyConpany. conmlipp/Printerl
Example to delete a printer

iprntcnd --delprinter ipp://printing. MyConpany.comipp/Printerl
Example to get a default printer

iprntcnd --getdefault
Example to list the print jobs

iprntcnd --listjobs ipp://printing. MyConpany.conlipp/Printerl
Example to get the list of installed printers

iprntcnd --listprinters
Example to get the list of printers on a server

iprntcnd --listprintersonserver printing. MyConpany. com
Example to print a file

iprntcnd --printfile ipp://printing. MyConpany.coniipp/Printerl /hone/userl/
tenp. t xt

Example to get a list of local ppd files

iprntcnd --ppdlist
Example to set a default printer

iprntcnd --setdefault ipp://printing. MyConpany.conmlipp/Printerl
Example to test a print page

iprntcnd --testpage ipp://printing. MyConpany. comipp/Printerl

246 iPrint Commands and Utilities



Example to upload driver <without using a wildcard> to ids

i prntcnd --upl oadi ds printing. MyConpany. com / usr/ shar e/ cups/ nodel / HP/
LaserJet _4V_4LJ Pro-1j4dithp. ppd. gz

or

iprntcmd --uploadids 192.168.3.4 /usr/share/cups/model/HP/LaserJet_4V_4LJ Pro-
lj4dithp.ppd.gz

Example to upload driver <using a wildcard> to ids
iprntcmd --uploadids printing.MyCompany.com /usr/share/cups/model/HP/LaserJet_4*

or
i prntcnd --upl oadi ds 192. 168. 3.4 /usr/ share/ cups/ nodel / HP/ Laser Jet _4*
Example to upload drivers (without using a wildcard) to rms

i prntcnd --upl oadbroker printing. MyConpany. com rns_nane /usr/share/ cups/ nodel /
HP/ Laser Jet _4V_4LJ _Pro-1j 4dit hp. ppd. gz

or

iprntcnd --upl oadbr oker 192.168. 3.4 rns_nane /usr/share/ cups/ nodel / HP/
LaserJet _4V_4LJ Pro-|j4dithp. ppd. gz

Example to upload drivers (using a wildcard) to rms

i prntcnd --upl oadbroker printing. MyConpany. com rns_nane /usr/share/ cups/ nodel /
HP/ Laser Jet _4*

or
iprntcnd --upl oadbroker 1.2.3.4 rms_nane /usr/share/cups/ nodel / HP/ Laser Jet _4*
Example to get iprint server version
i prntcnd --version printing. MyConpany. com
or
iprntcnd --version 192.168. 3.4
Example to get information of a printer

iprntcnd --info ipp://printing. MConpany. conlipp/Printerl
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TIDs for iPrint

This section contains the list of TIDs that are available for iPrint Appliance. These TIDs are located on
the Novell Technical Support website and are listed in this document to provide easy access for the

users.

TID No Description

7022058 iPrint context menu not present for all file types

7022057 How to enable the iPrint /ipp page with iPrint Appliance

7016720 How to renew server certificates with iPrint Appliance

7013074 Local rendered jobs are cancelled or improperly rendered

7015506 Unable to contact the remote renderer

7015857 Renderer is not using the modified printer driver

7013428 Unable to resolve domain <iPrintApplianceDomain> when printing from a mobile
device

7013185 Error “Check the printer for errors” is displayed when printing from a mobile device

7015684 Copy printer driver profiles from one iPrint Appliance to another

7015896 How to install VMware Tools on the iPrint Appliance

7015913 How to install iPrint printers using AD tools

TIDs for iPrint

249


https://www.novell.com/support/kb/doc.php?id=7022058
https://www.novell.com/support/kb/doc.php?id=7022057
https://www.novell.com/support/
https://www.novell.com/support/kb/doc.php?id=7016720
https://www.novell.com/support/kb/doc.php?id=7013074
https://www.novell.com/support/kb/doc.php?id=7015506
https://www.novell.com/support/kb/doc.php?id=7015857
https://www.novell.com/support/kb/doc.php?id=7013428
https://www.novell.com/support/kb/doc.php?id=7013185
https://www.novell.com/support/kb/doc.php?id=7015684
https://www.novell.com/support/kb/doc.php?id=7015896
https://www.novell.com/support/kb/doc.php?id=7015913
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Documentation Updates

This section summarizes the changes made to this guide post 3.2 release.

January 17, 2019

Section

Details

“License” on page 131

“Caveats For Email Printing” on
page 99

The validity of the iPrint trial license is increased from 60 days to 90

days.

Added a new caveat that, “Secure printers cannot be configured for

email printing.”

Documentation Updates
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